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Purpose

Audience

Assumptions

About This Guide

This user guide provides provides reference information for the QuantStudio™ 6 and 7
Flex Real-Time PCR Systems and describes how to prepare, maintain, and
troubleshoot the systems.

A WARNING! The protection provided by the equipment may be impaired if the

instrument is operated outside the environment and use specifications, the user
provides inadequate maintenance, or the equipment is used in a manner not
specified by the manufacturer (Life Technologies).

Note: For information and instructions on performing experiments on the
QuantStudio™ 6 and 7 Flex Real-Time PCR Systems, refer to the QuantStudio™ 6 and 7
Flex Real-Time PCR System Software Getting Started Guide (Pub. no. 4489822) and the
High Resolution Melt Module for QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software (Pub. no. 4489823).

This user guide is written for laboratory staff who operate and maintain the
QuantStudio™ 6 and 7 Flex Real-Time PCR System:s.

This guide assumes that your QuantStudio'" 6 and/or 7 Flex System has been installed
by a Life Technologies service representative.

This guide also assumes that you have:
 Familiarity with Microsoft® Windows® operating system.

¢ Knowledge of techniques for handling and preparing nucleic acid samples for
PCR.

* A general understanding of data storage, file transfers, and copying and pasting.

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems Maintenance and Administration Guide 1



About This Guide
User attention words

User attention words

Four user attention words may appear in this document. Each word implies a
particular level of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! Provides information that is necessary for proper instrument operation
or accurate chemistry kit use.

CAUTION! Indicates a potentially hazardous situation that, if not avoided, may
A result in minor or moderate injury. It may also be used to alert against unsafe
practices.

WARNING! Indicates a potentially hazardous situation that, if not avoided,
A could result in death or serious injury.

C DANGER! Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury.

Except for IMPORTANTS, the safety alert words in user documentation appear with an
open triangle figure that contains a hazard symbol. These hazard symbols are identical
to the hazard symbols that are affixed to the instrument. See the “Safety” appendix for
descriptions of the symbols.

Symbols on this instrument

12

Symbols may be found on the instrument to warn against potential hazards or convey
important safety information. In this document, the symbol is used along with the user
attention words to highlight important safety information. The following table gives
the meaning of these symbols.

Symbol English Francais
j Caution, risk of danger Attention, risque de danger
Consult the manual for further safety | Consulter le manuel pour d'autres
information. renseignements de sécurité.

QuantStudio™ é and 7 Flex Real-Time PCR Systems Maintenance and Administration Guide



Contents of this manual

About This Guide
Contents of this manual

This guide is divided into the following chapters and appendixes:

Chapter/appendix

Content

Chapter 1, Getting Started

Introduces the QuantStudio™ 6 and 7 Flex Systems, including
descriptions of all related hardware and software.

Chapter 2, Calibrate the
Instrument

Appendix A, Manual
Instrument Operation

Describes how to maintain a QuantStudio™ 6 or 7 Flex System,
including calibration and performance verification.

Describes how to operate the QuantStudio™ 6 and 7 Flex
Systems manually using the touchscreen interface.

Appendix B, Maintenance

Describes how to replace the user-serviceable parts of the
QuantStudio™ 6 and 7 Flex Systems and how to resolve
infrequent problems that can occur during normal use.

Appendix C, Networking

Describes how to install the QuantStudio™ é and 7 Flex
Systems to a local area network for remote monitoring and
control.

Appendix D, Power On or
Off, Store, and Move

Describes how to store, move, and reinstall the components of
the QuantStudio™ 6 and 7 Flex Systems.

Appendix E, Security, Audit,

and Electronic Signature

Appendix F, Calibration
Consumable Preparation

Describes how to configure the security, audit, and electronic
signature functions of the QuantStudio™ 6 and 7 Flex Real-
Time PCR System Software.

Describes how to prepare consumables for custom dye
calibration.

Appendix G, Parts and
Materials

Describes how to order parts, accessories, and consumables
for the QuantStudio™ 6 and 7 Flex Systems.

Appendix H, Instrument
Specification and Layout

Describes the QuantStudio™ 6 and 7 Flex System
specifications, requirements, layout, and connections.
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1 Chapter 1 Getting Started
Differences between the QuantStudio™ é and 7 Flex Real-Time PCR Systems

Differences between the QuantStudio™ 6 and 7 Flex Real-Time PCR
Systems

The following table displays the differences between the QuantStudio'™ 6 Flex System
and the QuantStudio'" 7 Flex System.

QuantStudio™ 6 Flex System QuantStudio™ 7 Flex System

Does not support the Twister® Robot Supports the Twister® Robot

Does not support the Array Card block | Supports the Array Card block

Features a coupled five-color filter set | Features a decoupled six-by-six-color filter set

About the QuantStudio™ 6 and 7 Flex Real-Time PCR Systems

The QuantStudio™ 6 and 7 Flex Systems use fluorescent-based polymerase chain
reaction (PCR) reagents to provide:

* Quantitative research detection of target nucleic acid sequences (targets) using
real-time analysis.

* Qualitative research detection of targets using post-PCR (endpoint) analysis.

¢ Qualitative analysis of the PCR product (achieved by melt curve analysis that
occurs post-PCR).

Data collection The QuantStudio" 6 and 7 Flex Systems collect raw fluorescence data at different
points during a PCR, depending on the type of run that the QuantStudio " 6 and 7 Flex
Systems perform:

Run type Data collection point
Real-time | Standard curve The QuantStudio™ 6 and 7 Flex Systems collect data
runs following each extension step of the PCR.

Relative standard curve
Comparative Ct (AACT)

Melting curve

16 QuantStudio™ é and 7 Flex Real-Time PCR Systems Maintenance and Administration Guide
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Run type Data collection point
Post-PCR | Genotyping The QuantStudio™ é and 7 Flex Systems collect data:
(endpoint) 1. Before the PCR. (For presence/absence
runs experiments, data collection before the PCR is
optional, but recommended.)
Presence/absence 2. (Optional) During the PCR. The QuantStudio™ é

and 7 Flex System can collect data during the run
(real-time); collecting data during the run can be
helpful for troubleshooting.

3. After the PCR.

The instrument collects raw fluorescence data following each extension step of the
PCR. A data collection point, or read, on the QuantStudio™" 6 and 7 Flex System

consists of three phases:

1. Excitation: The instrument illuminates all wells of the plate or array card, within
the instrument, exciting the fluorophores in each reaction.

2. Emission: The instrument optics collect the residual fluorescence emitted from
the wells of the plate or array card. The resulting image collected by the device
consists only of light that corresponds to the range of emission wavelengths.

3. Collection: The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval. The software stores the raw
fluorescent image for analysis.

After a run, the software uses calibration data (RO, background, uniformity, dye, and
normalization) to determine the location and intensity of the fluorescent signals in
each read, the dye associated with each fluorescent signal, and the significance of the

signal.

Instrument filters System dyes

and supported dyes

The QuantStudio™ 6 Flex System features a coupled five-color filter set while the

QuantStudio™ 7 Flex System features a decoupled six-by-six-color filter set that
supports the dyes shown in the following table. For more information about the
spectral dye calibration kits available for the QuantStudio'" 6 and 7 Flex Systems,
please contact Life Technologies.

Filter wavelength (nm)*t

Filter set Color Supported dye
Excitation Emission

x1-m1 Blue 470 15 520+ 15 FAM™ and SYBR® Green dyes
X2-m2 Green 520+ 10 558 + 12 JOE™, HEX™, TET™, and VIC® dyest
x3-m3 Yellow 5495+ 10 586.5+ 10 Cy®3, NED™, and TAMRA™ dyes
x4-mb Orange 580 + 10 623+ 14 ROX™ and Texas Red® dyes
x5-m5 Red 640 + 10 682 + 14 Cy®5 and LIZ® dyest
x6-mé8 Deep red 662+ 10 711412 Noneft

T The central wavelengths are the optimized wavelengths.

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems Maintenance and Administration Guide 17
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t The HEX™, TET™, and LIZ® dyes from Life Technologies fall within the emission wavelength range of the
system, therefore they can be added and adapted for use in experiments on the system. To add any of these
dyes to the Dye Library, perform a custom dye calibration. For more information, see “Calibration Consumable
Preparation” on page 149.

§ QuantStudio™ 7 Flex System only.

Tt This filter set currently does not support any dyes supplied by Life Technologies.

Filters
Wavelength
(nm)
Emission /
Spectra e
FAM™ dye VIC® dye TAMRA™dye ROX™dye Cy® dye
SYBR® Green dye JOE™dye Cy®3dye Texas Red®dye
NED™ dye

Custom dyes

The QuantStudio™ 6 and 7 Flex Systems can run assays designed with custom dyes
(dyes not supplied by Life Technologies) that are excited between 455 to 672 nm and
read between 505 to 723 nm. To add a custom dye to the Dye Library, perform a
custom dye calibration. For more information, see “Calibration Consumable
Preparation” on page 149.

Instrument hardware

The QuantStudio" 6 and 7 Flex Systems consist of the components shown in the
following figure and described in the subsequent table.

Front

&4
§F o
§ &8
8 i

g
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Component Description

A | USB ports Provide USB communication with the instrument. Can be used to
transfer data to and from the instrument.

Note: If multiple USB drives are plugged into the instrument, the
instrument mounts only the first drive that is installed, regardless of
the USB port used.

B | Touchscreen Provides access to the instrument functions. Can be used to run
experiment, transfer data, and operate the instrument functions
without the use of the computer.

C | Access door Provides access to the instrument lamp, the heated cover, and the
sample block.

D | Lamp [Lluminates the plate or array card during a run.

Heated cover Covers the plate or array card during a run to prevent condensation
and leakage through the cover.

Sample block Heats the plate or array card during a run.

Side door Opens to allow extension of the tray arm.

I @ T

Plate adapter Secures the plate or array card to the tray arm.

Tray arm Conveys the plate or array card to and from the sample block in the
interior of the instrument.

Rear

!__I
= =

|
Ethernet usBe usB
3 4

Component Description

A | Ethernet port An RJ45 port that provides Ethernet (gigabit) communication with the
instrument.t

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems Maintenance and Administration Guide 19
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Component Description

B | USB ports Provide USB communication with the instrument. USB ports can be
used to transfer data from the instrument.

Note: If multiple USB drives are plugged into the instrument, the
instrument mounts only the first drive that is installed, regardless of
the USB port used.

C | RS232 port Provides serial communication between the instrument and the
computer.

IMPORTANT! The serial port is for Life Technologies use only.

D | Instrument Cool the interior of the instrument.

fans IMPORTANT! The fans must be unobstructed to ensure adequate

cooling and proper function of the instrument.

E | On/Off switch Power switch for the instrument, where the states are on (| ) or
off (0.

F | Fuse cover Dual 12.5A, Time-Lag T, 250 VAC, 5 x 20-mm electrical fuses that
protect the instrument from excessive electrical current.

For AU/NZ only - 6.3A, Time-Lag, 250VAC, 5 x 20-mm.

G | Power port The 100-240 VAC port that provides power to the instrument.

t Use the Ethernet cable supplied with the instrument to connect the instrument (Ethernet port) to the network
interface card in the computer.

Barcode scanner The QuantStudio™ 6 and 7 Flex Systems include an optional Handheld Barcode
Scanner (Part no. 4453271) that you can purchase to assist you with data entry. The
barcode scanner uses a 670 nm Class II laser to scan plates or array cards (for only the
QuantStudio™ 7 Flex System) and it is capable of reading Code 128 (alphanumeric),
which supports 128 ASCII character barcodes.

WARNING! LASER. Exposure to direct or reflected laser light can burn the
retina and leave permanent blind spots. Never look into the laser beam. Remove
jewelry and anything else that can reflect the beam into your eyes. Protect others
from exposure to the beam.

The optional hand-held barcode scanner functions as an extension of the keyboard.
You can use the scanner to scan barcodes into the instrument software.

To scan a barcode using the hand-held barcode scanner:
1. Select the field in the instrument software where you want to enter the barcode.

2. Hold the hand-held barcode scanner 20-30 cm away from a plate or array card
and aim at the center of the barcode, then press the trigger. Slowly move the
scanning beam across the barcode until the scanner emits a high-pitched tone.

When the scanner scans a barcode, it automatically:

* Transmits the alphanumeric equivalent of the barcode to the instrument software.
The software enters the barcode text wherever the cursor is active.

* Transmits a carriage-return character (the equivalent of pressing the Enter key).

20 QuantStudio™ é and 7 Flex Real-Time PCR Systems Maintenance and Administration Guide
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For more information on the hand-held barcode scanner, see the user documentation
shipped with the barcode scanner.

IMPORTANT! The Applied Biosystems Twister® Robot component is supported only by
the QuantStudio™ 7 Flex System.

The QuantStudio™ 7 Flex System supports the use of the Applied Biosystems
Twister® Robot, an optional QuantStudio™ 7 Flex System accessory that consists of the
components shown below.

Note: See the Applied Biosystems Twister® Robot Automation Accessory User Guide (Pub.
no. 4470693) for information on operating, calibrating, maintaining and integrating the
Twister® Robot.

Front view

Component Description

A | Reach axis Moves the grip horizontally 11.25 in (28.5 cm) to 19.75in (50.1 cm) from

the center of the robot post.

B | Wrist
mechanism

Rotates materials to either the portrait or landscape positions, where
the range of motion is +135° (270° total).

Grip

Consists of two sets of fingers that grip the consumable. The fingers
close to grasp a consumable and open to release it.

Robot tower/

Moves the arm up and down 21.5in (54.6 cm), from 6.5in (16.5cm) to

vertical axis | 28in (71.1 cm) above the table.

Rotary axis Rotates the arm 340° around the base of the Twister® Robot.
Mechanical stops prevent continuous rotation.

Bar code Scans the bar codes of consumables as they are loaded into the

reader QuantStudio™ 7 Flex System.

Base cover Removable cover that contains four access bolts, which secure the
Twister® Robot to the Sciclone ALH 3000 base.

Racks Provide storage for PCR consumables before and after they are run by
the QuantStudio™ 7 Flex System (one of three shown).

Power LED When lit, indicates the Twister® Robot is powered on.
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Rear view

Component

Description

A | On/Off switch

Power switch for the Twister® Robot, where the states are on (| ) or off
(0).

Power port

100-240V port that provides power to the Twister® Robot.

RS232 port

Provides serial communication with the computer.

D | Fuse cover

Two T1.6A 250VAC, 5 x 20-mm electrical fuses that protect the
Twister® Robot from excessive electrical current.

Rack parts and functions

Racks are removable aluminum frames used as input and output locations for PCR
consumables. Rack positions are numbered counter-clockwise, with position 1 closest
to the front of the Twister® Robot (see below). Each rack is labeled for a specific
position and cannot be exchanged with the other racks.

Component

Description

A | Handles

B | Rack locator
notch

For connecting or disconnecting racks from the pod.

Locks the rack onto the pod in the correct position.

Note: Do not drop the racks. If the rack is bent, the Twister® Robot cannot properly
place the consumables.
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Electrical We recommend several protective devices to protect the instrument in environments
protective devices with large voltage and power fluctuations.

Power line regulator

We recommend the use of a 1.5-kVA power line regulator in areas where the supplied
power fluctuates in excess of + 10% of the normal voltage. Power fluctuations can
adversely affect the function of the instrument.

Note: A power line regulator monitors the input current and adjusts the power
supplied to the instrument or computer. It does not protect against a power surge or
failure.

Uninterruptible power supply (UPS)

We recommend the use of a 1.5-kVA uninterruptible power supply (UPS), especially in
areas prone to power failure. Power failures and other events that abruptly terminate
the function of the QuantStudio"" 12K Flex System can corrupt data and possibly
damage the computer or the instrument.

IMPORTANT! UPSs provide power for a limited time. They are meant to delay the
effects of a power outage, not to serve as replacement power sources. In the event of a
power loss, power off the instrument and the computer, unless you expect to regain
power within the battery life of the UPS.

Surge protector

We recommend the use of a 10-kVA surge protector (line conditioner) in areas with
frequent electrical storms or near devices that are electrically noisy, such as
refrigerators, air conditioners, or centrifuges. Short-duration, high-voltage power
fluctuations can abruptly terminate the function of, and thereby damage the
components of, the computer and the instrument.

Note: A dedicated line and ground between the instrument/computer and the
building’s main electrical service can also prevent problems caused by power
fluctuations.

Instrument software

The QuantStudio™ 6 and 7 Flex Systems include a suite of software applications that
can be used to calibrate, run, and integrate the instrument into a laboratory workflow.
The installation of the software contains the components described below.

The QuantStudio™ 6 and 7 Flex Systems include a suite of software applications that

can be used to calibrate, run, automate, and integrate the instrument into a laboratory
workflow. The installation of the software contains the components described below;
however, additional software may be available for the QuantStudio™" 6 and 7 Flex
Systems. Visit the QuantStudio™ 6 and 7 Flex Systems website for a complete list of
compatible software, and for updates and patches for the QuantStudio™ 6 and 7 Flex

System software and firmware:

www.lifetechnologies.com/us/en/home/technical-resources/software-downloads

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems Maintenance and Administration Guide 23


https://www2.appliedbiosystems.com/support/software/

Chapter 1 Getting Started
Instrument software

Computer
requirements

Software
installation

Third-party
software

24

The requirements for the computer used to operate the QuantStudio™ 6 and 7 Flex
Systems can vary depending on the version of the QuantStudio™" 6 and 7 Flex Real-
Time PCR System Software that you are running. To determine the computer
requirements for your QuantStudio™ 6 or 7 Flex System, check the QuantStudio™ 6
and 7 Flex Real-Time PCR System Software release notes at the following location:

<drive>:\Program Files\Applied Biosystems\QuantStudio 6 and 7 Flex
Software\QuantStudio 6 and 7 Software README.docx

Note: <drive> is the location where the software is installed.

IMPORTANT! Due to a known incompatibility, Life Technologies does not recommend
installing the QuantStudio™" 6 and 7 Flex Real-Time PCR System Software to
computers running the Windows Vista® operating system. If used with the operating
system, the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software generates
errors when saving experiment (.eds) files.

The default installation of the instrument partitions the computer hard drive to create
the logical drives as explained below.

Drive Software Description
c Microsoft® Windows® 0S* Operating system files.
QuantStudio™ 6 and 7 Flex Used to calibrate and perform experiments on the
Real-Time PCR System QuantStudio™ 6 and 7 Flex System.
Software

Stores the installation files, application data files,
and user files (experiments, exports, and imports).

C or D ' QuantStudio™ 6 and 7 Flex Used to automate the creation of new experiments
drive  System Command Line Utility = and the export of existing experiments.

Twister® Robot Softwaref Controls the Twister® Robot, stores all of the
taught positions for the robot, and includes the
VBA code required to operate the Twister® Robot
with the automation control software.

T We recommend that you do not install programs to the C drive.
1 QuantStudio™ 7 Flex System only.

Before you install third-party software to the computer running the QuantStudio™ 6
and 7 Flex Real-Time PCR System Software, confirm that the software will not:
e Restrict Ethernet communication

¢ Interfere with QuantStudio"" 6 and 7 Flex Real-Time PCR System Software
operation (see below)

To confirm that third-party software does not interfere with the QuantStudio'" 6 and 7
Flex Real-Time PCR System Software:

1. Install the software to the computer that contains the QuantStudio™ 6 and 7 Flex

Real-Time PCR System Software.
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2. Perform several test experiments using “dummy” plates (plates that do not
contain reagents).

Note: The goal of the test experiments is to run plates under conditions that
match normal instrument operation. Therefore, the characteristics of the test
experiments (plate layout and run method) must closely resemble your actual
experiments.

3. Confirm that the QuantStudio™ 6 and 7 Flex Systems perform each test
experiment without producing errors.

If the QuantStudio™ 6 and 7 Flex Systems perform the tests successfully, perform
experiments normally. If the QuantStudio™ 6 and 7 Flex Systems encounter errors
during the test runs, the software may not be compatible with the

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

Instrument consumables

The QuantStudio™ 6 and 7 Flex Systems support a series of specialized consumables
through interchangeable sample blocks. Use the consumables appropriate for the
sample block of your QuantStudio™ 6 or 7 Flex Systems.

Note: The QuantStudio" 6 Flex System does not support the Array Card block.

C WARNING! Use the flat caps for 0.2 mL tubes and 0.1 mL tubes. Rounded caps
can damage the heated cover.

Sample Consumable Reaction
block volume
96-well plate, e MicroAmp® Optical 8-Cap 100 pL
0.2mL Strip
e MicroAmp® 8-Tube Strips
(0.2-mL)

o MicroAmp® Reaction Tubes
without Caps (0.2-mL)

e MicroAmp® 96-Well Tray/
Retainer Set

o MicroAmp® Optical Adhesive 100 pL
Film

e MicroAmp® Optical 96-Well
Reaction Plate with Bar Code

"« MicroAmp® Optical Adhesive 50 uL
Film
e MicroAmp® Optical 96-Well

Fast Reaction Plate with Bar
Code

96-well plate,
0.1 mL
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Sample Consumable Reaction
block volume
384-well Notched corner e MicroAmp® Optical Adhesive 20 L
plate Film
A e MicroAmp® Optical 384-Well

Reaction Plate with Bar Code

Array cardt Life Technologies Array Card 1uL

+ QuantStudio™ 7 Flex System only.

Interchangeable sample blocks, heated covers, and plate retainers

The QuantStudio™ 6 and 7 Flex Systems feature a set of interchangeable sample
blocks, heated covers, and plate retainers that allow the instruments to support
multiple consumable formats. All of the hardware is user-installable. Replacement can
be done without the need for recalibration of the instrument, provided that the
calibrations for the new format have not expired. See Appendix B, “Maintenance” for
more information about changing the sample block, heated cover, and plate retainer.
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IMPORTANT! Perform the procedures for preparing array cards only if you are

verifying the performance of a QuantStudio™" 7 Flex System with an array card sample
block. The QuantStudio™ 6 Flex System does not support the array card sample block.
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Calibration overview

Calibration and The QuantStudio™ 6 and 7 Flex Systems require regular calibration and maintenance
Y q g
maintenance for proper operation. To ensure proper operation of your instrument, perform weekly,
schedule monthly, and semiannual maintenance as indicated in the following table.
IMPORTANT! Perform calibrations and run experiments under the environmental
conditions specified in Appendix H, “Instrument Specification and Layout”. Exposure
to extreme temperatures can have adverse effects on the run results, as well as
shortening the life span of the instrument components.
IMPORTANT! Do not use organic solvents to clean the QuantStudio"" 6 and 7 Flex
Systems.
Frequency User-performed maintenance task
Check the computer disk space. If necessary, archive or back up your
experiment files and instrument settings.
Weekly Power off the computer that controls the instrument, then power on the
computer after 30 seconds.
Clean the surface of the instrument with a lint-free cloth.
Perform a background calibration.t
Monthly Run disk cleanup and disk defragmentation.
Perform an instrument self test.
Perform an ROI calibration.
Perform a background calibration.t
Semi-annually Perform a uniformity calibration.
(every 6 months)
Perform a dye calibration.
Perform a normalization calibration.
As needed Perform an RNase P instrument verification run.
Replace the instrument lamp.F
T You can perform a background calibration to check for contamination.
I After replacing the instrument lamp, perform all calibrations and an RNAse P instrument verification run.
Planned The instrument requires regular planned maintenance by Life Technologies service
maintenance personnel to ensure that the instrument is operating within the installation

specification. The planned maintenance service can help you maximize your
productivity by minimizing downtime, lowering the cost of ownership by addressing
potential problems before they manifest (lost data, samples, or reagents), and
increasing the quality of your results by maintaining your instrument at optimal
performance. For more information, contact your Life Technologies sales
representative.
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Chapter 2 Calibrate the Instrument

™

The QuantStudio ™ 6 and 7 Flex Real-Time PCR System Software features an
automated notification system that alerts you of required calibrations. The feature will
also prevent you from operating an instrument that is out of calibration. See “Enable or
change the calibration reminders” on page 31 for more information on setting the
maintenance reminders.

The following figure shows the workflow for calibrating the QuantStudio™ 6 and 7
Flex Systems. Whether you are performing all calibrations or just a subset, perform
them in the sequence shown below.

Start

Perform an ROI calibration
Perform a background calibration
Perform a uniformity calibration
Perform dye calibrations
Perform a normalization calibration

Perform an RNase P instrument verification test

v

Finish

You can use the Instrument Console of the QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software to view the calibration status of a QuantStudio"" 6 or 7 Flex System.

™

1. From the QuantStudio = 6 and 7 Flex Real-Time PCR System Software Home tab,
click ® Instrument Console.

2. From the Instrument Console open the Instrument Manager:
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a. Select your instrument icon from the

My InStruments group‘ File Edit Instrument Analysis fé‘B\ Help
Mew Experiment - ﬁ QOpe |

B Cose B

b. Click Manage Instrument.

Note: If the Manage Instrument option is
inactive, connect your QuantStudio™ 6 or
7 Flex System to the My Instruments

group.

R4l Fitered by:

278860001
READY

3. From the Instrument Manager, click
Monitor, then click Information to open
the instrument monitor.

The instrument monitor screen displays the:

a. The Instrument type (QuantStudio™" 6 Flex System or QuantStudio™ 7 Flex
System).

b. Status of all calibrations, including the date and time of each calibration.
c. Maintenance status of the instrument.

d. Properties of the instrument.

E] 278860001 (384-Well Block)
i QuantStudio™ 6 Flex System
READY
Export Instrument Details :} Print Calibration Log Print Maintenance Summary
Calibration Status =
Last Run 3
ROI 06-20-2013 09:49:16 56T GUEST Current
Background 06-20-2013 09:57:23 56T GUEST Current
Uniformity 06-20-2013 10:04:14 SGT GUEST Current
B Dye
FAM 06-20-2013 10:11:09 56T GUEST Current
VIC 06-20-2013 10:18:06 56T GUEST Current
ROX 06-20-2013 10:27:22 56T GUEST Current <3b
SYBR 06-20-2013 10:37:27 5GT GUEST Current
NED 06-20-2013 10:53:57 5GT GUEST Current
TAMRA 06-20-2013 10:44:41 56T GUEST Current
MELTDOCTOR 06-21-2013 14:40:54 56T GUEST Current
B Normalzation
FAM/ROX 06-20-2013 11:01:35 56T GUEST Current
VIC/ROX 06-20-2013 11:08:56 5GT GUEST Current
iE HRM
RNase P 06-21-2013 09:26:48 56T GUEST Current

Maintenance Info

Lamp Life

46 hours

Total Cycles for Block

3,856

Total Degrees for Block

121,250

Instrument Properties

8

Instrument Label ruo

Serial Number 278860001

Instrument Firmware Version 1.0.3

P Address 172.28.1.105

Block Type 384-Well Block

Controller Firmware Version 1.0.2
Optics Firmware Version 24

Thermal Block Firmware Version 20

Heated Cover Firmware Version 10

28 Instiument Corr...

) 278860001 x
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Enable or change the calibration reminders

Note: While viewing the Monitor screen, you can generate reports of the calibration
history and status for the instrument. The following options are available from the
Instrument Manager:
* Print Calibration Log — Prints the calibration history of the instrument.
* Print Maintenance Summary - Prints a summary of the current instrument
calibrations.

Note: The details for an instrument in the My Preferred list can be exported even if the
network connection has been interrupted. The exported details from the disconnected
instrument would contain the data most recently downloaded from the instrument
before the interruption.

Enable or change the calibration reminders

Collect the
required
information

Define the mail
server settings

The calibration reminder settings allow you to configure the QuantStudio™" 6 and 7
Flex Real-Time PCR System Software to alert you by email when the QuantStudio™ 6
or 7 Flex System requires calibration. The notifications settings feature is optional, and

it does not affect instrument performance.

IMPORTANT! The calibration reminders feature requires a connection between the
QuantStudio™ 6 or 7 Flex System computer and a computer network. If you choose to
set up the feature as described below, ensure that your network has appropriate
security measures in place to protect data from threats such as computer viruses.

IMPORTANT! The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software
transmits emails only while the QuantStudio™ 6 or 7 Flex System is monitored. If the
network connection is interrupted, the software will stop transmitting updates.

The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software requires access to a
Simple Mail Transfer Protocol (SMTP) server to email calibration reminders. Contact
your systems administrator or information technology department for the following
information:

e Network address of an SMTP server.
* A user name and password for the server, if required for access.

® The Secure Sockets Layer (SSL) setting of the server (on or off).

1. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, select
Tools » Preferences.

2. From the Preferences dialog box, select the SMTP Settings tab.

3. Define the settings for the SMTP server:

a. From the Outgoing Mail Server (SMTP) field, enter the network address of
a Simple Mail Transfer Protocol (SMTP) server.
Optionally, you can specify the transmission control protocol (TCP) port for
the server by appending the port number to the server name, separating the
two using a colon ( :).

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems Maintenance and Administration Guide 31



Chapter 2 Calibrate the Instrument

Enable or change the calibration reminders

For example: smtp.mycompany.com:2023

Note: If a TCP port is not specified, the QuantStudio"" 6 and 7 Flex Real-
Time PCR System Software uses the default port number (25).

b. Select Encryption Required if the mail server has SSL enabled.

c. Select Authentication Required if the mail server requires a user name and
password.

d. If the mail server requires authentication, enter the user name and password
provided by your systems administrator.

13 Preferences

Defaults T Startup T Experiment T Print ]

SMTP Settings

Export Display Format Motification Settings

* Enter the SMTP server settings for email notifications.

Qutgoing Mail Sen'er(SMTP]:;
Encryption Required?: .
Authentication Required?: [
User Mame:

Passwaord:

1 (o< J[concel |

4. Click OK.

5. Test the mail server settings:

a. From the Home tab of the QuantStudio" 6 and 7 Flex Real-Time PCR System
Software, select any experiment in the Set Up panel, then click Set Up to
create a new experiment.

b. From the experiment document, click :@: Run in the Experiment Menu,
then click Notification Setting to view the notification settings for the
experiment.

c. From the Notification Settings of the experiment document, select Yes to
enable the Enable Notifications setting.

d. From the Enter e-mail addresses for notifications field, enter the email
address that you want to receive the test emails.

e. Click Test Configuration to test the mail server settings.
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Confirm that the email account you specified in step 5d received the test
messages from the QuantStudio™" 6 and 7 Flex Real-Time PCR System
Software. If not, consult your network administrator to confirm that the mail
server settings are defined correctly.

Run Status: Not Started

m [ Enable Notifications
c

Run Notification Settings
Amplification Plot Enable Notffications: () Yes (O No

Temperature Plot

Run Method

View Run Data

Test the current parameters.When you press the - -
Test Configuration, sample Run Started, Instrument Error, |REEARMGITE ]
Run Stopped, and Run Completed messages will be sent.

1. Open the Calibration Reminders screen for the QuantStudio™" 6 or 7 Flex System:

a. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Home
tab, click Instrument Console.

b. From the Instrument Console, select the icon for your instrument, then
click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your QuantStudio™ 6

or 7 Flex System to the My Instruments group.

c. From the Instrument Manager, click /‘% Maintenance, then click
Calibration Reminders.

2. From the Calibration Reminders Setting table, configure the notification settings
for the calibrations in interest. For each calibration that you want to monitor:

a. From the Send a Reminder column, select the check box to configure the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software to email a
reminder to perform the calibration.

b. From the Reminder Interval column, enter the number of days before the
calibration expires that the software should send a reminder email.

3. From the Enter e-mail addresses for notifications field, enter the email address(es)
that you want to receive notifications. Separate multiple email addresses with
commas (, ).
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ROIL

Background

Uniformity

Dye

Hormalization

HRM

RHase P Run

Sibraton

Reminders

Manage Files

[L

4. Click Apply to change the notification settings.

Calibration Reminders Settings

e
?\ Maintenance

Calibration Date Last Calibrated | Expiry Interval Date Calibration Ex.. Send an Email Remi... Reminder Interval | Reminder Date
ROI 13-07-2012 11:12:58 PDT| | 180[% 09-01-2013 11:12:58 PST ] Fi= 02-01-2013 11:12:58 PST|
Background 13-07-2012 11:27:13 PDT| 30/ 12-08-2012 11:27:13 PDT| ] 7B 05-08-2012 11:27:13 P...
Uniformity 13-07-2012 11:39:39 PDT| | 180|% 09-01-2013 11:39:39 PST Il 7E 02-01-2013 11:39:39 PST|
B Dye 1802 [} 7=
Dye-FAM 13-07-2012 11:50:46 PDT| 09-01-2013 11:50:46 PST sl 02-01-2013 11:50:46 PST|
Dye-VIC 13-07-2012 12:05:52 PDT| 09-01-2013 12:05:52 PST ] 02-01-2013 12:05:52 PST|
Dye-ROX 13-07-2012 12:17:14 PDT| 09-01-2013 12:17:14 PST ] 02-01-2013 12:17:14 PST|
Dye-CY5 13-07-2012 13:51:56 PDT| 09-01-2013 13:51:56 PST ] 02-01-2013 13:51:56 PST|
B Hormalzation 180}= = 7/
Wormalization-FAM/ROX13-07-2012 12:28:14 PDT| 09-01-2013 12:28:14 PST i} 02-01-2013 12:28:14 PST|
Normalization-VIC/ROX|1 3.07-2012 12:38:04 PDT 09-01-2013 12:38:04 PST ] 02-01-2013 12:38:04 PST|
Riase P 13-07-2012 14:27:41 PDT| | 180[= 09-01-2013 14:27:41 PST ] 7B 02-01-2013 14:27:41 PST|
El HRM 1802 ] 7=

Email Addresses Settings

Enter e-mail addresses for
Separate e-mail addrasses

notifications:
with ","

For example, "john@email.com, Kevin@email.com”

<

® 287880008 x
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Guidelines for preparing calibration plates and array cards

Observe the following guidelines when preparing calibration plates and array cards:
* Wear appropriate protective eyewear, clothing, and gloves.

¢ Prepare and run calibration plates and array cards within the recommended time
limits listed below.

Consumable Time to thaw After thawed, run within...
All 96-/384-well calibration 30 minutes 120 minutes
consumables’
All array card calibration 30 minutes 120 minutes
consumablest
RNase P plate (96-/384-well) 5 minutes 30 minutes
RNase P array card® 15 minutes 60 minutes

t All 96-well plates and 384-well plates used in the calibration of the instrument (ROI, background,
uniformity, dye, and normalization).

1 Al array cards used in the calibration of the QuantStudio™ 7 Flex System only (ROI, background,
uniformity, dye, and normalization).

§ For use with QuantStudio™ 7 Flex System only.

* (Plates only) Do not discard the packaging for the calibration plates. Each plate can
be used to calibrate the QuantStudio™" 6 and 7 Flex Systems 3 times for up to 6
months if it is stored in its packing sleeve.

* Store calibration plates or array cards in a dark place until you are ready to use
them. The fluorescent dyes in the wells of calibration consumables are
photosensitive. Prolonged exposure to light can diminish the fluorescence of the
dyes.

* Do not allow the bottoms of the plates or array cards to become dirty. Fluids and
other contaminants that adhere to the bottoms of the consumables can
contaminate the sample block and cause an abnormally high background signal.

¢ Confirm that your centrifuge is clean. Before centrifugation, wipe down the
bucket(s) using a tissue.

¢ Vortex and centrifuge all calibration plates to ensure complete mixing and that all
reagents are contained at the bottom of the wells. The calibration plates must be
well mixed and centrifuged before use.
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Preparing array cards for instrument calibration

Required materials

Filling the
calibration array
cards
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IMPORTANT! Perform the following procedure only if you are verifying the
performance of a QuantStudio" 7 Flex System with an array card sample block. The
QuantStudio™ 6 Flex System does not support the array card sample block.

* QuantStudio™ 7 Flex System Array Card Spectral Calibration Dye Kit:
— Array Cards, empty

- Array Card Spectral Calibration Dye Kit, including: FAM™ dye mix,
VIC® dye mix, ROX™ dye mix, ROI dye mix, Background Buffer,
FAM™/ROX™ dye mix, and VIC®/ROX™ dye mix

* Array Card Staker/Sealer

* Centrifuge with array card buckets and array card carrier clips
* Permanent marker or pen

* Pipettor, 200-pL (with pipette tips)

* Powder-free gloves

¢ Safety glasses

IMPORTANT! Wear powder-free gloves while creating the calibration array cards.

This procedure explains how to create all of the array cards required to calibrate the
QuantStudio™ 7 Flex System, but not all of them are required for a monthly
maintenance. Before preparing array cards for calibration, see “Calibration and
maintenance schedule” on page 28 to determine which calibrations are required.

Note: For more information on the array card loading procedure, contact Life
Technologies.

1. Remove the tubes of calibration solutions from the freezer, allow them to thaw,
then vortex the tubes to mix the contents well.

2. Remove the array cards from their box and place them on a clean, dry surface.

3. Mark the side of the empty array cards with: Background, FAM, ROI, ROX, VIC,
FAM/ROX, and VIC/ROX.

nagatadaldadatadg
- @\/@%@?ﬁ@é\’ Mark

4, For each array card, pipet 100 UL of the appropriate calibration solution into each
of the eight reservoirs in the array card:

a. Place the array card on a lab bench, with the foil side down.

b. Load 100 pL of the calibration solution into a pipette.
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c. Hold the pipette in an angled position (~45 degrees) and place the tip into
the fill port. The fill port is the larger of the two holes on the left side of the
fill reservoir.

Fill Vent
port | port

YU

d. Dispense the fluid so that it sweeps in and around the fill reservoir toward
the vent port.

Pipet the entire 100 puL into the fill reservoir, but do not go past the first stop
of pipettor plunger or you may blow the solution out of the port.
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IMPORTANT! Do not allow the tip to contact and possibly damage the coated
foil beneath the fill port.

5. Repeat step 4 to fill the remaining array card with the appropriate calibration
reagents.

6. Centrifuge the array card(s):

a. Place the filled array card(s) into a centrifuge array card carrier clip and
place empty array cards in the remaining slots. Confirm that the labels on the
buckets and clips are oriented in the same direction.

b. Place the filled carrier clips into the centrifuge buckets. Make sure that the
array card fill reservoirs and bucket and clip labels face outward when
loaded into the centrifuge.

IMPORTANT! You must run the centrifuge with all four buckets in place and
each of the two carriers filled with array cards. Place empty array cards into
unfilled slots.

IMPORTANT! Balance the loads in opposite buckets in the centrifuge.
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—Filled array

Empty
J*ﬂhlk%hml%‘1}:ray

\J“ ]
c. Close the centrifuge cover, then spin the array card(s) for 1 minute at
1200 rpm.

d. When the run is finished, stop the centrifuge, then spin the array card(s)
again for 1 minute at 1200 rpm.

IMPORTANT! Do not try to save time by doing one spin for 2 minutes. The
two sets of ramps are important for a good fill into the array card.

7. When the second run is finished, open the centrifuge and check that the fluid
levels in the reservoirs of each array card have decreased by the same amount.
Also, check all wells for bubbles and note the locations as possible problems.

Correct fill Incorrect/partial fill
ey @1 | e s (N o @

If necessary, centrifuge the array cards for an additional minute to fill any unfilled
wells. Do not exceed three 1-minute runs or centrifuge the array card for longer
than 1 minute at a time.

8. Seal the array card(s):

a. With the carriage (roller assembly) of the Array Card Staker/Sealer in the
Start position, place a filled array card into the fixture with the foil side up so
that the fill reservoirs are the farthest away from the carriage.

b. Press down on all four corners of the array card to ensure that it is fully
seated within the fixture.
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c. Use the two alignment pins in the fixture to position the array card correctly.

d. Seal the array card by running the carriage slowly over it. Run the carriage
over the array card in one direction only. Do not apply downward force on
the carriage as you move it forward over the card.

e. Remove the sealed array card from the fixture and trim the fill reservoirs
from the array card assembly using scissors. Trim the foil array card so that
the edge is even with the plastic carrier.

IMPORTANT! Completely remove the fill reservoirs from the array card so
that the edge is free of residual plastic. The plastic from the fill reservoirs that
extends beyond the edge of the card can prevent the array card from seating
properly on the sample block and can affect amplification.

Correct trim Incorrect trim

@ @ N 7@ @ 1

9. Repeat step 8 to seal the remaining array cards.

IMPORTANT! If an array card is sealed improperly, the it can leak and contaminate the
sample block and/or it can cause the associated calibration or RNase P test to fail.

IMPORTANT! As you seal the remaining filled array cards, store them in a dark place.
Do not expose the array cards to light until you are ready to use them. The dyes in the
array cards are photosensitive. Prolonged exposure to light can diminish the
fluorescence of the dye.
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A region of interest (ROI) calibration maps the positions of the wells on the sample
block of the instrument. The software uses the ROI calibration data to associate
increases in fluorescence during a run with the wells on the plate or array card. The
instrument uses a set of optical filters to distinguish the fluorescence emissions
gathered during runs. The software generates a calibration image for each filter to
account for minor differences in the optical path.

Perform the ROI calibration once every 6 months.

IMPORTANT! After every ROI calibration, you must perform (in order): a background
calibration, uniformity calibration, dye calibration, and a normalization calibration.

During the ROI calibration, the instrument software captures images of the ROI
calibration plate or array card at each instrument filter. An ROI calibration passes if the
collected image for each filter distinguishes all wells of the ROI plate or array card.
Each well in the image must be distinct and visible at the same luminosity relative to
the other wells in the image.

Note: You can review the ROI calibration image for each filter set by selecting the
desired filter combination from the Filter Set menu of the ROI tab in the Instrument
Manager.

Passing image Failing image

000000 00000000
2900090000 o000 09000
DPOO0OO XXX 200

P90 O LR N

o000 L X
290000 X K X |
09000

090 ®

Green circles around all wells indicate that Red circles around some of the wells

the wells calibrated successfully. Each green | indicate that the wells did not calibrate. The
circle indicates that the region of interest for | absence of a circle indicates that the region
the well position is sufficiently bright. of interest for the well position is not
sufficiently bright.
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IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates or
array cards.

Prepare the calibration consumable appropriate for your QuantStudio™ 6 or 7 Flex
System:

B Prepare the ROl calibration plate............. ... ... .o i, 41

B Preparing array cards for instrument calibration .......................... 36

Materials required
* Region of Interest (ROI) Plate
¢ Centrifuge with plate adapter
* Powder-free gloves

* Safety goggles

Prepare the plate

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare the plate.

1. Remove the ROI calibration plate from the freezer, then thaw it at room
temperature for approximately 30 minutes.

IMPORTANT! Use the calibration plate within 2 hours of defrosting it. Until you
are ready to run the plate, store it in the dark and at ambient temperature (15—
30°C). Do not remove the calibration plate from its packaging until you are ready
to run it. The fluorescent dyes in the wells of the plate are photosensitive.
Prolonged exposure to light can diminish the fluorescence of the dyes.

2. Remove the ROI plate from its packaging. Do not remove the optical film.

3. Vortex and centrifuge the plate:
a. Vortex the ROI calibration plate for 5 seconds.
b. Centrifuge the plate for 2 minutes at < 1500 rpm.

IMPORTANT! The ROI calibration plate must be well mixed and centrifuged.

c. Confirm that the liquid in each well of the ROI calibration plate is at the
bottom of the well. If not, centrifuge the plate again at a higher rpm and for a
longer period of time.

Correct Incorrect

Liquid is at ¢ Not centrifuged with enough force, or
bottom of well. | & Not centrifuged for enough time.
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Perform the ROI 1. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Home tab,
calibration click Instrument Console.

2. From the Instrument Console, select the icon for your instrument, then
click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your QuantStudio™ 6 or 7
Flex System to the My Instruments group.

3. From the Instrument Manager, start the calibration:
a. Click % Maintenance, then click ROI.
b. From the ROI Calibration screen, click Start Calibration.

4. Click Next, then prepare for the calibration as instructed.

5. From the bottom of the Setup tab, enter the reagent information for the ROI plate
or array card that you are using.

Reagent Information

Plate Barcode Reagent Name Reagent Part Number Reagent Lot Number Reagent Expiration Date

[] Check the box when the ROI calibration plate has been loaded, and when you have ensured you have entered all reagents information correctly

[ Corce [P |

nstrument Can, , . 287880008 x

6. Load the calibration plate or array card into the instrument:
a. From the instrument touchscreen, touch E to eject the instrument tray.
b. Load the plate or array card into the plate holder so that:

e Well Al of the plate or array card is in the top-left corner of the plate
adapter.

e The barcode faces the front of the instrument.

A1

00000256 I NNNMINININAIN

IMPORTANT! Plates and array cards should be loaded and unloaded by
operators who have been warned of the moving parts hazard and have been
adequately trained.

c. From the instrument touchscreen, touch E to close the instrument tray.

7. After loading the plate or array card, start the calibration:

a. From the bottom of the Setup tab, select Check the box when the ROI
calibration plate has been loaded, then click Next.
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b. From the Run screen, click START RUN.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to
10 minutes) to allow the heated cover to reach the required temperature.

8. When the run is complete and the software displays the Analysis screen, select
each filter from the Filter Set drop-down list, then confirm that the corresponding
ROI Image displays a green circle around each well area.

9. After you inspect all ROI images, confirm the status of the calibration, where
passed indicates that the run produced viable calibration data, and failed indicates
that the run did not produce data or that the data it collected is unusable.

Analysis status Action
Passed Click Next.
Failed Troubleshoot the failed calibration as described in “ROI calibration
troubleshooting” on page 70.

10. Unload the calibration plate or array card:

a. After the calibration, touch E on the touchscreen to eject the plate or array
card.

Note: If the instrument does not eject the plate or array card, remove it as
explained in “ROI calibration troubleshooting” on page 70.

b. Remove the ROI calibration plate or array card from the instrument tray and
store it in the dark at room temperature until you are ready to perform the
uniformity calibration.

WARNING! PHYSICAL INJURY HAZARD. During instrument
operation, the plate or array card temperature can reach 100°C. Allow
the consumable to cool to room temperature before removing.

c. Touch E on the instrument touchscreen to close the instrument tray.
11. From the ROI Calibration screen, click Finish to complete the calibration, then
click Yes when prompted to save the results.

Note: If the QuantStudio™" 6 and 7 Flex Real-Time PCR System Software displays
the warning, “Saving ROI calibration will invalidate other existing calibrations
except HRM Calibrations”, click OK to proceed.

Note: HRM (High Resolution Melt) is a separately licensed module. If your
instrument requires this module, contact Life Technologies.

12. (Optional) Click Print Report in the upper right corner of the screen to print a
summary of the calibration results for your records.
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The software uses the background calibration data during subsequent experiments to
remove background fluorescence from the experiment data.

Perform the background calibration monthly.

During the background calibration, the software captures a series of images of the
background plate or array card using each instrument filter. The software compares
the fluorescence from each well to the average for the plate or array card. A
background calibration passes if the collected images for all filters are free of abnormal
fluorescence.

Background fluorescence

Fluorescence data collected by the instrument includes a fluorescence signal inherent
to the instrument, referred to as “background fluorescence.” Background fluorescence
is a composite signal found in all spectral data that consists of fluorescence from
several sources, including:

* Background electronic signal
¢ Contaminants in the sample block

* The plastic consumable (plate or array card)

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates or
array cards.

Prepare the calibration consumable appropriate for your QuantStudio™ 6 or 7 Flex
System:

B Prepare the background calibrationplate ...................... ... ... ... 45

B Preparing array cards for instrument calibration........................... 36
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Background calibration

Centrifuge with plate adapter

* Powder-free gloves

* Safety goggles

Prepare the plate

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare the plate.

1. Remove the background calibration plate from the freezer, then thaw it at room
temperature for approximately 30 minutes.

IMPORTANT! Use the calibration plate within 2 hours of defrosting it. Until you
are ready to run the plate, store it in the dark and at ambient temperature (15—
30°C). Do not remove the plate from its packaging until you are ready to run it.

2. Remove the background calibration plate from its packaging. Do not remove the

optical film.

3. Vortex and centrifuge the plate:

a. Vortex the background calibration plate for 5 seconds.

b. Centrifuge the plate for 2 minutes at < 1500 rpm.

IMPORTANT! The background calibration plate must be well mixed and

centrifuged.

c. Confirm that the liquid in each well of the background calibration plate is at
the bottom of the well. If not, centrifuge the plate again at a higher rpm and
for a longer period of time.

IMPORTANT! Do not allow the bottom of the plate to become dirty. Fluids
and other contaminants that adhere to the plate bottom can contaminate the
sample block and cause an abnormally high background signal.

Correct

Incorrect

Liquid is at
bottom of well.

e Not centrifuged with enough force, or
¢ Not centrifuged for enough time.
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1. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Home tab,
click Instrument Console.

2. From the Instrument Console, select the icon for your instrument, then
click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your QuantStudio™ 6 or 7
Flex System to the My Instruments group.

3. From the Instrument Manager, start the calibration:
a. Click (% Maintenance, then click Background.
b. From the Background Calibration screen, click Start Calibration.

4. Click Next, then prepare for the calibration as instructed.

5. From the bottom of the Setup tab, enter the reagent information for the
background plate or array card that you are using.

Reagent Information

Plate Barcode Reagent Name Reagent Part Number Reagent Lot Number Reagent Expiration Date

[7] Check the box when the background calibration plate has been loaded, and when you have ensured you have entered all reagents information correctly

[ Corce [P |

nstrument Can, , . 287880008 x

6. Load the calibration plate or array card into the instrument:
a. From the instrument touchscreen, touch E to eject the instrument tray.
b. Load the calibration plate or array card into the plate holder so that:

e Well Al of the plate or array card is in the top-left corner of the plate
adapter.

e The barcode faces the front of the instrument.

00000256 I INNNMINIINAIN

IMPORTANT! Plates or array cards should be loaded and unloaded by
operators who have been warned of the moving parts hazard and have been
adequately trained.

c. From the instrument touchscreen, touch E to close the instrument tray.

7. After loading the plate or array card, start the calibration:

a. From the Setup tab, select Check the box when the background calibration
plate has been loaded, then click Next.
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b. From the Run screen, click START RUN.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to
10 minutes) to allow the heated cover to reach the required temperature.

8. When the run is complete and the QuantStudio'" 6 and 7 Flex Real-Time PCR
System Software displays the Analysis screen, confirm the status of the
calibration. The analysis status indicates the success of the calibration, where
passed indicates that the run produced viable calibration data, and failed indicates
that the run did not produce data or that the data it collected is unusable.

Analysis status Action
Passed Click Next.
Failed Troubleshoot the failed calibration as described in “Background
calibration troubleshooting” on page 71.

Note: Abnormal spectra or abnormally high background fluorescence can
indicate the presence of contamination on the plate or array card or sample block,
which can cause the calibration to fail.

9. Select the QC tab to review the quality check summary. The QC status indicates
the quality of the calibration data, where “Passed” indicates that all wells
produced data that passed the quality check, and “Failed” indicates that one or
more wells produced spectra that deviate significantly from the other wells on the
plate or array card.

Note: If the calibration failed, the QC tab can provide information regarding the
cause of the failure.

10. Unload the calibration plate or array card:

a. After the calibration, touch E on the touchscreen to eject the plate or array
card.

Note: If the instrument does not eject the plate or array card, remove it as
explained in “Background calibration troubleshooting” on page 71.

b. Remove the plate or array card from the instrument tray and discard it.

WARNING! PHYSICAL INJURY HAZARD. During instrument
operation, the plate or array card temperature can reach 100°C. Allow
the consumable to cool to room temperature before removing.

c. Touch E on the instrument touchscreen to close the instrument tray.

11. From the Background Calibration screen, click Finish to complete the calibration,
then click Yes when prompted to save the results.

12. (Optional) Click Print Report in the upper right corner of the screen to print a
summary of the calibration results for your records.
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The uniformity calibration generates data that allows the software to compensate for
the physical effects of the instrument filters.

Perform a uniformity calibration once every 6 months.

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates or
array cards.

Prepare the calibration consumable appropriate for your QuantStudio™ 6 or 7 Flex
System:
B Prepare the ROl calibration plate ........... ... ... i, 48

B Preparing array cards for instrument calibration........................... 36

Materials required

Note: The uniformity calibration requires the same materials used to perform the ROI
calibration.

* Region of Interest (ROI) Plate
¢ Centrifuge with plate adapter
* Powder-free gloves

* Safety goggles

Prepare the plate

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare the plate.

If you have a prepared ROI calibration plate from a recent ROI calibration, go to step
3b below; otherwise, prepare the ROI calibration plate as follows:

1. Remove the ROI calibration plate from the freezer, then thaw it at room
temperature for approximately 30 minutes.

IMPORTANT! Use the calibration plate within 2 hours of defrosting it. Until you
are ready to run the plate, store it in the dark and at ambient temperature (15—
30°C). Do not remove the plate from its packaging until you are ready to run it.

2. Remove the ROI plate from its packaging. Do not remove the optical film.

3. Vortex and centrifuge the plate:
a. Vortex the ROI calibration plate for 5 seconds.

b. Centrifuge the plate for 2 minutes at < 1500 rpm.

IMPORTANT! The ROI calibration plate must be well mixed and centrifuged.
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c. Confirm that the liquid in each well of the ROI calibration plate is at the
bottom of the well. If not, centrifuge the plate again at a higher rpm and for a
longer period of time.

Correct Incorrect

Liquid is at ¢ Not centrifuged with enough force, or
bottom of well. |« Not centrifuged for enough time.

From the QuantStudio " 6 and 7 Flex Real-Time PCR System Software Home tab,
click Instrument Console.

From the Instrument Console, select the icon for your instrument, then
click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your QuantStudio™™ 6 or 7
Flex System to the My Instruments group.

From the Instrument Manager, start the calibration:
a. Click j‘% Maintenance, then click Uniformity.
b. From the Uniformity Calibration screen, click Start Calibration.

Click Next, then prepare for the calibration as instructed.

From the bottom of the Setup tab, enter the reagent information for the ROI plate
or array card that you are using.

Reagent Information

Plate Barcode Reagent Name Reagent Part Number Reagent Lot Number Reagent Expiration Date

[7] Check the box when the ROI calibration plate has been loaded, and when you have ensured you have entered all reagents information correctly

R

>

Instrument Can, , . * 287880008 x
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6. Load the calibration plate or array card into the instrument:

a. From the instrument touchscreen, touch E to eject the instrument tray.

b. Load the calibration plate or array card into the plate holder so that:

¢ Well A1 of the plate or array card is in the top-left corner of the plate

adapter.

e The barcode faces the front of the instrument.

00000256 I NNNMINIINAIN

IMPORTANT! Plates or array cards should be loaded and unloaded by
operators who have been warned of the moving parts hazard and have been
adequately trained.

c. From the instrument touchscreen, touch E to close the instrument tray.

7. After loading the plate or array card, start the calibration:

a. From the Setup tab, select Check the box when the ROI calibration plate
has been loaded, then click Next.

b. From the Run screen, click START RUN.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to
10 minutes) to allow the heated cover to reach the required temperature.

8. When the run is complete and the Analysis screen displays, confirm the status of
the calibration. The analysis status indicates the success of the calibration, where
passed indicates that the run produced viable calibration data, and failed indicates
that the run did not produce data or that the data it collected is unusable.

Analysis status

Action

Passed
Failed

Click Next.

Troubleshoot the failed calibration as described in “Uniformity
calibration troubleshooting” on page 72.

9. Select the QC tab to review the quality check summary.

Note: The QC tab can provide information on the cause of a failed calibration.
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10. Unload the calibration plate or array card:

a. After the calibration, touch a on the touchscreen to eject the plate or array
card.

Note: If the instrument does not eject the plate or array card, remove it as
explained in “Uniformity calibration troubleshooting” on page 72.

b. Remove the calibration plate or array card from the instrument tray and
discard it.

WARNING! PHYSICAL INJURY HAZARD. During instrument
operation, the plate or array card temperature can reach 100°C. Allow
the consumable to cool to room temperature before removing.

c. Touch a on the instrument touchscreen to close the instrument tray.

11. From the Uniformity Calibration screen, click Finish to complete the calibration,
then click Yes when prompted to save the results.

12. (Optional) Click Print Report in the upper right corner of the screen to print a
summary of the calibration results for your records.
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The software uses the calibration data collected from the dye standards to characterize
and distinguish the individual contribution of each dye in the total fluorescence
collected by the instrument. After each run, the instrument software receives data in
the form of a raw spectra signal for each reading. The software determines the
contribution of the fluorescent dyes used in each reaction by comparing the raw
spectra to the pure spectra calibration data. When you save an experiment after
analysis, the instrument software stores the pure spectra with the collected
fluorescence data for that experiment.

Perform a dye calibration once every 6 months.

IMPORTANT! Perform a background calibration before every series of dye calibrations.
Because the age and use of instrument components can affect spectra readings, you
must perform a dye calibration at least every 6 months.

The product of a dye calibration is a collection of spectral profiles that represent the
fluorescence signature of each dye standard. Each profile consists of a set of spectra
that correspond to the fluorescence collected from the wells of the calibration plate or
array card. Following the calibration of each dye, the software “extracts” a spectral
profile for each dye. The software plots the resulting data for each profile in a graph of
fluorescence versus filter.

When the software extracts the dye calibration data, it evaluates the fluorescence
signal generated by each well in terms of the collective spectra for the entire calibration
plate or array card. Dye spectra are generally acceptable if they peak within the same
filter as their group, but diverge slightly at other wavelengths (see below).

Acceptable spectra Unacceptable spectra

Spectra peak at the same wavelength and do Spectra peak at the different wavelengths
not diverge significantly

0 i

0.8

Normalized Fluorescence
Normalized Fluorescence

04

1w - - - o2 2 o -2 -3 -rri3-mB- - - i i -mi 212 - - - PR 21 o e - o i S e -mé-mi
Filter Filter

Note: Because the wells of a calibration plate or array card contain identical
concentrations of a dye, the resulting signals for the wells should be similar. Variations
in spectral position and peak position are caused by minor differences in the optical
properties and excitation energy between the individual wells.
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Preparing the IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates or
calibration plate or  array cards.
array card
Prepare the calibration consumable appropriate for your QuantStudio™ 6 or 7 Flex
System:
B Prepare the dye calibrationplates ............. .. ... .. ... il 53
B Preparing array cards for instrument calibration .......................... 36
Prepare the dye Materials required
calibration plates * Spectral calibration plates

— Spectral Calibration Plate with FAM™ Dye

— Spectral Calibration Plate with VIC® Dye

— Spectral Calibration Plate with ROX™ Dye

— Spectral Calibration Plate with NED™ Dye

- Spectral Calibration Plate with TAMRA™ Dye

— Spectral Calibration Plates as required by the experiment that you intend to
run

¢ Centrifuge with plate adapter
* Powder-free gloves

* Safety goggles

Prepare the plate

IMPORTANT! Before performing a dye calibration, you must perform an ROI
calibration, a background calibration, and a uniformity calibration.

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare the plate.

1. Remove the dye calibration plate from the freezer, then thaw it at room
temperature for approximately 30 minutes.

IMPORTANT! Use the calibration plates within 2 hours of defrosting them. Until
you are ready to run the plates, store them in the dark and at ambient
temperature (15-30°C). Do not remove the plates from their packaging until you
are ready to run them.
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2. Before using each dye plate, vortex the plate for 5 seconds, centrifuge it for
2 minutes at < 1500 rpm, then confirm that the liquid in each dye plate is at the
bottom of the wells. If not, centrifuge the plate again at a higher rpm and for a
longer period of time.

Correct Incorrect
Liquid is at ¢ Not centrifuged with enough force, or
bottom of well. |« Not centrifuged for enough time.
Perform the dye IMPORTANT! The software guides you through the calibration of each dye separately.
calibration You must set up, run, and analyze each dye independently.

1. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Home tab,
click Instrument Console.

2. From the Instrument Console, select the icon for your instrument, then
click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your QuantStudio™ 6 or 7
Flex System to the My Instruments group.

3. From the Instrument Manager, start the calibration:
a. Click %‘% Maintenance, then click Dye.

b. From the Dye Calibration screen, select System Dye Calibration, then
click Start Calibration.

4. From the Dye Calibration screen, select the dye to calibrate from the Dye Name
drop-down list, then perform the calibration as instructed.

5. From the bottom of the Setup tab, enter the reagent information for the dye plate
or array card that you are using.

Reagent Information

Plate Barcode Reagent Name Reagent Part Number Reagent Lot Number Reagent Expiration Date

[7] Check the box when the dye calibration plate has been loaded, and when you have ensured you have entered all reagents information correctly

[ Corce [P |

* 287880008 x

6. Load the dye plate or array card into the instrument:
a. From the instrument touchscreen, touch E to eject the instrument tray.

b. Confirm that the dye plate or array card matches the dye selected in the
software, then load it into the plate holder.

Load the plate or array card so that:

e Well Al of the plate or array card is in the top-left corner of the plate
adapter.

¢ The barcode faces the front of the instrument.
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Note: The name of the dye contained by the plate or array card is next to the
barcode on the front of it.

IMPORTANT! Plates or array cards should be loaded and unloaded by
operators who have been warned of the moving parts hazard and have been
adequately trained.

c. From the instrument touchscreen, touch E to close the instrument tray.

7. After loading the plate or array card, start the calibration:

a. From the Dye Calibration screen, select Check the box when the dye
calibration plate has been loaded, then click Next.

b. From the Run screen, click START RUN.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to
10 minutes) to allow the heated cover to reach the required temperature.

8. When the run is complete and the software displays the Analysis screen, confirm
the grouping of the dye spectra:

a. Select the Plate Layout tab, then review the raw data. For each spectrum,
confirm that the peak is:

* Within the detectable range for the QuantStudio"" 6 and 7 Flex Systems.

¢ Free of irregular spectral peaks.

¢ Present at the correct filter for the dye (see “Instrument filters and
supported dyes” on page 17).

Note: Among wells containing the same dye, variations in spectral position
and peak position are caused by minor differences in the optical properties
and excitation energy between the individual wells.

b. Select the QC tab, then review the summary of wells that failed the quality
check (QC).

9. After you inspect the dye spectra, confirm the analysis status of the calibration.
The analysis status indicates the success of the calibration, where passed indicates
that the run produced viable calibration data, and failed indicates that the run did
not produce data or that the data it collected is unusable.
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10.

1.

12.

13.

Analysis status Action

Passed 1. Click Next.

2. Enter comments in the Comments field, click Finish, then
click Yes when prompted to save the results.

Failed Troubleshoot the failed calibration as described in “Dye calibration
troubleshooting” on page 73.

Select the QC tab to review the quality check summary. The QC status indicates
the quality of the calibration data, where passed indicates that all wells produced
data that passed the quality check, and failed indicates that one or more wells
produced dye spectra that differ significantly from the other wells on the plate or
array card.

Note: If the calibration failed, the QC tab can provide information regarding the
cause of the failure.

Unload the calibration plate or array card:

a. After the calibration, touch E on the touchscreen to eject the plate or array
card.

Note: If the instrument does not eject the plate or array card, remove it as
explained in “Dye calibration troubleshooting” on page 73.

b. Remove the calibration plate or array card from the instrument tray and
discard it.

WARNING! PHYSICAL INJURY HAZARD. During instrument
operation, the plate or array card temperature can reach 100°C. Allow
the consumable to cool to room temperature before removing.

c. Touch E on the instrument touchscreen to close the instrument tray.

Repeat the calibration to calibrate the instrument for the remaining dyes that are
present in the experiments that you will be running.

(Optional) Click Print Report in the upper right corner of the screen to print a
summary of the calibration results for your records.
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Normalization calibration

During the normalization calibration, the instrument collects and stores the data from
the normalization standards.

When to perform Perform a normalization calibration once every 6 months.
the calibration

About the During the normalization calibration, the software captures a series of images of each
calibration data normalization plate or array card using each instrument filter. The normalization
calibration yields a “Pass” or “Fail” result for each normalization consumable used.

Preparing the IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates or
calibration plate or  array cards.
array card
Prepare the calibration consumable appropriate for your QuantStudio™" 6 or 7 Flex
System:
B Prepare the normalization calibrationplates...................... ... ..., 57
B Preparing array cards for instrument calibration ....................... ... 36
Prepare the Materials required
normalization * Normalization Plate with FAM"™/ROX™ dyes
calibration plates e Normalization Plate with VIC™/ROX™ dyes

¢ Centrifuge with plate adapter
* Powder-free gloves

* Safety goggles

Prepare the plate

IMPORTANT! Before performing a normalization calibration, you must perform an ROI
calibration, a background calibration, a uniformity calibration, and a dye calibration.

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare the plate.

1. Remove the normalization calibration plates from the freezer, then allow them to
warm to room temperature (approximately 30 minutes).

IMPORTANT! Use the calibration plates within 2 hours of defrosting them. Until
you are ready to run the plates, store them in the dark and at ambient
temperature (15-30°C). Do not remove the plates from their packaging until you
are ready to run them.
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Perform the
normalization
calibration

58

Go to “Perform the normalization calibration” on page 58.

Before using each normalization plate, vortex the plate for 5 seconds, centrifuge it
for 2 minutes at <1500 rpm, then confirm that the liquid in each dye plate is at the
bottom of the wells. If not, centrifuge the plate again at a higher rpm and for a
longer period of time.

Correct Incorrect

Liquid is at ¢ Not centrifuged with enough force, or
bottom of well. |+ Not centrifuged for enough time.

From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Home tab,
click Instrument Console.

From the Instrument Console, select the icon for your instrument, then
click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your QuantStudio™™ 6 or 7
Flex System to the My Instruments group.

From the Instrument Manager, start the calibration:
a. Click Z:L; Maintenance, then click Normalization.

b. From the Normalization Calibration screen, click Start Calibration.

From the Normalization Calibration screen, select the reporter/passive dye
combination that you want to calibrate, then perform the calibration as instructed.

From the bottom of the Setup tab, enter the reagent information for the
normalization plate or array card that you are using.

Reagent Information

Plate Barcode Reagent Name Reagent Part Number Reagent Lot Number Reagent Expiration Date

[] Check the box when the normalization calibration plate has been loaded, and when you have ensured you have entered all reagents information correctly

[ Corce [[Previo-_ |
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6. Load the calibration plate or array card into the instrument:
a. From the instrument touchscreen, touch E to eject the instrument tray.

b. Confirm that the normalization plate or array card matches the selection in
the software, then load it into the plate holder so that:

¢ Well A1 of the plate or array card is in the top-left corner of the plate
adapter.

e The barcode faces the front of the instrument.
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Note: The dyes contained in each plate or array card appear next to the
barcode on the front of it.

IMPORTANT! Plates or array cards should be loaded and unloaded by
operators who have been warned of the moving parts hazard and have been
adequately trained.

c. From the instrument touchscreen, touch E to close the instrument tray.

7. After loading the plate or array card, start the calibration:

a. From the Normalization Calibration screen tab, select Check the box when
the normalization calibration plate has been loaded, then click Next.

b. From the Run screen, click START RUN.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to
10 minutes) to allow the heated cover to reach the required temperature.

8. When the run is complete and the QuantStudio'" 6 and 7 Flex Real-Time PCR
System Software displays the Analysis screen, confirm the status of the
calibration. The analysis status indicates the success of the calibration, where
passed indicates that the run produced viable calibration data, and failed indicates
that the run did not produce data or that the data it collected is unusable.

Analysis status Action
Passed Enter comments in the Comments field, click Next.
Failed Troubleshoot the failed calibration as described in the
“Normalization calibration troubleshooting” on page 74.
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10.

11.

12.

13.

Select the QC tab to review the quality check summary. The QC status indicates
the quality of the calibration data, where passed indicates that all wells produced
data that passed the quality check, and failed indicates that one or more wells
produced unusable data.

Note: If the calibration failed, the QC tab can provide information regarding the
cause of the failure.

Unload the calibration plate or array card:

a. After the calibration, touch E on the touchscreen to eject the plate or array
card.

Note: If the instrument does not eject the plate or array card, remove it as
explained in “Normalization calibration troubleshooting” on page 74.

b. Remove the calibration plate or array card from the instrument tray and
discard it.

WARNING! PHYSICAL INJURY HAZARD. During instrument
operation, the plate or array card temperature can reach 100°C. Allow
the consumable to cool to room temperature before removing.

c. Touch E on the instrument touchscreen to close the instrument tray.

From the Normalization Calibration screen, click Finish to complete the
calibration, then click Yes when prompted to save the results.

Repeat the calibration procedure to perform the remaining normalization
calibration.

(Optional) Click Print Report in the upper right corner of the screen to print a
summary of the calibration results for your records.
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Verify the instrument performance

When necessary, you can perform the RNase P instrument verification test to confirm
the performance of the QuantStudio'" 6 and 7 Flex Systems.

When to perform We recommend performing an RNase P instrument verification test:
the test e After moving the instrument to another location.

e Asneeded to confirm the function of the instrument.

About the RNase P The RNase P instrument verification test uses instrument verification kits available

Kits from Life Technologies. The kits differ only in the consumable format for which they
are designed: an RNase P Instrument Verification Plate for QuantStudio'" 6 and 7 Flex
Systems with 96/384-well sample blocks and an Array Card RNase P Kit for the
QuantStudio™ 7 Flex System with array card sample blocks.

RNase P Instrument Verification Plates

The RNase P plate is preloaded with the reagents necessary for the detection and
quantitation of genomic copies of the human RNase P gene (a single-copy gene
encoding the RNase moiety of the RNase P enzyme). Each well contains: PCR master
mix, RNase P primers, FAM"" dye-labeled probe, and a known concentration of
human genomic DNA template.

The figure to the right illustrates the T o5 T % 6 7 o9 0 2
arrangement of the standard and A
unknown populations on a 96-well and B Ynknow A
Fast 96-well RNase P plate. The RNase P c (50001
plate contains five replicate groups of 5 NTC STD 1250 | STD 2500
standards.(1250, 2500, 5000, 10000, an.d a0 5000 o1V 160001 ST 20000
20000 copies), two unknown populations
(5,000 and 10,000 copies), and a no - Unknown B
template control (NTC). G (10000}
H

The figure to the right illustrates the (S P
arrangement of the standard and I \
unknown populations on a 384-well
RNase P plate. The RNase P plate contains 1z op
five replicate groups of standards (1250, 8I2(2(E(E]E
2500, 5000, 10000, and 20000 copies), two | [HE[EZEE  evosr | liooc0)
unknown populations (5,000 and 10,000 1815155 5l
copies), and a no template control (NTC). ! 2

b 1

= — S—
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Array Card RNase P Kits

The RNase P Kits include one empty array card and eight tubes of solution. Each tube
contains reaction mix (PCR master mix, RNase P primers, and FAM"™-MGB dye-

labeled probe) and a known concentration of human genomic DNA template.

To perform an instrument verification 1230456l

run, each solution is loaded into the g No Template Control 1
empty array card in the arrangement 0 Ynknown A (800) 2
shown right. When complete, the array ¢ Ynknown B {1600} 3
card contains five replicate groups of 0 Standard 20 4
standards (200, 400, 800, 1600, and 3200 Standard 40 5
copies), two of unknown populations L :‘a\"“ a f ‘:33 . f
(800 and 1600 copies), and one that " cla\"“ 2ra s 7
serves as a no template control (NTC). : tandard 3200 8
Analytical The software performs the same analysis of data from an instrument verification run

performance regardless of the type of consumable used.

After the run, the software:

1. Generates a standard curve from the averaged threshold cycle (Cr) values of the
replicate groups of standards.

2. Calculates the concentration of the two unknown populations using the standard
curve.

3. Calculates the following to assess the QuantStudio'" 6 or 7 Flex System
performance:

[(CoprnkZ) - 3(GCoprnk2)] > [(Coprnkl) + 3(<5Coprnk1)]
where:

¢ CopyUnk; = Average copy number of unknown population A
® GCopyUnk1 = Standard deviation of unknown population A
¢ CopyUnk, = Average copy number of unknown population B
®* GcopyUnk2 = Standard deviation of unknown population B

Note: Unknown population A refers to the 5,000-copy population and unknown
population B refers to the 10,000-copy population in the RNase P plate.
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Installation The QuantStudio™ 6 or 7 Flex System passes the installation specification if the
specification inequality holds and the instrument successfully distinguishes between unknown
populations A and B with a statistical confidence level of 99.7%.

As shown in the following table, you can omit a limited number of outlier wells from
the unknown populations to meet the installation specification.

Maximum number of outlier wells that can be removed
Sample block Unknown Unknown Standards No template
population AT | population B¥ (STD)8 controls (NTC)
96-well platet? 6 6 1 0
384-well plate 10 10 2 0
Array card*¥ 4 4 4 0

1 5,000-copy population for 384-well plates; 800-copy population for array cards.

T 10,000-copy population for 384-well plates; 1,600-copy population for array cards.
§ Maximum number of wells that can be removed from each standard population.
T1Standard 96-well plates or Fast 96-well plates

11 QuantStudio™ 7 Flex System only.

Prepare the Materials required

RNase P plate * RNase P Instrument Verification Plate
¢ Centrifuge with plate adapter
e Powder-free gloves

* Safety goggles

Prepare the plate

IMPORTANT! When performing the RNase P instrument verification test:
* Perform all calibrations beforehand.

* Run the RNase P plate soon after you allow the plate to thaw. Minimizing the time
that the prepared plate or array card sits on the bench ensures optimal
performance.

* Wear powder-free gloves and safety glasses when you prepare plates.

1. Obtain the RNase P Instrument Verification Plate from the freezer, then allow the
plate to warm to room temperature (for approximately 5 minutes).

IMPORTANT! Use the RNase P plate within 30 minutes of defrosting it. Until you
are ready to run the plate, store it in the dark and at ambient temperature (15—
30°C). Do not remove the plate from its packaging until you are ready to run it.

2. Remove the RNase P plate from its packaging.

3. Briefly vortex and centrifuge the RNase P plate:

a. Vortex the plate for 5 seconds.
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b. Centrifuge the reaction plate for 2 minutes at <1500 rpm.

IMPORTANT! The reaction plate must be well mixed and centrifuged.

c. Confirm that the liquid is at the bottom of each well of the reaction plate. If
not, centrifuge the reaction plate again at a greater rpm and for a longer
period of time.

IMPORTANT! Do not allow the bottom of the plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block and cause an abnormally high background.

Correct Incorrect

Liquid is at ¢ Not centrifuged with enough force, or
bottom of well. |« Not centrifuged for enough time.

Preparing an array  IMPORTANT! Perform the following procedure only if you are verifying the
card forinstrument  performance of a QuantStudio™ 7 Flex System with an array card sample block.

verification

Required materials
* Array Card Staker/Sealer
¢ Centrifuge with centrifuge array card carrier clips and buckets
* Powder-free gloves
* Safety goggles
* Pipettor, 200-pL (with pipette tips)
* RNase P Array Card Instrument Verification Reagents Kit:
— Array Card

— RNase P Array Card Instrument Verification Reagents Kit, including tubes
with reagent mix for each port (8 tubes total)

Preparing the RNase P Array Card

IMPORTANT! Wear powder-free gloves while preparing the array card.

1. Remove the Array Card RNase P Kit from the freezer, then allow it to warm to
room temperature (for approximately 15 minutes).

IMPORTANT! You must fill and run the RNase P array card within 60 minutes of
thawing the Array Card RNase P Kit.

2. Remove an array card from its box and place it on a clean, dry surface.
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3. Using a permanent marker, mark the side of the empty array card with RNase P.

)
=

e

AR
GRsRaRbabAL
./(!».&;&2(!K = Mark

4, Transfer 100 uL of each solution into the appropriate port of the array card:

12345678 9][10[11]12[13[14[15[16]17[18][19]20]21]22[23[24] PORT
A No T n Cantral 1
B No temptate controt 1
c 1 A(800) L
D NKNOWT touyu) Z
E 1 (1400) 2
F NKNOWT t16uyu) &)
G Ch L, /
H StandaardZ 4
! Ch Az [
3 Stanaard 4 9
K c +HQ /
L Stanaard o (o]
L] c A 1400 7
N Standara 160U 7
o c ~ 2900 Q
P Standarad 320U (]

For each transfer:
a. Place the array card on a lab bench, with the foil side down.
b. Load 100 pL of fluid into a pipette.

c. Hold the pipette in an angled position (~45 degrees) and place the tip into
the fill port. The fill port is the larger of the two holes on the left side of the
fill reservoir.

Fill Vent
port | port

NUULRA

d. Dispense the fluid so that it sweeps in and around the fill reservoir toward
the vent port. Pipet the entire 100 pL into the reservoir, but do not go past the
first stop of pipettor plunger or you may blow the solution out of the port.

IMPORTANT! Do not allow the tip to contact and possibly damage the coated
foil beneath the fill port.

ey

S
Z
Z

%
\/\/\/\s

LR

NG

N
Az

SIS

5. Centrifuge and seal the array card as explained in steps a through 8 on page 37.
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6. Run the prepared array card as soon as possible after filling it.

IMPORTANT! Store the array card in a dark place until you are ready to run it. The
fluorescent dyes in the array card are photosensitive. Prolonged exposure to light can
diminish the fluorescence of the dye.

-_

Run the RNase P From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Home tab,
plate or array card click Instrument Console.

2. From the Instrument Console, select your instrument icon, then click Manage
Instrument.

Note: If the Manage Instrument button is inactive, add your QuantStudio" 6 and
7 Flex Instrument to the My Instruments group.

3. From the Instrument Manager, start the RNase P run:
a. Click j% Maintenance, then click RNase P Run.
b. From the RNase P Run screen, click Start RNase P Run.

4. Click Next, then prepare for the instrument verification test as instructed.

5. From the bottom of the Setup tab, enter the reagent information for the RNase P
plate or array card that you are using.

Reagent Information

Plate Barcode Reagent Name Reagent Part Number Reagent Lot Number Reagent Expiration Date

[] Check the box when the RNase P plate has been loaded, and when you have ensured you have entered all reagents information correctly

R

Instrument Con, . 287880008 x

6. Load the RNase P plate or array card into the instrument:
a. From the instrument touchscreen, touch E to eject the instrument tray.
b. Load the plate or array card into the plate holder so that:
o Well Al of the plate or array card is in the top-left corner of the adapter.

e The barcode faces the front of the instrument.
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IMPORTANT! Plates and array cards should be loaded and unloaded by
operators who have been warned of the moving parts hazard and have been
adequately trained.

c. From the instrument touchscreen, touch E to close the instrument tray.
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7. After loading the plate or array card, start the instrument verification test:

a. From the Overview screen, select Check the box when the RNase P plate
has been loaded, then click Next.

b. From the Run screen, click START RUN to start the test.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the instrument is in operation.

Note: Before starting the instrument verification test, the instrument may pause
(up to 10 minutes) to allow the heated cover to reach the required temperature.

8. When the run is complete and the software displays the Analysis screen, confirm
the status of the run.

Analysis status

Action

Passed

The QuantStudio™ 6 or 7 Flex System passed the RNase P run.

Failed

The QuantStudio™ 6 or 7 Flex System failed the RNase P run.
Review the data for outliers.

If the run fails, the software may have included outliers that caused
the initial analysis to fail. Error may cause some wells to be
amplified insufficiently or not at all. These wells typically produce
Cy values that differ significantly from the average for the
associated replicate wells. If included in the calculations, these
outlying data (outliers) can result in erroneous measurements.

9. From the Amplification Plot, select Ct vs. Well from the Plot Type menu.

10. Confirm the uniformity of each replicate population (controls, standards, and
unknowns) on the plate or array card by comparing the groupings of Cy values:

a. From the Plate Layout, select the wells containing Unknown Population A:

b. From the plot, confirm that the Cys of the replicate population are

equivalent.

Note: The numbers on the X-axis of the plot correspond to the wells of the
plate or array card. Beginning with well A1, the wells are numbered from
left-to-right, and top-to-bottom.
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c. If an outlier is present in the selected population, select the corresponding
well of the plate layout, then click Omit to remove the well from the analysis.
If the total number of outliers for the replicate population exceeds the limit in
the table below, repeat the test using another RNase P plate or array card.

Maximum number of outlier wells that can be removed

Sample block Unknown Unknown Standards

population At | population B# (STD)S

No template
controls (NTC)

96-well plate™™ 6 6 1 0
384-well plate 10 10 2 0
Array card*¥ 4 4 4 0

1 5,000-copy population for 384-well plates; 800-copy population for array cards.
T 10,000-copy population for 384-well plates; 1,600-copy population for array cards.
§ Maximum number of wells that can be removed from each standard population.

T+Standard 96-well plates or Fast 96-well plates
11 QuantStudio™ 7 Flex System only.

11. Repeat step 10 for each replicate population (unknowns, standards, and no

template controls) on the plate or array card.

12. Review the Results Table for quality flags generated by the test:

a. Select the Results Table tab.

b. Review the Flag column for wells that generated quality flags.

c. Troubleshoot each well that generated a flag as explained in “RNase P test

troubleshooting” on page 75.
¢ AMPNC - Amplification in negative control
e BADROX - Bad passive reference signal
e BLFAIL - Baseline algorithm failed
¢ CTFAIL - Cy algorithm failed
e EXPFAIL - Exponential algorithm failed

¢ HIGHSD - High standard deviation in replicate group

¢ NOAMP - No amplification

* NOISE - Noise higher than others on the consumable

* NOSIGNAL - No signal in well

¢ OFFSCALE - Fluorescence is offscale

¢ OUTLIERRG - Outlier in replicate group

* SPIKE - Noise spikes

¢ THOLDFAIL - Thresholding algorithm failed

13. If you omitted outliers, click Reanalyze to analyze the run.

If the status of the RNase P Run is “Failed” after performing step 8-12, repeat the
RNase P test using a different RNase P plate or array card. If the problem persists,

contact Life Technologies.
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Troubleshooting
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Review the standard curve:
a. Select the Standard Curve tab.
b. Click the upper-left corner of the Plate Layout to select all wells.
c. Confirm that the R? value is > 0.990.

If the R? value is < 0.990, repeat the RNase P test using a different RNase P plate or
array card. If the problem persists, contact Life Technologies.

In the Analysis screen, click Next, remove the plate or array card when the
instrument ejects the tray arm, then discard the consumable.

WARNING! PHYSICAL INJURY HAZARD. During instrument
operation, the plate or array card can reach 100°C. Before removing the
consumable, be sure to wait until it reaches room temperature.

Note: If the instrument does not eject the plate or array card, remove it as
explained in “RNase P test troubleshooting” on page 75.

Click Finish, then click Yes when prompted to save the test.

(Optional) Click Print Report in the upper right corner of the screen to print a
summary of the RNase P test results for your records.

The tables in this section describe how to troubleshoot failed calibrations and RNase P
instrument verification tests:

ROI calibration troubleshooting. .......... ... ... i 70
Background calibration troubleshooting ......................... ... ... 71
Uniformity calibration troubleshooting .................................. 72
Dye calibration troubleshooting. . .......... ... . ... i 73
Normalization calibration troubleshooting ............................... 74
RNase P test troubleshooting . ................. ... ... ... ... ... 75
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Table 1 ROI calibration troubleshooting

Problem/symptom

Possible cause

Action

ROI calibration failed.
e ROl image is blurry
e ROl image is faint

Instrument does not eject the
ROI plate or array card (it is
stuck within the instrument).

e Plate or array card was
centrifuged insufficiently.

e Plate or array card contains
old or insufficient reagents.

e The sample block or heated
cover may not be seated
correctly.

' The adhesive cover may have

adhered the plate or array card
to the heated cover.

CAUTION! PHYSICAL INJURY HAZARD. During operation, the sample block
can reach 100°C. Before removing the plate or array card, wait until the block
reaches room temperature.

1. Unload the instrument and confirm that you loaded the correct plate or array card.
If not, perform the calibration again using the correct type of consumable.

2. View the wells of the plate or array card. If the liquid in the wells is not:
¢ At the bottom of the wells, centrifuge the plate or array card for a longer time,
then repeat the calibration.
e Equivalent in volume, the plate or array card is not sealed properly and the
reagents have evaporated. Discard the consumable and run another.
3. If the calibration plate or array card appears to be normal, discard it and run another.

4. If the calibration fails again, check the sample block and heated cover positions:
a. Power off and unplug the instrument. Wait 15 minutes, then open the access door.

b. Firmly push the sample block and the heated cover toward the back of the
instrument to confirm that they are seated correctly.

IMPORTANT! Align the arrows on
the front handle of the heated cover
as shown. If the arrows are not
aligned, push the heated cover into
the instrument until the handle
locks into place.

IMPORTANT! Confirm that the
indicator on the left side of the
sample block is positioned behind the
red line on the instrument rail. If not,
push the sample block into the
instrument until it is seated correctly.

c. Repeat the calibration.
5. If the calibration fails again, contact Life Technologies.

Remove the plate or array card from the instrument as explained in “Remove a plate
stuck within the instrument” on page 78.

Instrument malfunction.

Multiple possible causes.

Contact your local Life Technologies Field Service Office.
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Table 2 Background calibration troubleshooting

Problem/symptom Possible cause

Action

Background calibration failed. e Plate or array card was
centrifuged insufficiently.

¢ Plate or array card contains
old or insufficient reagents.

¢ One or more wells of the
background plate or array
card produced spectra that
exceed the maximum limit for
the instrument.

CAUTION! PHYSICAL INJURY HAZARD. During operation, the sample block
can reach 100°C. Before removing the plate or array card, wait until the block
reaches room temperature.

. Unload the QuantStudio™ 6 or 7 Flex System and confirm that you loaded the correct

plate or array card into the instrument. If not, perform the calibration again using the
correct type of consumable.

. View the wells of the plate or array card. If the liquid in the wells of the consumable

is not:

e At the bottom of the wells, centrifuge the plate or array card for a longer time,
then repeat the calibration.

e Equivalent in volume, the plate or array card is not sealed and the reagents have
evaporated. Discard the consumable and run another.

. If the calibration plate or array card appears to be normal, discard it and run another.

. If the calibration fails again, determine the source of the contamination, as explained

in “How to identify contamination” on page 78.

Instrument does not eject the The adhesive cover may have
background plate or array card adhered the plate or array card
(it is stuck within the to the heated cover within the
instrument). instrument.

Instrument malfunction. Multiple possible causes.

Remove the plate or array card from the instrument as explained in “Remove a plate
stuck within the instrument” on page 78.

Contact your local Life Technologies Field Service Office.
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Table 3 Uniformity calibration troubleshooting

Problem/symptom Possible cause

Action

Uniformity calibration failed. e Plate or array card was
centrifuged insufficiently.

e Plate or array card contains
old or insufficient reagents.

e Abnormally low spectra
across all wells of the plate or
array card.

CAUTION! PHYSICAL INJURY HAZARD. During operation, the sample block
can reach 100°C. Before removing the plate or array card, wait until the block
reaches room temperature.

1. Unload the QuantStudio™ 6 or 7 Flex System and confirm that you loaded the correct
plate or array card into the instrument. If not, perform the calibration again using the
correct type of consumable.

2. Unload the QuantStudio™ 6 or 7 Flex System and view the wells of the plate or array
card. If the liquid in the wells of the consumable is not:

e At the bottom of the wells, centrifuge the plate or array card for a longer time,
then repeat the calibration.

e Equivalent in volume, the plate or array card is not sealed and the reagents have
evaporated. Discard the consumable and run another.

3. If the calibration plate or array card appears to be normal, discard it and run another.

4. If the calibration fails again, contact Life Technologies.

One or more wells produced
spectra that deviate significantly
from the rest of the plate or
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1. While viewing the calibration data in the Analysis screen, locate the well(s) with
abnormal signal in the Plate Layout tab.

2. Rotate the plate or array card 180°, then perform the calibration again.

array card. ) ] ) ) .
3. Determine the location of the contaminated wells again. If the position(s) of the
well(s) identified in the steps above are:
¢ l|dentical - The sample block is contaminated. Decontaminate the sample block.
¢ Reversed - The ROI plate or array card is contaminated. Discard the consumable,
then perform the uniformity calibration using a new ROI plate or array card.
4. If the calibration fails again, contact Life Technologies.
Instrument does not eject the The adhesive cover may have Remove the plate or array card from the instrument as explained in “Remove a plate
ROI plate or array card (the adhered the plate or array card | stuck within the instrument” on page 78.
consumable is stuck within the to the heated cover within the
instrument). instrument.
Instrument malfunction. Multiple possible causes. Contact your local Life Technologies Field Service Office.
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Table 4 Dye calibration troubleshooting

Problem/symptom Possible cause

Action

Dye calibration failed. e Dye plate or array card was

One or more raw spectra are at centrifuged insufficiently.

or below the detectable * Dye plate or array card
threshold for the calibration. contains old or insufficient
reagents.
e Spectra contain peaks in " Fluorescent contaminants are
more than one filters. present on the sample block or
e One or more raw spectra dye plate or array card.

exceed the maximum limit for
the instrument.

CAUTION! PHYSICAL INJURY HAZARD. During operation, the sample block
can reach 100°C. Before removing the plate or array card, wait until the block
reaches room temperature.

1. Unload the QuantStudio™ 6 or 7 Flex System and view the wells of the plate or array
card. If the liquid in the wells of the consumable is not:
o At the bottom of the wells, centrifuge the plate or array card for a longer time,
then repeat the calibration.
e Equivalent in volume, the plate or array card is not sealed and the reagents have
evaporated. Discard the consumable and run another.

2. If the dye calibration plate or array card appears to be normal, discard it and run
another.

3. If the problem persists, contact Life Technologies.

Confirm that contaminants are not present by performing a background calibration. If
the background calibration does not show sample block contamination, the dye plate or
array card may be contaminated.

Instrument does not eject the " The adhesive cover may have Remove the plate or array card from the instrument as explained in “Remove a plate
dye plate or array card [the adhered the plate or array card | stuck within the instrument” on page 78.

consumable is stuck within the to the heated cover within the

instrument). instrument.

Instrument malfunction. Multiple possible causes. Contact your local Life Technologies Field Service Office.
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Table 5 Normalization calibration troubleshooting

Problem/symptom

Possible cause

Action

Normalization calibration failed.

Abnormally low spectra across
all wells of the plate or array
card.

One or more wells produced
spectra that deviate significantly
from the rest of the plate or
array card.

CAUTION! PHYSICAL INJURY HAZARD. During operation, the sample block
can reach 100°C. Before removing the plate or array card, wait until the block
reaches room temperature.

1. Unload the QuantStudio™ 6 or 7 Flex System and confirm that you loaded the correct
plate or array card into the instrument. If not, perform the calibration again using the
correct consumable.

2. If you are using the correct plate or array card, perform the calibration again using
a different normalization consumable.

3. If the calibration fails again, contact Life Technologies Field Service Office.

1. While viewing the calibration data in the Analysis screen, locate the well(s) with
abnormal signal in the Plate Layout tab.

2. Rotate the plate or array card 180°, then perform the calibration again.

3. Determine the location of the contaminated wells again. If the position(s) of the
well(s) identified in the steps above are:
¢ Identical: The sample block is contaminated. Decontaminate the sample block.

¢ Reversed: The normalization plate or array card is contaminated. Discard the
consumable, then perform the normalization calibration using a new
normalization plate or array card.

4. If the calibration fails again, contact your local Life Technologies Field Service Office.

Instrument does not eject the
normalization plate or array card
(it is stuck within the
instrument).

The adhesive cover may have
adhered the plate or array card
to the heated cover within the
instrument.

Remove the plate or array card from the instrument as explained in “Remove a plate
stuck within the instrument” on page 78.

Instrument malfunction.

Multiple possible causes.

Contact your local Life Technologies Field Service Office.
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Table 6 RNase P test troubleshooting

Problem/symptom

Possible cause

Action

RNase P plate or array card
verification run failed.

Instrument does not eject the
RNase P plate or array card (the
consumable is stuck within the
instrument).

e Contamination
¢ Defective seal

e Inaccurate fluid transfer
during plate or array card
manufacturing

* Insufficient centrifugation

" Adhesive cover may have

adhered the plate or array card
to the heated cover within the
instrument.

CAUTION! PHYSICAL INJURY HAZARD. During operation, the sample block
can reach 100°C. Before removing the plate or array card, wait until the block
reaches room temperature.

1. Unload the RNase P plate or array card from the instrument.

2. Hold the plate or array card up to a light source, and confirm that all wells contain
the same volume of fluid.

If there are differences in fluid volumes, check the heat seal of the wells with lower
volumes for signs of damage or evaporation.

Compare the position of the wells that have lower volumes with the outliers that you
have removed from the plate or array card. If the well positions coincide, the heat
seal on the consumable may be defective, resulting in the evaporation of the
associated samples.

3. Contact Life Technologies to order a replacement RNase P plate or array card. If the
replacement consumable fails, contact Life Technologies for assistance.

Remove the plate or array card from the instrument as explained in “Remove a plate
stuck within the instrument” on page 78.

Negative control well displays
the AMPNC flag, indicating that
the well amplified.

Well displays the BADROKX flag,
indicating that the passive
reference signal is unacceptable
for the normalization of the
reporter dye signal.

Contamination in one or more
PCR reaction components
contained in the negative control
well.

e Droplets on the sides of the

wells

e Improper sealing or seal
leaks

¢ Condensation on the plate or
array card

Contact Life Technologies to order a replacement RNase P plate or array card kit. If the
replacement RNase P consumable fails, contact Life Technologies for assistance.

If a well is flagged, confirm the results:
1. Select the flagged well(s] in the plate layout or well table.

2. View the amplification plot (R, vs. Cycle), and review the data in the C; region for
abnormalities.

3. Examine the plate or array card to check for condensation and/or inconsistent
reaction volumes.

4. Contact Life Technologies to order a replacement RNase P plate or array card.
Repeat the test and make sure to properly centrifuge the RNase P consumable. If the
replacement RNase P plate or array card fails, contact Life Technologies for
assistance.
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Problem/symptom

Possible cause

Action

Well displays the BLFAIL flag,
indicating that the software
cannot calculate the best fit
baseline for the data.

Amplification too late
No amplification

e Well displays the CTFAIL flag,
indicating that the software
cannot calculate the
threshold cycle (C,].

e Well displays the EXPFAIL
flag, indicating that the
software cannot identify the
exponential region of the
amplification plot.

Well displays the HIGHSD flag,
indicating that the C; standard
deviation for the replicate group

exceeds the current flag setting.

Amplification too early
Amplification too late
Low amplification

No amplification

Droplets on the sides of the
wells

Improper sealing or seal
leaks

Condensation on the plate or
array card

Inconsistent volumes across
the plate or array card

Well displays the NOAMP flag,
indicating that the sample did
not amplify.

Missing template

Excitation source in the
instrument stopped
functioning

Well displays the NOISE flag,
indicating that the well produced
more noise in the amplification
plot than other wells on the plate
or array card.

Droplets on the sides of the
wells

Improper sealing or seal
leaks

Condensation on the plate or
array card

If a well is flagged, confirm the results:

1.
2.

Select the flagged well(s) in the plate layout or well table.

View the amplification plot (R, vs. Cycle and DR, vs. Cycle] and check for early, late,
low, or no amplification.

. Contact Life Technologies to order a replacement RNase P plate or array card.

Repeat the test, making sure to properly seal and centrifuge the RNase P plate or
array card. If the replacement RNase P plate or array card fails, contact
Life Technologies for assistance.

If a well is flagged, confirm the results:

1.

Select the flagged well(s) and the associated replication group(s) in the plate layout
or well table.

. View the amplification plot (R, vs. Cycle), and review the data for abnormalities.

. Hold the plate or array card up to a light source, and check for condensation or

evaporation.

If there are differences in fluid volumes, check the heat seal of the wells with lower
volumes for signs of damage or evaporation.

. Contact Life Technologies to order a replacement RNase P plate or array card.

Repeat the test, and make sure to properly centrifuge the RNase P consumable. If
the replacement RNase P plate or array card fails, contact Life Technologies for
assistance.
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Problem/symptom

Possible cause

Action

Well displays the NOSIGNAL
flag, indicating that the well
produced very low or no

Missing reaction mix resulting
from pipetting error.

If a well is flagged, confirm the results:

1.

Consider omitting the well from the analysis.

fluorescence signal. 2. Note the location for each flagged well, and check each corresponding well in the
plate or array card for evaporation or low reaction volume.
3. Contact Life Technologies to order a replacement RNase P plate or array card. If the
replacement RNase P consumable fails, contact Life Technologies for assistance
Well displays the OFFSCALE e Fluorescent contaminant on 1. Perform a background calibration. If you detect fluorescent contamination,
flag, indicating that the the plate or array card or decontaminate the sample block.
fluorescence signal for one or sample block 2. Contact Life Technologies to order a replacement RNase P plate or array card. If the
more dyes in the well exceeds * Fluorescent contaminant in replacement consumable fails, contact Life Technologies for assistance
the instrument’s maximum the reaction
detectable range for one or more
cycles.
Well displays the OUTLIERRG e Contamination 1. Decontaminate the work area and pipettors.
flag, indicating that the C; of the & |mproper sealing or seal 2. Contact Life Technologies to order a replacement RNase P plate or array card.

well deviates significantly from
C; values in the associated
replicate group (only the outlier
is flagged).

leaks

Repeat the test and make sure that the RNase P consumable is properly sealed. If
the replacement RNase P plate or array card fails, contact Life Technologies for
assistance.

Well displays the SPIKE flag,
indicating that the amplification
curve contains one or more data
points inconsistent with the
other points in the curve.

Well displays the THOLDFAIL
flag, indicating that the software
cannot calculate the threshold.

e Bubbles in the reaction

e Evaporation during the
denaturation step because of
improper sealing or seal
leaks

e Amplification too early
e Amplification too late
e Low amplification

e No amplification

Contact Life Technologies to order a replacement RNase P plate or array card. Repeat
the test, and make sure to properly centrifuge the RNase P consumable. If the

replacement RNase P plate or array card fails, contact Life Technologies for assistance.

If a well is flagged, confirm the results:

1.
2.

Select the flagged well(s) in the plate layout or well table.

View the amplification plot (R, vs. Cycle and DR,, vs. Cycle), and check for early, late,
low, or no amplification.

. Contact Life Technologies to order a replacement RNase P plate or array card. If the

replacement RNase P consumable fails, contact Life Technologies for assistance.

Instrument malfunction.

Multiple possible causes

Contact your local Life Technologies Field Service Office.
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Chapter 2 Calibrate the Instrument

Troubleshooting

How to identify Signals that exceed the limit of normal background fluorescence may indicate

contamination fluorescent contaminants on the calibration plate or array card or the sample block.
Common contaminants include ink residue from permanent pens, powder from
disposable gloves, and dust.

To identify and resolve a possible contamination problem:

1.

While viewing the background calibration data in the Analysis screen, select the
QC tab to review the list of wells that failed the quality check.

Eject the background plate or array card from the instrument, rotate the plate
180°, then perform the background calibration again.

Determine the location of the contaminated wells again as in step 1.

If the position(s) of the contaminated well(s) in the steps above are:

¢ Identical — The sample block is contaminated. Decontaminate the sample
block as explained in “Decontaminate the sample block” on page 96.

* Reversed — The background plate or array card is contaminated. Discard it,
then perform the background calibration using a new background
consumable.

If the calibration fails after you replace the background plate or array card and
decontaminate the sample block, contact Life Technologies for further support.

Remove a plate If the QuantStudio™ 6 or 7 Flex System does not eject a plate after you touch E on the
stuck within the touchscreen, the adhesive cover of the plate may have adhered it to the heated cover

instrument

78

within the instrument. If so, you can remove the plate from the instrument as follows.

1.

Power off the instrument. Wait 15 minutes, then power on the instrument and
eject the plate.

If the plate does not eject, power off and unplug the instrument, then open the
access door.

While wearing powder-free gloves, reach into the instrument and remove the
plate from the heated cover, then close the access door.

Perform a background calibration to confirm that the sample block has not been
contaminated.
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Manual Instrument Operation

Overview of instrument touchscreen functions. .. ......................... 80
Operate the instrument from the touchscreen............................. 81
Maintain the instrument from the touchscreen . ........................... 85
Administrate the instrument from the touchscreen ........................ 88

Note: This appendix describes how to operate the QuantStudio"" 6 and 7 Flex Systems
manually using the touchscreen interface. Although the QuantStudio™" 6 and 7 Flex
Systems can be used without an Ethernet connection to a computer, the touchscreen
allows you to perform only a subset of the total instrument functions.
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Overview of instrument touchscreen functions

Overview of instrument touchscreen functions

The QuantStudio™ 6 and 7 Flex Systems feature a touchscreen interface that you can
use to transfer data, manage instrument settings, and configure the instrument for
network use. The touchscreen does not provide access to all instrument functions.
Features such as analyzing experiments, instrument calibration, and remote
notification are available only through the QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software.

The following table summarizes the functions that are available from the
QuantStudio™ 6 or 7 Flex System touchscreen.

Categor Function Available in
ory secure mode?t
Operational:c Create experiments from templates No

Run experiments

Transfer and delete experiments, templates, and
results to/from a USB drive

Maintenance$ Back up and restore the instrument settings Yes

Perform an instrument self test

Install and record a new lamp

Update the instrument firmware

Administrationtt | Define the date and time

Define the instrument settings

Define the network settings

Define the maintenance reminders

Define the system shortcuts

Enable or disable instrument security

Review the instrument statistics

Review the instrument version information

View the QuantStudio™ 6 and 7 Flex Systems log

t See “Enable/disable instrument security” on page 92.

I Tasks for users responsible for day-to-day use of the instrument.

§ Tasks for users who maintain the instrument.

T+ Tasks for systems administrators or for information technology personnel.
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Operate the instrument from the touchscreen

Operate the instrument from the touchscreen

The touchscreen provides limited control of the QuantStudio™ 6 and 7 Flex Systems to
run experiments and transfer data. You can perform the following functions from the
touchscreen to operate the QuantStudio™" 6 and 7 Flex Systems without using the

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software:

B Create an experiment from a template . .......... ... ... . .. ... .. ... 81
B Runanexperiment................. i, 82
B Transfer experiments, templates, and resultsdata ......................... 83

Note: If the QuantStudio™" 6 or 7 Flex System is operating in secure mode (see
“Enable/disable instrument security” on page 92), users can only open and close the

side door.
Create an 1. If necessary, download the experiment template to the QuantStudio™ 6 or 7 Flex
experiment from a System as described in “Transfer experiments from a USB drive” on page 83.
template 2. If the instrument is in standby, touch the QuantStudio'" 6 or 7 Flex System

touchscreen to activate it, then press [¢] .
3. In the Main Menu, touch & View Templates.

4. In the View Templates screen, touch a template, then touch + New:

To view the parameters of a template, select the desired template, then touch
&> View. When finished, touch ‘ to return to the View Templates screen.

Note: You cannot modify the experiment parameters of a template.

5. In the Create New Experiment screen, touch each field to set the:

¢ Touch the New Experiment Name field and use the keypad to enter a name
(up to 100 characters) for the experiment.

¢ Touch the Save to Folder field to open the Select Folder Screen.
* Touch the Reaction Volume field to enter a reaction volume in pL.
¢ (Optional) Touch the Barcode Number field to enter a barcode and touch the
Notes field to enter notes (up to 200 characters) about the experiment.
6. When finished, either:
* Touch gg Save & Exit.
or

¢ Touch , Save & Start Run to proceed to the Start Run screen.
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Operate the instrument from the touchscreen

Run an experiment

82

If the instrument is in standby, touch the QuantStudio™ 6 or 7 Flex System
touchscreen to activate it, then press &) .

In the Main Menu screen, then touch E

When the side door opens, load the appropriate plate or
array card. Ensure that the consumable is properly
aligned in the holder.
* (A) Load 96/384-well plates with the A1l position at
the top-left corner of the plate adapter.

* (B) Load both plates and array cards with the
barcode facing the front of the instrument.

In the Main Menu, touch Browse Experiments.

In the Experiments screen, touch the desired experiment, then touch either:
. , Start Run to start the run immediately, then go to step 10.
or

¢ & View/Edit to view or edit the experiment before starting the run.

Modify the experiment parameters as needed. To:

* Add astage or step to the thermal profile, touch the stage or step to the left of
where you want to add the stage or step, then touch B Add.

* Add a melt curve to the end of the thermal profile, touch 8. Add Melt
Curve.

* Change the time or temperature of a stage or step, touch the time/
temperature field of the stage or step, modify the settings as desired, then
touch Close.

* Change the cycle parameter of a stage, touch the cycle field, modify the
setting as desired, then touch Close.

* Delete a stage or step from the thermal profile, touch the stage or step you
want to remove, then touch i Delete.

When finished modifying the parameters, touch g Save.

In the Save Experiment screen, touch each field to set the experiment, name,
reaction volume, barcode, and any additional information to save to the
experiment

When finished, touch f Save & Start Run to start the experiment.

In the Start Run screen, touch each field as needed to modify the associated
parameter, then touch , Start Run Now to start the experiment.

Note: When the run is complete, touch Y to unload the plate. You can download
the experiment results to a computer if the QuantStudio™ 6 or 7 Flex System is
connected to a network, or you can copy the data to a USB device (see “Transfer
experiments, templates, and results data” on page 83).
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Operate the instrument from the touchscreen

Transfer You can transfer experiments, templates, and results
experiments, data to/from the QuantStudio™ 6 and 7 Flex
templates, and Systems using a USB flash drive. Before transferring ]
, data, you must plug the drive into the USB port
results data below the touchscreen. Q‘)— Y\I"

IMPORTANT! Do not use the USB ports on the rear

panel of the QuantStudio™" 6 and 7 Flex Systems.
The rear USB ports are only for use by Life

Technologies personnel to service the instrument.

Transfer templates from a USB drive

1.
2.

Plug a USB drive into the USB port below the touchscreen.

If the instrument is in standby, touch the QuantStudio'" 6 or 7 Flex System
touchscreen to activate it, then press .

In the Main Menu, touch & View Templates.
In the Browse Experiments screen, select the template:

a. Touch | i |, then touch USB.
b. Touch the desired template, then touch gg Save.

In the Save Experiment As screen, set the name for the file.
a. Touch the New Template Name field, then enter a name for the copied file.
b. Touch the Save to Folder field, then select the folder to receive the file.

c. Touch Save.
Touch [ to return to the Main Menu.

Unplug the USB drive.

Transfer experiments from a USB drive

1.
2.

Plug a USB drive into the USB port below the touchscreen.

If the instrument is in standby, touch the QuantStudio"" 6 or 7 Flex System
touchscreen to activate it, then press [0 .

In the Main Menu, touch Browse Experiments.

In the Browse Experiments screen, select the experiment:
a. Touch |E|, then touch USB.

b. Touch the desired experiment, then touch gg Save.

In the Save Experiment As screen, touch the experiment that you want to transfer
to the USB drive, then touch Save.

Touch [ to return to the Main Menu.

Unplug the USB drive.
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Copy experiment results to a USB drive
1. Plug a USB drive into the USB port below the touchscreen.

2. If the instrument is in standby, touch the QuantStudio'" 6 or 7 Flex System
touchscreen to activate it, then press [{} .

3. From the Main Menu of the instrument touchscreen, touch Collect Results.

4. From the list of experiments, touch the experiment(s) of interest or
touch :.: Select All

5. Touch ‘fﬁ Save to USB.

6. From the Copy Results To USB screen, check that the name of the USB drive is
correct to ensure that it is mounted, then touch ‘fﬁ Save to USB.

7. Touch [ to return to the Main Menu.

8. Unplug the USB drive.
Note: After the results from a completed run have been collected, the corresponding
experiment displays “Collected” and it can be deleted.
Delete results

Once you have collected results from the QuantStudio™ 6 or 7 Flex System, you can
use the touchscreen to delete the files from the instrument hard drive.

1. From the Main Menu of the instrument touchscreen, touch Collect Results.

2. From the list of experiments, touch the experiment(s) of interest, then touch
M Delete.

3. When asked to confirm the deletion, touch OK.

4. Touch ﬁ to return to the Main Menu.
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Maintain the instrument from the touchscreen

Back up and
restore the
instrument
settings

The QuantStudio™ 6 and 7 Flex Systems touchscreen provides access to a few

maintenance functions that cannot be accessed remotely from the QuantStudio™ 6 and
7 Flex Real-Time PCR System Software. Unlike the maintenance performed using the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, some of the touchscreen
functions are not part of the recommended maintenance schedule. The frequency that
you perform them depends on your laboratory policies.

B Back up and restore the instrument settings ................ ... ... 00 85
B Perform an instrumentself test .......... ... ... ... i 86
B Update the instrument firmware . ........... ... ... ... o .. 87

Note: The touchscreen does not provide access to all instrument functions. Features
such as instrument calibration and remote notification are available only through the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

You can use the QuantStudio™ 6 or 7 Flex System touchscreen to back up the
instrument settings (icon, standby time-out, and cover idle temperature), and some
network settings (the Autodiscovery and Smart Monitoring options). If the
QuantStudio™ 6 or 7 Flex Instrument settings are reset, you can restore the settings
using the backup.

Note: The backup feature can be used as an administrative tool to manage
QuantStudio™ 6 and 7 Flex Systems. You can use the feature to create a standard
“image” for a QuantStudio™ 6 or 7 Flex Instrument that can then be restored on other
instruments to bypass the manual setup process.

The QuantStudio™ 6 and 7 Flex Systems back up to
and restores instrument settings from a USB flash

drive. Before backing up or restoring settings, you ]
must plug the drive into one of the USB ports below
the touchscreen. (") Y\IJ

IMPORTANT! Do not use the USB ports on the rear
panel of the QuantStudio'" 6 and 7 Flex Systems.
The rear USB ports are for use by Life Technologies
personnel to service the instrument.

Back up the instrument settings
1. Plug a USB drive into the USB port below the touchscreen.

2. From the Main Menu of the instrument touchscreen, touch Tools, then
touch Backup Settings.

3. From the Backup Settings screen, touch ,.% Backup.
4. Wait for the backup to complete, then touch [ to return to the Main Menu.
5. Unplug the USB drive.
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Perform an
instrument self
test

86

Note: For administrative purposes, you can reuse the instrument settings saved to the
USB drive to configure more than one QuantStudio™" 6 or 7 Flex System. Note that you
must configure the network settings for each instrument individually.

Restore the instrument settings

1. Plug the USB drive that contains the instrument settings into the USB port below
the touchscreen.

2. From the Main Menu of the instrument touchscreen, touch Tools, then
touch Restore Settings.

3. From the Restore Settings screen, select the settings to restore:
a. Touch the settings that you want to restore from the list.

b. Touch ﬁ" Restore to upload the instrument settings from the USB drive.

IMPORTANT! Do not remove the USB drive from the QuantStudio™ 6 or 7 Flex
System until instructed.

Note: Alternatively, touch Restore Default Settings to restore the QuantStudio™
6 or 7 Flex System to the factory settings.

4. After the QuantStudio™ 6 or 7 Flex System restarts, unplug the USB drive.

You can use the QuantStudio™ 6 or 7 Flex System touchscreen to perform a
comprehensive self test of the QuantStudio" 6 or 7 Flex System subsystems. After the
self test is complete, the QuantStudio™" 6 or 7 Flex System generates two files that
provide a detailed summary of the instrument condition and function. In the event of a
problem, you can save the results files to a USB drive and email them to Life

Technologies technical support for a diagnosis.

Note: We recommend running the self test as part of regular maintenance to ensure
optimal performance of the QuantStudio™ 6 or 7 Flex System.

1. From the Main Menu of the instrument touchscreen, touch Tools, then touch Run
Self Test.

2. From the Self Test screen, touch E Start Self Test, then wait for the test to
complete.

3. (Optional) When the QuantStudio™ 6 or 7 Flex System completes the self test,
save the results to a USB drive:

a. Plug a USB drive into the USB port below
the touchscreen.

L]
IMPORTANT! Do not use the USB ports on

the rear panel of the QuantStudio™ 6 and (") Y\IJ
7 Flex Systems. The rear USB ports are for

use by Life Technologies personnel to
service the instrument.
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Maintain the instrument from the touchscreen

b. Touch gg Save.

IMPORTANT! Do not remove the USB drive from the QuantStudio™ 6 or 7
Flex System until instructed.

¢. When the QuantStudio™ 6 or 7 Flex System finishes writing the results to the
USB drive, touch OK, then remove the USB drive.

4. Touch ﬁ to return to the Main Menu.

Update the You can download QuantStudio" 6 and 7 Flex Systems firmware updates directly
instrument from the service section of the Life Technologies website. After obtaining a firmware
firmware update, transfer the update to the QuantStudio"" 6 or 7 Flex System using a USB drive.

1. Download the firmware update:

a. Go to www.lifetechnologies.com/us/en/home/technical-resources/
software-downloads

b. In the Software Downloads page, select Applied Biosystems QuantStudio™
6 and 7 Flex Real-Time PCR Systems from the menu.

¢. In the Software Downloads page for your QuantStudio'" 6 or 7 Flex System,
click Updates - Patches.

d. Download the QuantStudio™ 6 and 7 Flex Systems firmware to a USB drive.

2. Plug a USB drive into the USB port below the
touchscreen.

IMPORTANT! Do not use the USB ports on the - 7 ‘

rear panel of the QuantStudio™ 6 and 7 Flex < ) Y\I’
Systems. The rear USB ports are for use by Life
Technologies personnel to service the
instrument.

[

3. If the instrument is in standby, touch the QuantStudio™ 6 or 7 Flex System
touchscreen to activate it, then press [T} .

4. In the Main Menu, touch Tools, then touch § Upgrade Firmware.

5. In the Upgrade Firmware screen, select the update package, then touch
= Upgrade Firmware. Allow the QuantStudio ™ 6 or 7 Flex System to complete
the upgrade.

IMPORTANT! Do not remove the USB drive from the QuantStudio™" 6 or 7 Flex
System until you are instructed to do so.

6. After the upgrade is complete and the QuantStudio" 6 or 7 Flex System reboots,
confirm the upgrade success:

a. Unplug the USB drive.

b. Touch Settings, then touch About this instrument to view the software
version number to confirm that the firmware has been upgraded.
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Administrate the instrument from the touchscreen

Define the date and
time

Define the
instrument
settings

88

The touchscreen provides access to several administrative functions that you can use

™

to integrate the QuantStudio ~ 6 and 7 Flex Systems into a laboratory workflow. The
following functions are available from the touchscreen and can be used after
installation to customize the instrument settings and configure it for network use.

Define the date and time. .. ... ... .. i 88
Define the instrument settings. . .. ...... ... ... i 88
Define the maintenance reminders. . ....... ..., 90
Define the network settings . .. ........ ... i 90
Define the system shortcuts............... ... ... ... ...l 91
Review the instrument statistics .. .........c.. it 91
Review the instrument version information ............................... 91
Enable/disable instrument security. ............ ... ... i i, 92
View the instrumentlog....... ... ... ... .. . 92

Note: The touchscreen does not provide access to all instrument functions. Features
such as instrument calibration and remote notification are available only through the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

IMPORTANT! If your laboratory is subject to daylight savings time changes, you must
manually adjust the time settings during daylight savings to ensure that the internal
clocks of your computer and instrument are synchronized.

1.

2.

From the Main Menu of the instrument touchscreen, touch Settings, then
touch Set Date & Time.

From the Set Date & Time screen:
a. Touch the Time zone field, then touch the correct time zone from the list.
b. Touch the Date field, enter the current date, then touch Done.

c. Touch the Date Format drop-down list, then select the format for your
region.

d. Touch each Time field, enter the appropriate time units, then touch Done.
e. Touch 12 Hour or 24 Hour to select the appropriate time format.

f.  Touch Save to save the settings, then touch OK when prompted.

Touch ﬁ to return to the Main Menu.

. From the Main Menu of the instrument touchscreen, touch Settings, then

touch Configure the Instrument.

Touch the Instrument Name field, enter up to a 25-character name for the
QuantStudio™ 6 or 7 Flex System, then touch Done.
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The instrument name is the alphanumeric string used to identify the
QuantStudio™ 6 or 7 Flex Instrument on the network.

IMPORTANT! To connect the QuantStudio™ 6 or 7 Flex System to a network, the
name must be unique.

IMPORTANT! The instrument name cannot include spaces or special characters
(suchas;:"<>*+=\17,).

3. Upload the instrument icon:

The instrument icon is the graphic used to represent the QuantStudio™ 6 or 7 Flex
System in the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software
Instrument Console:

a. Save the replacement graphic to a USB
drive, then plug the drive into the USB

port below the touchscreen. ]

IMPORTANT! Do not use the USB ports on < ) Y\I’

the rear panel of the QuantStudio" 6 and
7 Flex Systems. The rear USB ports are for
use by Life Technologies personnel to
service the instrument.

b. Touch Upload Icon, select the desired graphic file, then touch Done.

Note: The replacement graphic must be a maximum of 48 x 48 pixels and be
stored in the portable net graphic (PNG) format.

4. Define the standby time-out setting:
a. Select Standby Time-out to activate the feature.
b. Touch the Standby Time-out field.

c. Enter the number of minutes (1-300) that the QuantStudio™ 6 or 7 Flex
System should remain idle until it enters standby mode, then touch Done.

Note: When in standby mode, the QuantStudio™" 6 or 7 Flex System powers off
the LCD screen backlight and enters low-power mode.

5. Define the heated cover temperature setting:
a. Select Cover Idle Temperature to activate the feature.
b. Touch the Cover Idle Temperature field.

c. Enter the temperature (50.0-110.0°C) that the heated cover should maintain
when the QuantStudio™ 6 or 7 Flex System is idle, then touch Done.

Note: The recommended Cover Idle Temperature is 60.0°C for reaction plate
formats and 85.0°C for the array card format.

6. Touch Save to save the settings, then touch OK when prompted.
7. Unplug the USB drive.
8. Touch ﬁ to return to the Main Menu.
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Define the You can use the QuantStudio™ 6 or 7 Flex System touchscreen screen to:
maintenance * Set the expiration period for instrument calibrations and lamp replacement.
reminders

* Activate, deactivate, or change the frequency of the maintenance reminders

displayed by the QuantStudio™ 6 or 7 Flex System.

To set the reminder:

1.

Define the network
settings

90

-_

From the Main Menu of the instrument touchscreen, touch Settings, then
touch Set Maintenance Reminders.

For each reminder:
a. Touch the Calibration expires after field.

b. Use the keypad to enter the number of days (or, for the lamp, the number of
hours) that should elapse before expiration, then touch Done.

c. (Optional) Touch the checkbox to activate or deactivate an expiration
reminder, then go to step 3.

(Optional) Configure the reminder:
a. Touch the Display reminders before field.

b. Enter the number of days (or, for the lamp, the number of hours from 1-2000)
before which the instrument should display warnings of the impending
expiration, then touch Done.

Touch Save to save the settings, then touch OK when prompted.

Touch ﬁ to return to the Main Menu.

From the Main Menu of the instrument touchscreen, touch Settings, then touch
Set Network Information.

Note: The Set Network Information screen displays the Media Access Control
(MAC) address of the QuantStudio™ 6 or 7 Flex System below the Autodiscovery
and Smart Monitoring check boxes. The MAC address can be used to uniquely

identify the QuantStudio™ 6 or 7 Flex System on the network.

Touch Autodiscovery to make the QuantStudio™" 6 or 7 Flex System discoverable
by computers that are running the QuantStudio'" 6 and 7 Flex Real-Time PCR
System Software.

Touch Smart Monitoring to enable the feature on the QuantStudio™ 6 or 7 Flex
System.

The Smart Monitoring feature allows Life Technologies service personnel to
monitor the status of the QuantStudio™ 6 or 7 Flex System remotely through an
internet connection. Smart Monitoring employs multiple layers of security,
including a Secure Sockets Layer (SSL) and Lightweight Directory Access
Protocol (LDAP) authentication, to provide real-time troubleshooting and
problem resolution for the QuantStudio™ 6 or 7 Flex System. For a detailed
description of the Smart Monitoring Service, see the Smart Monitoring Service
Product Bulletin: Leveraging the power of the Internet while maintaining system security
(Part no. 121PB07-03).

Set the Internet Protocol (TCP/IP) Properties for either DHCP or Static IP
communication.
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Network service Action
DHCP Touch Obtain an IP address automatically.
Static IP 1. Touch Use the following IP address.

2. Touch the IP Address field, enter the IP address using the
keypad, then touch Done.

3. Assign the:
* |P addresses for the DNS Servers (primary and secondary)
e Subnet Mask setting

e Default Gateway setting

5. Touch gg Save to save the settings, then touch OK when prompted.

6. Touch ﬁ to return to the Main Menu.

You can use the QuantStudio™ 6 or 7 Flex System touchscreen to map the shortcut
buttons that appear in the Main Menu. You can configure shortcuts to automatically
open specific files and folders so that you can access data quickly and easily without
having to navigate to it.

1. If the instrument is in standby, touch the QuantStudio™ 6 or 7 Flex System
touchscreen to activate it, then press .

2. In the Main Menu, configure the shortcuts as desired:
To add a shortcut:
a. Touch the shortcut of interest, then touch Set Shortcut.

b. Touch [ & | From Templates to link to a specific template file or touch
[& | From Folders to link to a folder.

c. Touch the desired template file or folder to configure the shortcut.

To delete a shortcut, touch the shortcut of interest, then touch i Remove
Shortcut, or touch Remove All to delete all shortcuts.

3. When you are finished configuring the shortcuts, touch [ to return to the Main

Menu.

You can use the QuantStudio™ 6 or 7 Flex System touchscreen to view usage statistics
on the heated cover, lamp, and other instrument components.

1. From the Main Menu of the instrument touchscreen, touch Tools, then
touch Show Statistics.

2. When you are finished, touch ﬁ to return to the Main Menu.
You can use the QuantStudio™ 6 or 7 Flex System touchscreen to view instrument

version data, such as instrument serial number and version numbers for most
instrument components and firmware.

1. From the Main Menu of the instrument touchscreen, touch Tools, then
touch About the Instrument.

2. When you are finished, touch [ to return to the Main Menu.
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Enable/disable
instrument
security

View the
instrument log

92

The QuantStudio™™ 6 and 7 Flex Systems feature a secure mode that can be enabled to

restrict local instrument functionality. When security is enabled, use of the touchscreen
is restricted to administrative functions that change the instrument settings. After the
QuantStudio™ 6 or 7 Flex System is secured, you must enter an administrator
password to modify the instrument settings, use the firmware tools, or deactivate the
secure mode.

™

IMPORTANT! If you enable or disable the QuantStudio " 6 and 7 Flex Systems security,
auditing, and electronic signature feature, you must similarly enable or disable the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software security (see page 131).
The QuantStudio™" 6 and 7 Flex Real-Time PCR System Software cannot connect to
QuantStudio™ 6 and 7 Flex Systems that do not match security settings.

Note: Secure mode limits the number of features that are available from the
QuantStudio™ 6 or 7 Flex System touchscreen; it does not provide user authentication
functionality through the instrument touchscreen.

1. If the instrument is in standby, touch the QuantStudio™ 6 or 7 Flex System
touchscreen to activate it, then press [0 .

2. In the Main Menu, touch Settings, then touch Set Administrator Options.

3. In the Set Administrator Options screen, touch Secure Environment to enable
(checked) or disable (unchecked) system security.

4. (Optional) To change the administrator password:
a. Touch Change Password.
b. Enter the current password, then touch Done.
c. Enter the new password, then touch Done.
d. Reenter the password when prompted.

e. Touch OK when prompted.

Note: The default password for the QuantStudio™" 6 or 7 Flex System touchscreen
is password; however, the password can be changed during installation.

5. Touch gg Save.

6. Touch the Administrator Password field, enter the administrator password, then
touch Done.

7. Touch ﬁ to return to the Main Menu.

You can use the QuantStudio™ 6 or 7 Flex System touchscreen to view a log that
summarizes instrument activity from the last 6 months. For each recorded activity, the
activity log provides a description of the activity and the date/time when it occurred.

1. From the Main Menu of the instrument touchscreen, touch Tools, then
touch View Log.

2. From the View Log screen, configure the settings to display the records of
interest:
* Select an option from the drop-down menu to filter the log.

e Select Earliest First or Latest First to determine the order to sort the records.
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3. (Optional) Plug the USB drive into the port
below the touchscreen, then touch Export to USB
to save the log to the drive.

IMPORTANT! Do not use the USB ports on the
rear panel of the QuantStudio™" 6 and 7 Flex
Systems. The rear USB ports are for use by Life
Technologies personnel to service the
instrument.

4. Touch ﬁ to return to the Main Menu.
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Decontaminate the sampleblock . .......... ... i 96
Replace the halogenlamp .......... ... .. o i il 99
Replace the instrument fuses ............. ... i 102
Install the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software. . . .. 103

Manage QuantStudio™ 6 and 7 Flex Real-Time PCR System Software licenses 104
Update the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software. ... 105

Update the Windows® operating system. .............. ..., 106
Change the sample block. . ...... ... ... i 106
Changetheheated cover............. ... ... il 108
Change the plate adapter ........... ... .. 111

IMPORTANT! This chapter contains all user service procedures for the QuantStudio'" 6
and 7 Flex Systems. Procedures other than those described in this document must be
performed by a qualified Life Technologies Service Engineer.
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Decontaminate the sample block

Materials required

How to handle the
sample block

96

Perform this procedure to eliminate fluorescent contaminants from the QuantStudio™
6 or 7 Flex System sample block. Contamination is generally evident in failed
background calibrations where one or more wells consistently exhibit abnormally high
signals.

CAUTION! PHYSICAL INJURY HAZARD. Do not remove the QuantStudio™
6 or 7 Flex System cover. There are no components inside the instrument that
you can safely service yourself. If you suspect a problem, contact a Life
Technologies Service Representative.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can reach 100°C. Allow the sample block to cool to room
temperature before performing the procedure.

CAUTION! Before using a cleaning or decontamination method other than
those recommended by the Life Technologies, confirm with Life Technologies
that the proposed method will not damage the equipment.

¢ Bleach, 10% solution

¢ Tissue, lint-free

¢ Cotton or nylon swabs and lint-free cloths
¢ Ethanol, 95% solution

* Safety glasses

* Pipette (100-uL) with pipette tips

* Powder-free gloves

* Screwdriver

¢ Deionized water

To prevent damaging or contaminating the sample block, handle the assembly as
shown. Also, when the assembly has been removed from the QuantStudio™ 6 or 7 Flex
System, place the sample block on a clean, dry surface or in its shipping container.
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Clean the WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
sample block sample block can reach 100°C. Allow the sample block to cool to room
temperature before performing the procedure.

IMPORTANT! Wear powder-free gloves when you perform this procedure.

1. Identify the contaminated wells of the sample block (see “How to identify
contamination” on page 78).

2. Power off and unplug the QuantStudio™" 6 or 7 Flex System, then allow it to cool
for 15 minutes.

3. Open the access door.

4. Firmly press down on the handle of the sample block, then remove it from the
QuantStudio™ 6 or 7 Flex System. Place the sample block on a clean, dry surface.

5. Clean the contaminated wells of the sample block using deionized water:
a. Pipet a small volume of deionized water into each contaminated well.
b. In each well, pipet the water up and down several times to rinse the well.
c. Pipet the water to a waste beaker.
d. Use a cotton swab to scrub inside of each contaminated well.

e. Use a lint-free cloth to absorb the excess deionized water.
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6.

10.

11.

12.

13.

14.

Load the sample block into the QuantStudio™ 6 or 7 Flex System, then close the
access door.

IMPORTANT! After installing the sample block, confirm that
the indicator on the left side of the sample block is positioned
behind the red line on the instrument rail. If the indicator is
forward of the red line, push the sample block into the
QuantStudio™ 6 or 7 Flex Instrument until it is seated
correctly.

Close the access door.

IMPORTANT! Confirm that the access door is completely closed. The
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software displays an error
message if the door is not completely closed and latched, or if the sample block is
not seated correctly.

™

Plug in, then power on the QuantStudio ™ 6 or 7 Flex System.

Perform a background calibration to confirm that you have eliminated the
contamination.

If the contamination remains, repeat steps 2-5, then clean the contaminated wells
of the sample block using a 95% ethanol solution:

a. Pipet a small volume of 95% ethanol solution into each contaminated well.

b. In each contaminated well, pipet the solution up and down several times to
rinse the well.

c. Pipet the ethanol solution to a waste beaker.

Repeat steps 5-9 to rinse the wells of the sample block and to ensure that you
have eliminated the contamination.

IMPORTANT! Always use deionized water to rinse wells after cleaning with
bleach or ethanol solution.

If the contamination remains, repeat steps 2-5, then clean the contaminated wells
of the sample block using 10% bleach solution:

a. Pipet a small volume of 10% bleach solution into each contaminated well.

b. In each contaminated well, pipet the solution up and down several times to
rinse the well.

c. Pipet the bleach solution to a waste beaker.

Repeat steps 5-9 to rinse the wells of the sample block and to confirm that you
have eliminated the contamination.

IMPORTANT! Always use deionized water to rinse wells after cleaning with
bleach or ethanol solution.

If the contamination remains, contact Life Technologies.
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Replace the halogen lamp

Materials required

Halogen lamp
warnings

View the lamp
status

Replace the halogen lamp at or before 2000 hours of life.

WARNING! PHYSICAL INJURY HAZARD. The QuantStudio' " 6 or 7 Flex
System and lamp are hot! The lamp can become very hot while in use. Before
handling the lamp, allow it to cool for 15 minutes and put on protective,
powder-free gloves.

CAUTION! PHYSICAL INJURY HAZARD. Wear disposable, powder-free
gloves when handling the lamp to prevent burns and to prevent shortening the
life of the replacement lamp.

WARNING! This QuantStudio™ 6 or 7 Flex System is designed for 12V, 75 W
halogen lamps only. Replace with halogen bulbs supplied by Life Technologies.

Safety glasses
Powder-free gloves
Halogen bulb (12 'V, 75 W)

The QuantStudio" 6 and 7 Flex Real-Time PCR System Software can display the
following warnings before or during an experiment:

The lamp current is below the acceptable level at the start of the run.
Replace the halogen bulb as explained in “Replace the lamp” on page 100.

The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software stopped the run
because the lamp current decreased below the acceptable level during the run.

Replace the halogen bulb as explained in “Replace the lamp” on page 100. Click
OK in the message box, then replace the lamp bulb.

The lamp usage exceeds 2000 hours at the start of a run.
Click Cancel Run, then replace the lamp before you perform another experiment.

. From the QuantStudio™™ 6 and 7 Flex Real-Time PCR System Software Home tab,

click Instrument Console.

From the Instrument Console, select your QuantStudio'" 6 or 7 Flex System from
the list of instruments, then review the Lamp Life and Last Serviced readings in
the Maintenance Info pane.

If the lamp usage has reached 2000 hours, replace the lamp (see “Replace the
lamp” below).

Note: The Lamp Life report displays the total number of hours that the halogen
lamp has been illuminated. The Last Serviced report displays the date that the
lamp was installed.
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IMPORTANT! Always wear powder-free gloves when you handle the lamp. Finger
prints shorten the lamp life.

. Record the lamp installation:

a. From the Main Menu of the touchscreen, touch Tools, then touch Record
Lamp Installation.

b. Touch the Name field, enter any relevant information (such as the make,
model, or serial number of the lamp), then touch Done.

c. Touch the Comments field, enter any additional information that you want
to record, then touch Done.

d. Touch Save, then touch OK.

e. When asked to confirm lamp replacement, touch OK.

Note: The data that you enter for the new lamp appears in the instrument log.

. Power off and unplug the QuantStudio'" 6 or 7 Flex System, then allow it to cool

for 15 minutes.

. Open the access door.

. Remove the lamp from the QuantStudio™" 6 or 7 Flex System:

a. Slide the lamp release lever downward.

b. Firmly grasp the lamp and lift it up and out of the slotted mount.

. Inspect the lamp for damage (carbon usually coats the inside of a failed lamp). If

necessary, dispose of the lamp and obtain a replacement.

IMPORTANT! Dispose of the lamp in accordance with your local municipal waste
ordinances. Do not dispose of the lamp as unsorted municipal waste.

. Install the new lamp into the QuantStudio™ 6 or 7 Flex System:

a. Slide the lamp release lever upward.
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b. Firmly grasp the lamp, place it into the slotted mount, then carefully slide
the lamp downward into place.

Close the access door.

Plug in and power on the QuantStudio™ 6 or 7 Flex System.

IMPORTANT! Confirm that the access door is completely closed. The
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software displays an error
message if the door is not completely closed and latched, or if the lamp is not
seated correctly.

Start the QuantStudio™" 6 and 7 Flex Real-Time PCR System Software, then
perform an ROI calibration.

While the QuantStudio ™ 6 or 7 Flex System is running, look through grating of
the access door and confirm that the lamp is illuminated.

¢ If the lamp is illuminated, the lamp has been installed successfully.

¢ If the lamp is not illuminated, the replacement halogen lamp may be
defective. Replace the lamp again. If the second lamp does not illuminate,
check the QuantStudio™ 6 or 7 Flex System fuses for failure (see page 102).

After replacing the lamp, perform the following calibrations in the specified
order:

a. ROI calibration
b. Background calibration
. Uniformity calibration

c

d. Dye calibration

e. Normalization calibration
f

RNase P test
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Replace the instrument fuses

Replace the QuantStudio™" 6 or 7 Flex System fuses when the fuses fail.

CAUTION! FIRE HAZARD. For continued protection against the risk of fire,
replace fuses only with listed and certified fuses of the same type and rating as
those currently in the QuantStudio" 6 or 7 Flex System.

Materials required .

Replace the fuses 1.

Fuses, 12.5A, Time-Lag T, 250VAC, 5 x 20-mm (2)

Fuses for AU/NZ only, 6.3A, Time-Lag T, 250VAC, 5 x 20-mm (2)
Safety glasses

Powder-free gloves

Screwdriver, flathead

Power off, then unplug the QuantStudio™ 6 or 7 Flex System. Allow it to cool for
15 minutes.

Using a flat-head screwdriver, unscrew and remove the fuse holder.

Remove each fuse from its fuse holder and inspect it for damage. Carbon typically
coats the inside of failed fuses.

Good Failed

Replace each failed fuse with a 12.5A, Time-Lag T, 250VAC, 5 x 20-mm Fuse.

Note: The voltage and amperage ratings are on the fuse holder.

Note: For AU/NZ only, replace each failed fuse with a 6.3A, Time-Lag T, 250VAC,
5 x 20-mm Fuse.

Install the fuse holder.

Plug in, then power on the QuantStudio™ 6 or 7 Flex System. The installation is
successful if the instrument powers on.

Note: Fuse failure can result from fluctuations in the supplied power to the
QuantStudio™ 6 or 7 Flex System. To prevent further failures, consider installing an
electrical protective device, such as a UPS or a surge protector.

102
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Install the QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software

If you have extra software licenses, you can install the QuantStudio™ 6 and 7 Flex

Real-Time PCR System Software to computers that meet the operating requirements
(not recommend).

Computer See “Computer requirements” on page 24 for a list of hardware and operating system
requirements requirements for the QuantStudio™" 6 and 7 Flex Real-Time PCR System Software.

Install the software 1. Load the QuantStudio™" 6 and 7 Flex Real-Time PCR System Software CD into the
computer.

2. From the QuantStudio™" 6 and 7 Flex Real-Time PCR System Software Installer,
click Install QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.
3. Complete the installation as instructed using the default settings:
¢ From the Welcome window, enter your customer information.
¢ From the License Agreement screen, accept the terms of the agreement.
¢ From the Installation Location screen, accept the default location.

e From the License screen, install the license key/file that you obtained from
Life Technologies.

The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software installation
requires several minutes.

4. FEject the CD when the installation is complete.
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Manage QuantStudio™ 6 and 7 Flex Real-Time PCR System Software

licenses

QuantStudio™ 6
and 7 Flex Real-
Time PCR System
Software license
keys and files

Activate a license

Install a license file

104

You can use the License Central feature to activate, or install the licenses that control
access to the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software base
application and associated modules.

™

The QuantStudio ™ 6 and 7 Flex Real-Time PCR System Software and associated
modules require the installation and maintenance of valid license files for continued
operation. The license files are generated by the Life Technologies website when a
license key is activated. Each file pairs a software license key with the computer from
which the key was activated. After a key is activated and a license file is generated, the
file cannot be transferred to another computer. To transfer a license between
computers, you must reactivate the license key using the QuantStudio"" 6 and 7 Flex
Real-Time PCR System Software on the target computer.

™

Note: License keys are found on the QuantStudio ~ 6 and 7 Flex Real-Time PCR
System Software CD packaging, or they can be supplied by Life Technologies support.

™

If you have a valid license key for the QuantStudio ™ 6 and 7 Flex Real-Time PCR
System Software or an associated module, you can activate the license as explained
below.

IMPORTANT! An internet connection, a web browser, and a valid email account are
required to activate a QuantStudio’" 6 and 7 Flex Real-Time PCR System Software

license. If the computer that contains the QuantStudio™" 6 and 7 Flex Real-Time PCR
System Software is not connected to the internet or it lacks a web browser application,

contact Life Technologies support to request the license file.

1. From the QuantStudio™" 6 and 7 Flex Real-Time PCR System Software Home tab,
select Tools » License Central.

2. From the License Central dialog box, select the license of interest from the table,
click Activate License, then wait for the default web browser application to
connect to the Life Technologies website.

3. From the Life Technologies Software License Activation website, click
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software from the list of
products, then activate the license as instructed.

After you successfully activate the license, the Life Technologies website emails
you the activated license file (.lic) to install on your computer.

After you activate a license and receive an activated license file (.lic), install the file as
explained below to unlock the QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software or module.

Note: Each license file is generated specifically for the computer that was used to
activate the license key.

1. Save the license (.lic) file to the computer that contains the QuantStudio™ 6 and 7
Flex Real-Time PCR System Software.
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2. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Home tab,
select Tools » License Central.

3. From the License Central dialog box, click Install License.
4. From the Open dialog box, navigate to and select the license file, then click Open.
5. Click OK to close the License Central dialog box.

Note: Contact Life Technologies support if the software fails to install the license.

Update the QuantStudio™ 6 and 7 Flex Real-Time PCR System

Software

Update the
software

Life Technologies may release updates to the QuantStudio™" 6 and 7 Flex Real-Time
PCR System Software that you can install without the aid of Life Technologies service
personnel. You can obtain updates directly from the service section of the Life
Technologies website.

For the latest services and support information for the QuantStudio™ 6 or 7 Flex

System:

1. Go to www.lifetechnologies.com/us/en/home/technical-resources/software-
downloads

2. From the Software Downloads page, select Applied Biosystems QuantStudio™ 6
and 7 Flex Systems from the menu.

3. From the Applied Biosystems QuantStudio™ 6 and 7 Flex Systems Software
Downloads page, click Updates - Patches.

The website opens the page describing the latest software updates for the
QuantStudio™ 6 or 7 Flex System.

Prepare for the upgrade
To prepare for the software update, back up all data files and experiments by creating
a copy of the directory that you are using to store files. The default directories are:

¢ Installation directory — <drive>: \Program Files\Applied
Biosystems\QuantStudio 6 and 7 Flex Software

e Data directory — <drive>: \Applied Biosystems\AppData\QuantStudio 6
and 7 Flex Software

e User files directory — <drive>: \Applied Biosystems\QuantStudio 6 and
7 Flex Software\User Files\experiments

Note: <drive> is the location where the software is installed.

Install the software

Install the software update according to the instructions that download with the
software. If you are installing the update to a computer that already contains the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, the update automatically
acquires the software license from the existing installation. If you are installing the
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Update the Windows® operating system

QuantStudio™ 6 and 7 Flex Real-Time PCR System Software to a computer that does
not contain a previous installation, you must have a license file supplied by Life
Technologies. If you do not have a license file, obtain one as explained in “Manage
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software licenses” on page 104.

Update the Windows® operating system

Do not upgrade or update the Microsoft® Windows® operating system of the
computer running the QuantStudio"" 6 and 7 Flex Real-Time PCR System Software
without first consulting the software release notes or the Life Technologies website.
Future versions and updates to the Windows® operating system may conflict with the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

To determine compatibility of an upgrade or update:

1. Open <drive>:\Program Files\Applied Biosystems\QuantStudio 6 and 7 Flex
Software, double-click QuantStudio 6 and 7 Software README.docx, then read

the QuantStudio ™ 6 and 7 Flex Real-Time PCR System Software Release Notes for
the compatibility of interest.

Note: <drive> is the location where the software is installed.

2. If the website does not contain the information of interest, contact Life
Technologies.

Change the sample block

When to change
the sample block

Materials required

How to handle the
sample block
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WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
sample block and heated cover can reach 100°C. Allow the sample block to cool
to room temperature before removing.

You can change the sample block:

* To change the consumable format of the QuantStudio™ 6 or 7 Flex System.

In the event of a hardware failure.

Safety glasses

Powder-free gloves

Sample block

To prevent damaging or contaminating the sample block, handle the assembly as
shown below. After the assembly has been removed from the QuantStudio™ 6 or 7
Flex System, place the sample block on a clean, dry surface or in its shipping container.
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Change the sample 1. Power off and unplug the QuantStudio™ 6 or 7 Flex System, then allow it to cool
block for 15 minutes.

2. Open the access door.

3. Firmly press down on the handle of the sample block, then remove it from the
QuantStudio™ 6 or 7 Flex System. Place the sample block on a clean, dry surface.

4. Install the new sample block into the QuantStudio'™ 6 or 7 Flex System.

IMPORTANT! After installing the sample block, confirm that
the indicator on the left side of the sample block is positioned
behind the red line on the instrument rail. If not, push the
sample block into the QuantStudio™ 6 or 7 Flex System until
it is seated correctly.

5. If you are installing a sample block of a different consumable format, replace the
heated cover and plate adapter if necessary.

6. Close the access door.

IMPORTANT! Confirm that the access door is completely closed. The
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software displays an error
message if the door is not completely closed and latched, or if the sample block is
not seated correctly.

7. Plug in and power on the QuantStudio™ 6 or 7 Flex System.

8. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Home tab,
click Instrument Console.
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9. From the Instrument Console, select your QuantStudio'" 6 or 7 Flex System from
the list of instruments, then review the Block Type field in the Instrument
Properties pane.

The installation is successful if the QuantStudio™" 6 or 7 Flex System powers on
and if the Block Type field displays the correct type of sample block.

Note: The Block Type field displays the type of sample block installed to the
QuantStudio™ 6 or 7 Flex System.

10. Check the calibration status of the QuantStudio™ 6 or 7 Flex System (see “View
the calibration status of an instrument” on page 29).

If the calibrations for the new sample block/heated cover have expired, perform
the following calibrations in the specified order:

a. ROI calibration
b. Background calibration
c. Uniformity calibration
d. Dye calibration

e. Normalization calibration

IMPORTANT! If the calibrations for the new sample block/heated cover are valid,
you do not need to recalibrate the QuantStudio™" 6 or 7 Flex System.

Change the heated cover

When to change
the heated cover

Materials required

How to handle the
heated cover
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WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
sample block and heated cover can reach 100°C. Allow the heated cover to cool
to room temperature before removing.

You can change the heated cover:

 To change the consumable format of the QuantStudio" 6 or 7 Flex System.

e In the event of a hardware failure

Safety glasses

Powder-free gloves

Heated cover

To prevent damaging or contaminating the heated cover, handle the assembly as
shown below. After the assembly has been removed from the QuantStudio™ 6 or 7
Flex System, place the heated cover on a clean, dry surface or in its shipping container.
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Change the heated Note: Confirm that the replacement heated cover supports the plate or array card
cover format that you want to use. Some heated covers support more than one consumable

type.

1.

Power off and unplug the QuantStudio™ 6 or 7 Flex System, then allow it to cool
for 15 minutes.

Open the access door.

Unlock the heated cover by pinching the handle together, then pull the assembly
from the QuantStudio™ 6 or 7 Flex System and place it on a clean, dry surface.

N

Install the new heated cover into the QuantStudio'" 6 or 7 Flex System.

IMPORTANT! Align the arrows on the front handle as shown below. If the arrows
are not aligned, push the heated cover into the QuantStudio™ 6 or 7 Flex System
until the handle locks into place.

Correct Incorrect

5. If you are installing a heated cover of a different consumable format, replace the

sample block and plate adapter if necessary.
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10.

Close the access door and ensure it is completely closed.

Note: The QuantStudio" 6 and 7 Flex Real-Time PCR System Software displays
an error message if the door is not completely closed and latched, or if the sample
block is not seated correctly.

™

Plug in and power on the QuantStudio ~ 6 or 7 Flex System.

From the QuantStudio " 6 and 7 Flex Real-Time PCR System Software Home tab,
click Instrument Console.

From the Instrument Console, select your QuantStudio" 6 or 7 Flex System from
the list of instruments, then review the Heated Cover Firmware Version field in
the Instrument Properties pane.

The installation is successful if the QuantStudio™ 6 or 7 Flex System powers on
and if the Heated Cover Firmware Version field displays a version number.

Check the calibration status of the QuantStudio™" 6 or 7 Flex System (see “View
the calibration status of an instrument” on page 29).

If the calibrations for the new sample block/heated cover have expired, perform
the following calibrations in the specified order:

a. ROI calibration
b. Background calibration
c. Uniformity calibration
d. Dye calibration

e. Normalization calibration

IMPORTANT! If the calibrations for the new sample block/heated cover are valid,
you do not need to recalibrate the QuantStudio™" 6 or 7 Flex System.
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Change the plate adapter

When to change
the plate adapter

Materials required

Change the plate
adapter

Change the plate adapter in the event of a hardware failure or if you want to change
the consumable format of the QuantStudio™ 6 or 7 Flex System.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
plate adapter can reach 100°C. Allow the plate adapter to cool to room
temperature before removing.

You can change the plate adapter:

To change the consumable format of the QuantStudio" 6 or 7 Flex System.

In the event of a hardware failure

Safety glasses
Powder-free gloves

Plate adapter

Touch the instrument touchscreen to activate it, then press G
From the Main Menu, touch E

When the tray arm opens, pull the latch, then lift and remove the plate adapter.

Attach the new adapter to the tray arm, then pull the latch to allow the adapter to
lower into place. If necessary, apply pressure as indicated until the adapter snaps
into place.

From the Main Menu, touch E

If you are installing a tray adapter of a different consumable format, replace the
sample block and heated cover if necessary.
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IMPORTANT! This chapter does not provide adequate detail to integrate the
QuantStudio™ 6 or 7 Flex Systems into all possible network architectures. Because
your network may contain advanced features (such as a firewall or network domains),
Life Technologies recommends that you consult a network administrator before
connecting the QuantStudio™ 6 or 7 Flex Systems to your laboratory network.
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Networking overview

Controlling and
monitoring
networked
QuantStudio™ 6
and 7 Flex Systems

About the
Ethernet port
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After installing the QuantStudio™" 6 or 7 Flex System, you can connect the
QuantStudio™ 6 or 7 Flex System to a local area network to enhance its functionality.

This appendix describes how to:
* Setup the QuantStudio™ 6 or 7 Flex System for use on a network.
* Setup a computer for remote monitoring.

¢ Test the network connection by engaging the remote monitoring feature.

When the QuantStudio™ 6 or 7 Flex System is connected to a network, computers on

the network that are running the QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software can control or monitor it. The QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software can control up to 4 instruments and monitor up to 10 instruments
simultaneously. A networked QuantStudio™ 6 or 7 Flex System can be controlled by
only one computer at a time. A networked computer running the QuantStudio™ 6 and
7 Flex Real-Time PCR System Software can transfer experiments to and from an
instrument, begin or stop a run, and perform some maintenance functions. During a
run, the Remote Monitoring feature of the software can be used to view the run status,
temperature, and amplification data in real-time.

Note: Remote monitoring does not allow you to control the QuantStudio™ 6 or 7 Flex

System.

The QuantStudio™ 6 or 7 Flex System features a Gigabit Ethernet port for direct
communication with the QuantStudio™ 6 or 7 Flex System computer and for network
communication. When the QuantStudio™ 6 or 7 Flex System is connected to a network,
computers on the network that run the QuantStudio™" 6 and 7 Flex Real-Time PCR
System Software can:

* Send and download experiments to and from the QuantStudio™ 6 or 7 Flex

System.

e Run experiments on the QuantStudio" 6 or 7 Flex System.

¢ Remote monitor the QuantStudio™ 6 or 7 Flex System as it performs runs.

™

The Ethernet port of the QuantStudio ™ 6 or 7 Flex System supports:

e Static IP network service with subnet mask, primary and secondary data network
service (DNS), and default gateway settings, or dynamic host configuration
protocol (DHCP) network service

e mDNS/DNS for local domains

Note: Because mDNS is limited to direct network connections, a QuantStudio™ 6

or 7 Flex System set for mDNS may not be visible to other nodes that are
separated by a router, hub, or another network device.

e [Pv4 link-local (IPV4LL) in the RFC (also known as Automatic Private IP
Addressing [APIPA] or Internet Protocol Automatic Configuration [IPAC])

Note: When the QuantStudio'" 6 or 7 Flex System is set for DHCP, APIPA is
automatically enabled, and the QuantStudio™" 6 or 7 Flex System provides an IP
address when no address is supplied by the DHCP server.
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Networking overview

Example 1

In the following example, one or more QuantStudio" 6 or 7 Flex Systems, which have
been configured for dynamic host configuration protocol (DHCP) operation, are
connected to a network by their Ethernet ports. In this layout, any computer on the
network can monitor and control the QuantStudio™ 6 or 7 Flex Systems.

Note: A networked computer running the QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software can simultaneously control up to 4 instruments and monitor up to
10 instruments that have been connected to the network.

DHCP server

Networked Networked
computer instrument(s)
Example 2

In the example shown below, the QuantStudio™ 6 or 7 Flex System is connected
directly to the QuantStudio™ 6 or 7 Flex System computer, which is also connected to
the local area network. In this configuration, the computers on the network can
exchange experiments with the QuantStudio™" 6 or 7 Flex System computer; however,
the QuantStudio™ 6 or 7 Flex System can be neither monitored nor controlled remotely
because it is physically isolated from the network.

DHCP server

®

Networked Networked Instrument
computer computer
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Consult a network administrator.

— We recommend that you consult a network administrator before connecting
the QuantStudio" 6 or 7 Flex System to your laboratory network.

— To enable the full functionality of the QuantStudio™ 6 and 7 Flex Real-Time
PCR System Software, the computer requires a network connection.

Limit remote monitoring to 10 computers.

Avoid using more than 10 computers to simultaneously monitor the
QuantStudio™ 6 or 7 Flex System remotely. Although the QuantStudio™ 6 or 7
Flex System supports remote monitoring from multiple computers, each
connection taxes the instrument microprocessor. Too many connections can

overburden the QuantStudio™ 6 or 7 Flex System and result in instrument errors.

Note: The effects of an overburdened QuantStudio'" 6 or 7 Flex System are
evident in the Temperature Plot during a run. Symptoms can include extended
hold times or brief, unexpected plateaus in the instrument Temperature Plot.

Observe the restrictions to mDNS and Autodiscovery.

The QuantStudio " 6 or 7 Flex System supports mDNS but only when the
QuantStudio™ 6 or 7 Flex System and computer share a direct network
connection and are within the same subnet. Consequently, network computers
that are separated from the QuantStudio™ 6 or 7 Flex System by a router, hub, or
another network device may not be able to access the QuantStudio™™ 6 or 7 Flex
System by its host name.

Confirm the uniqueness of the instrument name.

The QuantStudio 6 or 7 Flex System does support name resolution but the
instrument name must be unique within the subnet. The QuantStudio™ 6 and 7
Flex Real-Time PCR System Software can automatically discover QuantStudio'" 6
or 7 Flex Systems on the link-local network that are configured for Autodiscovery.

Note: The QuantStudio™ 6 or 7 Flex System does not test the uniqueness of the
instrument name when it is set.

Name QuantStudio " 6 and 7 Flex Systems using lowercase letters.

When you define the QuantStudio™" 6 and 7 Flex Systems settings, enter the
instrument name using lowercase letters only.
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Network setup workflow

The following figure illustrates the workflow for installing the QuantStudio™™ 6 or 7
Flex System to a local area network.

Start

Collect the required network information.
Connect the QuantStudio™ 6 or 7 Flex System to the network.
Connect the computer to the network.

Monitor the QuantStudio™ 6 or 7 Flex System
(to test the network connection).

v

Finish

Collect the required network information

Obtain the following information from your network administrator:

* Network policy for obtaining IP addresses (DHCP or static IP).

IMPORTANT! When the QuantStudio" 6 or 7 Flex System is set for DHCP, APIPA
is automatically enabled and the QuantStudio™ 6 or 7 Flex System self assigns an
IP address when no address is supplied by a DHCP server.

¢ If the network requires static IP addresses, obtain the IP address, subnet mask,
and gateway address for the QuantStudio™" 6 or 7 Flex System.
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Connect the QuantStudio™ 6 or 7 Flex System to the network

Materials required

Define the
instrument
internet

protocol settings
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™

After deciding how to connect the QuantStudio = 6 or 7 Flex System to a network, set
up the QuantStudio™ 6 or 7 Flex System according to your network policies.

Ethernet cable with RJ45 connectors (a CAT6 Ethernet cable for a 1000Mbit/s network
connection or a CAT5 for 100Mbit/s connection)

. Use the Ethernet cable to connect the Ethernet port of the QuantStudio'" 6 or 7

Flex System to the nearest network port.

. Power on the QuantStudio™ 6 or 7 Flex System.

. From the Main Menu of the touchscreen, touch Settings, then touch Set Network

Information.

Note: The Set Network Information screen displays the Media Access Control
(MAC) address of the QuantStudio™ 6 or 7 Flex System below the Autodiscovery
and Smart Monitoring check boxes. The MAC address can be used to uniquely

identify the QuantStudio™ 6 or 7 Flex System on the network.

. Touch Autodiscovery to make the QuantStudio'" 6 or 7 Flex System discoverable

by computers that are running the QuantStudio'" 6 and 7 Flex Real-Time PCR
System Software.

. Touch Smart Monitoring to enable the feature on the QuantStudio™ 6 or 7 Flex

System.

The Smart Monitoring feature allows Life Technologies service personnel to
monitor the status of the QuantStudio™ 6 or 7 Flex System remotely through an
internet connection. Smart Monitoring employs multiple layers of security,
including a Secure Sockets Layer (SSL) and Lightweight Directory Access
Protocol (LDAP) authentication, to provide real-time troubleshooting and
problem resolution for the instrument. For a detailed description of the Smart
Monitoring Service, see the Smart Monitoring Service Product Bulletin: Leveraging
the power of the Internet while maintaining system security (Part no. 121PB07-03).

. Set the Internet Protocol (TCP/IP) Properties for either DHCP or Static IP

communication.
Network service Action
DHCP Touch Obtain an IP address automatically.
Static IP 1. Touch Use the following IP address.

2. Touch the IP Address field, enter the IP address using the
keypad, then touch Done.

3. Assign the:
* |P addresses for the DNS Servers (primary and secondary)
e Subnet Mask setting
e Default Gateway setting

7. Touch Save to save the settings, then touch OK when prompted.
8. Touch ﬁ to return to the Main Menu.
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Connect the computer to the network

Materials required  Ethernet cable with RJ45 connectors

Computer If you are connecting a computer that you provided to a network, confirm that the
requirement computer contains a free network port.

Collect required Obtain the following information from your network administrator:

information ¢ Network policy for obtaining IP addresses (DHCP or static IP)

¢ If the network requires static IP addresses, obtain the IP address, subnet mask,
and gateway address for the computer

Set up the IMPORTANT! We recommend that you arrange for a network administrator to connect
computer your computer to the network. The following procedure does not provide adequate
detail for all network architectures.

Note: The following procedure is valid for the Microsoft® Windows® 7 operating
system.

1. Use the Ethernet cable to connect the computer to the nearest network port.

2. Power on the computer, then log in using a user account that belongs to the
Administrators user group.

From the desktop, right-click My Network Places, then select Properties.
Right-click Local Area Connection, then select Properties.

Select Internet Protocol (TCP/IP), then click Properties.

o o M~ w

Set the Internet Protocol (TCP/IP) Properties for either DHCP or Static IP
communication:

Network
configuration

DHCP

Action

—_

Select Obtain an IP address automatically.
2. Set the DNS address. If the computer obtains DNS addresses:

e Automatically - Select Obtain DNS server address
automatically.

e Statically - Select Use the following DNS address, enter the
address of the preferred and alternate DNS servers if available.

Static IP 1. Select Use the following IP address.
2. In the IP Address field, enter the static IP address.
3. If necessary, enter a subnet mask.
4

. If necessary, enter a static gateway address in the Default
Gateway field.

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems Maintenance and Administration Guide 119



C Appendix C Networking
Monitor the QuantStudio™ 6 or 7 Flex System

Install the
QuantStudio™ 6
and 7 Flex Real-
Time PCR System
Software

7. If your network requires advanced TCP/IP setup (such as WINS), define the
settings:

a. Click Advanced in the Internet Protocol (TCP/IP) Properties dialog box.

b. Define the IP Settings, DNS, and WINS tabs as instructed by your systems
administrator, then click OK.

8. Close all dialog boxes by clicking OK.

9. Restart the computer.

The computer is now visible to other computers on the network.

If you are using a computer that you have provided, install the QuantStudio™ 6 and 7
Flex Real-Time PCR System Software using the QuantStudio'" 6 and 7 Flex Real-Time
PCR System Software CD.

Note: You must install the QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software to monitor the QuantStudio'" 6 or 7 Flex System over the network.

Monitor the QuantStudio™ 6 or 7 Flex System

About remote
monitoring

Monitor the status
of a run

120

After connecting theQuantStudio™ 6 or 7 Flex System and a computer to the network,
you can enable remote monitoring in the QuantStudio" 6 and 7 Flex Real-Time PCR
System Software to observe the instrument status remotely.

When the QuantStudio'" 6 or 7 Flex System is connected to the network, any computer
on the network that is running the QuantStudio™" 6 and 7 Flex Real-Time PCR System
Software can:

B Monitor thestatusof arun................. .. oo see below
B Download experiment files ......... ... ... .. .. 121
B Enable or change the calibration reminders .............................. 121

Guidelines for remote monitoring

To ensure optimal performance of the remote monitoring feature, observe the
following guidelines:

™

* The QuantStudio ~ 6 and 7 Flex Real-Time PCR System Software can monitor up
to 10 instruments.

*  We do not recommend that a QuantStudio™ 6 or 7 Flex System be monitored by
more than 10 computers simultaneously.

* Unless you are sure that your QuantStudio™” 6 or 7 Flex System and computer
exist on the same subnet, we recommend that you use the IP address of the
QuantStudio™ 6 or 7 Flex System to add it for remote monitoring.

1 ™

. From the QuantStudio ™ 6 and 7 Flex Real-Time PCR System Software Home tab,
click Instrument Console.
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2. From the Instrument Console, select the icon for your instrument, then
click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your QuantStudio" 6 or 7
Flex System to the My Instruments group.

3. From the Instrument Manager, click Monitor, then click Information.

4. From the Monitor Instrument screen, click Monitor Running Instrument.
™

The QuantStudio ™ 6 and 7 Flex Real-Time PCR System Software displays the
status, attributes, calibration status, and plot data for the selected QuantStudio™ 6
or 7 Flex System. If a communications warning appears, contact your network
administrator to troubleshoot the problem.

You can lose the software connection to the QuantStudio™" 6 or 7 Flex System if you:

* Change the QuantStudio™ 6 or 7 Flex System that is connected directly to your
computer

* Use the touchscreen to change the instrument name or IP address

Note: To reestablish the connection, restart the QuantStudio™ 6 and 7 Flex Real-Time

PCR System Software.
Download See “Transfer experiments, templates, and results data” on page 83 for more
experiment files information on using QuantStudio'" 6 and 7 Flex Real-Time PCR System Software to

transfer experiment results from the QuantStudio™" 6 or 7 Flex System.

Enable or change The calibration reminder settings allow you to configure the QuantStudio"" 6 and 7

the calibration Flex Real-Time PCR System Software to alert you by email when the QuantStudio™ 6

reminders or 7 Flex System requires calibration. The notifications settings feature is optional, and
it does not affect performance.

IMPORTANT! The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software
transmits email only while the QuantStudio™ 6 or 7 Flex System is monitored. If the
network connection is interrupted, the software stops transmitting updates.

Collect the required information

The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software requires access to a
Simple Mail Transfer Protocol (SMTP) server to email calibration reminders. Contact
your systems administrator or information technology department for the following
information:

¢ Network address of a SMTP server.
* A user name and password for the server, if required for access.

® The Secure Sockets Layer (SSL) setting of the server (on or off).

Define the mail server settings

1. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, select
Tools » Preferences.

2. From the Preferences dialog box, select the SMTP Settings tab.
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3. From the SMTP Settings tab, define the settings for the SMTP server:

* Outgoing Mail Server (SMTP) field — Enter the network address of a Simple
Mail Transfer Protocol (SMTP) server. Optionally, you can specify the
transmission control protocol (TCP) port for the server by appending the
port number to the server name, separating the two using a colon ( : ).

For example: smtp.mycompany.com:2023
Note: If a TCP port is not specified, the QuantStudio™ 6 and 7 Flex Real-
Time PCR System Software uses the default port number (25).

* Encryption Required — Select if the mail server has SSL enabled.

* Authentication Required - Select if the mail server requires a user name and
password.

¢ User Name and Password fields — If the mail server requires authentication,
enter the user name provided by your systems administrator.

4. Click OK.

Modify the notification settings for a monitored QuantStudio™ é or 7 Flex System

1. Open the Calibration Reminders screen for the QuantStudio'" 6 or 7 Flex System:

™

a. From the QuantStudio " 6 and 7 Flex Real-Time PCR System Software Home
tab, click Instrument Console.

b. From the Instrument Console, select your QuantStudio™ 6 or 7 Flex System
from the list of instruments on the network, then click Add to My
Instruments.

Note: You must add a QuantStudio™ 6 or 7 Flex System to your list before
you can manage it.

c. After the QuantStudio™ 6 or 7 Flex System is added to your list, select it,
then click Manage Instrument.

d. From the Instrument Manager, click /‘% Maintenance, then click
Calibration Reminders.

2. From the Calibration Reminders Setting table, configure the notification settings
for the calibrations in interest. For each calibration that you want to monitor:

a. In the Expiry Interval column, enter the number of days that elapse before
the type of calibration expires on the QuantStudio™ 6 or 7 Flex System.

b. In the Send a Reminder column, select the check box to configure the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software to email a
reminder to perform the calibration.

c. In the Reminder Interval column, enter the number of days that elapse
before the software emails recipients a reminder to perform the calibration.

3. From the Enter e-mail addresses for notifications field, enter the email address(es)
that you want to receive email notifications. Separate multiple email addresses
with commas (, ).

4. Click Apply to change the notification settings.
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Place the QuantStudio™ 6 or 7 Flex System on standby

Place the QuantStudio™ 6 or 7 Flex System on standby

If left unattended, the QuantStudio™ 6 or 7 Flex System automatically enters standby
mode to conserve power. To enter standby mode manually, touch on the
QuantStudio™ 6 or 7 Flex System touchscreen.

Power on the QuantStudio™ 6 or 7 Flex System

To power on the QuantStudio" 6 or 7 Flex System from a powered-off state:
1. Touch anywhere on the touchscreen to determine if the QuantStudio™ 6 or 7 Flex
System is in standby mode.
Does the touchscreen display the Standby screen after you touch it?
* Yes — The instrument is ready for use. Go to step 4.
* No - Go to step 2 to power on the instrument.

2. Power on the QuantStudio™ 6 or 7 Flex System. Toggle the power button on the
rear of the QuantStudio™ 6 or 7 Flex System, then wait for it to start.

iy

it
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The QuantStudio'" 6 or 7 Flex System is ready to use when the touchscreen
displays the Main Menu.

3. (QuantStudio™ 7 Flex System only) If you have an Applied Biosystems®
Twister® Robot, toggle the power button on the rear of the Twister® Robot.

Note: The Twister® Robot is ready to use when the power LED illuminates.
4. Power on the monitor.

5. Power on the computer:
a. Press the computer power button, then wait for it to start.

b. When the Login screen appears, enter your user name and password, then
click OK.

6. Start the QuantStudio'™ 6 and 7 Flex Real-Time PCR System Software:

a. From the desktop, double-click QuantStudio 6 and 7 Flex System Software.

Note: If the shortcut is not present on the desktop, select Start »
All Programs » Applied Biosystems » QuantStudio 6 and 7 Flex
Software » QuantStudio 6 and 7 Flex Software to start the software.
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IMPORTANT! If the QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software does not start, confirm that no other instances of the instrument
control software are open. If any instance of the software is open, close it
before starting the QuantStudio'" 6 and 7 Flex Real-Time PCR System
Software.

b. If the QuantStudio™" 6 and 7 Flex Real-Time PCR System Software Login
appears, enter your user name and password, then click Log In.

Enter your user name and password to log in.

User Narne:

Passward:

Exit Application

Note: Security is a separately licensed module. If your system requires this
module, contact Life Technologies.

Note: If the QuantStudio" 6 and 7 Flex Real-Time PCR System Software
displays the License Central screen after you log into the software, your
license file may have become corrupt. Contact Life Technologies support to
obtain a replacement license file.

Power off the QuantStudio™ 6 or 7 Flex System

The QuantStudio'" 6 or 7 Flex Systems operate in low-power mode when not in use;
however, the instrument can be powered off completely so that the components draw
no power.

Note: If the QuantStudio'" 6 and 7 Flex Systems are inactive for extended periods of
time, prepare them for storage as explained in “Store the QuantStudio™ 6 or 7 Flex
System” on page 126.

1. Power off the QuantStudio™ 6 or 7 Flex System:

a. If the touchscreen is not blank, touch to place the QuantStudio™ 6 or 7
Flex System into stand-by mode.

b. Toggle the power button on the rear of the QuantStudio™ 6 or 7 Flex System.

2. Power off the QuantStudio'" 6 or 7 Flex System computer:
a. From the desktop, select Start » Shut Down.
b. From the Shut Down Windows dialog box, select Shut Down, then click OK.
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3. Power off the monitor.

4. (QuantStudio™ 7 Flex System only) If you have an Applied Biosystems®

Twister® Robot, toggle the power button on the rear of the Twister® Robot.

Store the QuantStudio™ 6 or 7 Flex System

Materials required

Prepare the
QuantStudio™ 6 or
7 Flex System

126

The QuantStudio™ 6 or 7 Flex System can be powered off and stored for extended
periods of time. The length of the period of inactivity determines the method you use
to power off the QuantStudio™ 6 or 7 Flex System.

Reaction plate or array card (unused)

. If you plan to store the QuantStudio™ 6 or 7 Flex System for more than a week or

you plan to move it, load an unused plate or array card into the QuantStudio™ 6
or 7 Flex System:

Note: The empty plate or array card protects the internal components of the
QuantStudio™ 6 or 7 Flex System during transport or during periods of inactivity
lasting more than a week.

a. Touch [¢] in the QuantStudio™ 6 or 7 Flex System touchscreen.

b. Touch E to eject the tray arm, place a plate or array card onto the plate
adapter, then press E again to load the plate.

¢. Touch (&) to place the QuantStudio™ 6 or 7 Flex System into stand-by mode.

. Toggle the power button on the rear of the QuantStudio'" 6 or 7 Flex System.

. Power off the computer:

a. Select Start » Shut Down.
b. From the Shut Down Windows dialog box, select Shut Down, then click OK.

. Power off the monitor.

. (QuantStudio™ 7 Flex System only) If you have an Applied Biosystems®

Twister® Robot, toggle the power button on the rear of the Twister® Robot.
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Move the QuantStudio™ 6 or 7 Flex System

Perform this procedure to safely move the QuantStudio™ 6 or 7 Flex System short
distances (for example, between laboratories of the same building).

CAUTION! PHYSICAL INJURY HAZARD. Do not attempt to lift the
QuantStudio™ 6 or 7 Flex System or any other heavy objects unless you have
received related training. Incorrect lifting can cause painful and sometimes
permanent back injury. Use proper lifting techniques when lifting or moving
the QuantStudio™ 6 or 7 Flex System. At least two people are required to lift it.

IMPORTANT! Moving your QuantStudio'" 6 or 7 Flex System can create subtle changes
in the alignment of the instrument optics. Recalibrate the instrument if necessary.

How to handle the  To prevent damaging or contaminating the sample block or the heated cover, handle
sample block and the assemblies as shown below. After you remove each assembly from the
QuantStudio™ 6 or 7 Flex System, place them on a clean, dry surface or in its shipping
container.

heated cover

Prepa re the 1. Power off the QuantStudio™ 6 or 7 Flex System and computer.

- ™M
QuantStudio™ 6 or 2. When the QuantStudio™ 6 or 7 Flex System and computer are powered off,
7 Flex System disconnect all QuantStudio™ 6 or 7 Flex System components and package the
components cabling for the move.

3. Prepare the QuantStudio™ 6 or 7 Flex System for the move:
a. Open the QuantStudio™ 6 or 7 Flex System access door.

b. Firmly press down on the sample block handle, pull the sample block from
the QuantStudio™ 6 or 7 Flex System, then place it on a clean, dry surface.

c. Pinch the handle of the heated cover together, then pull the assembly from
the QuantStudio™ 6 or 7 Flex System and place it on a clean, dry surface.
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Move the
QuantStudio™ 6 or
7 Flex System

Reinstall the
QuantStudio™ 6 or
7 Flex System

128

d. Package the sample block and heated cover assemblies in a clean, dust-free
container.

Move the QuantStudio™ 6 or 7 Flex System according to the following guidelines:

Ensure that the surface on which you will place the QuantStudio™ 6 or 7 Flex
System can support at least 77.9 + 0.6 kg (171.5 £ 0.13 lbs).

Ensure that the path to transport the QuantStudio™" 6 or 7 Flex System is clear of
obstructions.

At least two people are needed to lift and carry the QuantStudio™ 6 or 7 Flex
System.

Keep your spine in a good neutral position.

Bend at the knees and lift with your legs.

Do not lift an object and twist your torso at the same time.

Coordinate your intentions with your assistant before lifting and carrying.

. Reconnect the components of the QuantStudio"" 6

or 7 Flex System. Use the Ethernet cable supplied
with the instrument to connect the QuantStudio™ 6 -
or 7 Flex System to the network interface card in the 8 Ethernet
computer. i

i
IMPORTANT! Do not use a standard Ethernet cable mﬂ

to connect the QuantStudio™ 6 or 7 Flex System to = |
the computer.

Install the sample block and heated cover assemblies.

Perform a RNase P instrument verification run. If the run:

Passes — Do not recalibrate the QuantStudio" 6 or 7 Flex System. No further
action is necessary.

Fails — Perform the following calibrations in the specified order:

a.
b.

C.

ROI
Background

Uniformity

. Dye

Normalization
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Administrator overview

Example
applications
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IMPORTANT! Security, Audit, and Electronic Signature (SAE) is a separately licensed
module available only on purchase. If your system requires this module, contact

Life Technologies. The feature is disabled by default even after the installation of the
license and needs to be enabled.

The Security, Audit, and Electronic Signature (SAE) module is a component of the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software that allows you to
configure the QuantStudio'" 6 and 7 Flex Systems to meet specific requirements. The
module provides the following functionality:

Security — Controls user access to the software. A default Administrator user
account is provided, and additional user accounts and permissions can be user-
defined.

Note: You can enable or disable system security globally.

Note: The default password for the Administrator user account is Administrator;
however, the password can be changed during installation.

Auditing — Tracks changes made to library items, actions performed by users, and
changes to the Security, Audit, and Electronic Signature settings. The software
automatically audits some actions silently. You can select other items for auditing
and specify the audit mode. The Auditing function provides reports for audited
library items, Security, Audit, and Electronic Signature changes, and actions.

Note: You can enable or disable auditing globally and by record type.

Electronic signature (e-sig) — Determines if users are required to provide a user
name and password when performing certain functions. You can configure e-sig
so that a user can print a report or start a run only if the associated data are
signed. You can also configure each e-sig event to require multiple signatures and
to require users with specific permissions to sign.

Note: You can enable or disable electronic signature globally.

You can configure the Security, Audit, and Electronic Signature module in a variety of
ways. For example, you can:

Require users to log in, and leave audit disabled.
Allow only certain users to create or modify protocols.
Allow only certain users to approve reviewed samples.

Require experiments to be signed before users can run or print them.
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Configure the security system

Access the Security
screen and enable
or disable security

Set account setup
and security
policies

Use the Security screen to disable and enable security, control restrictions and security
policies for all user accounts, and set up notifications when certain security events
occur.

Note: Security is disabled by default.

To enable or disable security:

1.

In the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, select
Tools » Security » Settings.

In the Security Settings dialog box, select the System tab.

Select or deselect Enable Security. Note the following:

* The software requires you to enter your user name and password when you
enable security.

* The enable commands are grayed when a run is in process.
e When security is disabled, the & is not active in lower parts of the screen.

¢ Disabling Security inactivates Auditing and E-Signature.

IMPORTANT! If you disable security, you inactivate audit and electronic signature
functions; however, no audit record is generated to indicate that audit and
electronic signature functions are disabled.

IMPORTANT! If you enable or disable the QuantStudio'" 6 and 7 Flex Real-Time
PCR System Software security, auditing, and electronic signature feature, you
must similarly enable or disable the QuantStudio"" 6 and 7 Flex Systems security
(see “Enable/disable instrument security” on page 92). The QuantStudio™" 6 and 7
Flex Real-Time PCR System Software cannot connect to QuantStudio" 6 and 7
Flex Systems that do not match security settings.

4. Click Apply Settings.

Note: Security policies apply to all user accounts.

1.

In the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, select
Tools » Security » Settings.

In Account Setup, specify User Name limits.

IMPORTANT! The software allows spaces in user names. Use spaces in user names
with caution. For information, see “Spaces in user names and/or passwords” on
page 132.

Specify User Password limits:
a. Specify the passwords length limits.

b. Specify password reuse. You cannot disable the password reuse restriction.
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Set up messaging
notifications

132

c. Specify the allowed characters in user passwords: spaces and alphabetical,
numeric, uppercase, lowercase, and special characters (commas, periods,
semicolons, dashes, underscores, and tildes).

4. In Security Policies, specify Password Expiration, Account Suspension, and

Session Timeout settings.

Note: A session times out while a run is in progress if the time-out period is
exceeded and there is no other user activity.

In the Open Non-Secure Data option, select Yes or No to determine whether users
can open experiments and templates that were created without security settings.

Click Set Up Messaging Notification Settings to specify when and how the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software notifies the
administrator of certain security events. For information, see “Set up messaging
notifications” on page 132.

7. Click Apply Settings.

The new settings are applied to the user account the next time that the user logs in.

Spaces in user names and/or passwords

If you allow spaces in user names and/or passwords, be aware of the following issues:

* Leading and trailing spaces in user names are difficult to detect on the screen or in

printed reports.

* The number of consecutive spaces in a user name is difficult to determine on the

screen or in printed reports.

Spaces in user names may cause confusion when a user searches for an audit record
associated with a user name. To find a record associated with a user name, specify the
user name exactly, including leading, consecutive, and trailing spaces.

1.

In the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, select
Tools » Security » Settings.

In the Security screen, click Set Up Messaging Notifications to display the Setup
Notifications dialog box.
Select the events for notification:

* System security enabled or disabled — Security has been enabled or
disabled.

¢ User did not enter correct password — A user attempts to log in with an
incorrect password. The message indicates the number of failed
authentications.

¢ User account suspended — The user exceeds maximum number of allowed
failed authentications (login attempts with an incorrect password).

¢ User session timed out — No activity occurred in a user account for the
specified period of inactivity.
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4. Select the notification method:

* Notify Admin at Login - If an event triggers notification, the next time any
user with an Administrator role logs in, the software lists those events,
indicating the time each event occurred and the user who triggered the
event.

The Administrator has the option of acknowledging the event, which
removes it from the notification list.

» Email Notification - If an event triggers notification, the QuantStudio™" 6
and 7 Flex Real-Time PCR System Software sends an email to the addresses
in the adjoining Email Address column of the table. The email notification
displays the triggered event and displays the time that the event occurred
and the user who triggered the event.

5. Click OK.

User account management

Create or edit user  The software includes a default Administrator user account with permissions (defined
accounts by the account user role) to perform all functions in the software. You cannot modify
this account.

1 ™

. From the QuantStudio ™~ 6 and 7 Flex Real-Time PCR System Software, select
Tools » Security » Settings.

2. From the Security Settings dialog box, select the Users tab.

From the Users tab, you can perform the actions in the following table:

To... Action

Create a user 1. Click Create to display the New User dialog box.

account 2. Enter user name, password, first name, middle initial (optional), and

last name. Click a field to display the field limits, which are specified
in Security settings.

Note: First name, Ml (middle initial), and last name are used to create
User Full Name, which is displayed as the name of the logged-in user.

Note: You cannot change the user name after you save the user
account.

3. Select Password Expires at First Login to require the user account
to specify a new password at first log in. The Password Expires On date
is specified in Security settings.

4. Select the user role (described in “Create or edit a user role” on
page 134) and the electronic signature state (determines if a user
account has permission to electronically sign objects).

Leave the status set to ACTIVE.
5. (Optional) Enter email (for information only), phone, and comments.
6. Click Save.

A shaded Save button indicates an invalid entry in a field. Click a field
to display the limits for the field, then enter a valid entry.
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Determine the
name of the
logged-in user

Create or edit a
user role

134

To... Action
Edit a user 1. From the Users screen, select a user account, then click Edit.
account Note: If you select multiple users, only Status and Role will be
changed.
2. Edit settings as needed. You cannot edit the user name of an existing
user.
3. Click Save.
Activate a 1. From the Users screen, select the user.
suspended 2. Click Edit.

user account
3. Change the Status from SUSPENDED to ACTIVE, then click Save.

Disable IMPORTANT! You cannot delete a user, because user records are required
(inactivate) a for auditing. To disable a user account, inactivate it as follows.

user account
1. From the Users screen, select the user.

2. Click Edit.

3. Change the Status from ACTIVE to INACTIVE, then click Save.
Reset a 1. From the Users screen, select the affected user account, then
forgotten click Edit.
password 2. Enter a replacement password for the user, then re-enter the password

for confirmation.

3. If you assigned the user a temporary password, then select Password
Expires at First Login to require the user to specify a new password
at log in.

4. Click Save.

The title bar of the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software
window displays the name of the user.

User roles determine the permissions associated with a user account. The
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software includes three default
user roles:

* Administrator (cannot be edited or deleted)
e Lab Director

¢ Technologist

You can modify the Lab Director and Technologist roles, and you can create your own
roles with customized settings as needed.

™

1. From the QuantStudio = 6 and 7 Flex Real-Time PCR System Software, select
Tools » Security » Settings.

2. From the Security Settings dialog box, select the Roles tab.

From the Roles tab, you can perform the actions in the following table:
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To... Action

Create a user 1. Click Create.
role 2. Enter a role name and (optional] description.

3. Select permissions (see “Permissions and default user roles” on
page 135). To select all permissions in a category, select the check box
next to the category.

Note: Operations not shown in the following table are available to all
user roles.

. Click Save Role.

Edit a user role . From the Roles screen, select a user role, then click Edit.

4
1
2. Edit settings as needed. You cannot edit the Administrator user role.
3

. Click Save Role.

Permissions and default user roles

Note: To determine the permissions for a default role or to edit it, select the role, then
click Edit.

The following table shows all user-configurable permissions and the settings for the
default user accounts.

Permissions Default user roles
s & £
g 2 =
Category Function ’c= ° g
s | g | E
- = <
Setup Create and edit experiments or experiment Yes No Yes
templates (includes running experiments)
Create, edit, and import sample attributes Yes No Yes
Run Perform a run using the Quickstart function Yes No Yes
Start a run Yes No Yes
Stop a run Yes No Yes
Targets (Library) = Create targets Yes | No | Yes
Edit targets Yes No Yes
Delete targets Yes No Yes
Analysis Create analysis settings (includes default settings) | Yes No Yes
Se_ttings Edit analysis settings (includes default settings) Yes No Yes
(Library)
Delete analysis settings Yes No Yes
Run Methods Create a run method Yes No Yes
(Library) Delete a run method Yes No Yes
Dye (Library) Create a custom dye Yes No Yes
Delete a dye Yes No Yes
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Permissions Default user roles

s & £

g 8k

Category Function = ° [0}

o £ c

5 8 £

i - =
Study Create or edit a study (for example, edit a plate or | Yes No Yes

analysis settings)

Add (transfer] experiments to a study Yes | No | Yes
Remove experiments from study Yes No Yes
Preferences Edit the system preferences Yes No Yes
Export the system preferences Yes No Yes
Import the system preferences Yes No Yes
Calibrations Perform calibrations Yes | Yes | Yes
RNaseP Perform an RNase P run Yes | Yes Yes
Instrument Add and remove instruments from monitoring Yes No Yes
Configuration Upgrade and downgrade instrument firmware Yes No Yes
Security Configure the security and audit feature No No Yes
Configuration Log in to user sessions that have timed out No No Yes
Perform E-Signing Yes No Yes
Export Export primary and secondary analysis results Yes | Yes | Yes

Viewor printauser  Note: The landscape and portrait functions are not available for the User or Roles
report reports. To print either report in landscape, save the report electronically (.pdf), then
print the file in the desired orientation.

1. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, select
Tools » Security » Settings.

2. From the Security Settings dialog box, select the Users or Roles tab.
3. Click View Report.

4. From the Report screen, click tool bar options to manipulate the report as needed.
Place the mouse pointer over an item for a description of the item.

9. Click =} (Print) to print the report, or click |_|1| (Save) to save the report
electronically (.pdf). Close the report.
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Audit trail management

Access the Audit Use the Audit screen to control the auditing state (disabled or enabled), the events that
screen and enable  are audited, and the reasons available to users when audit mode is set to Prompt or

or disable auditing ~ Required.
Note: Auditing is disabled by default.

IMPORTANT! If you disable security, you inactivate audit and electronic signature
functions; however, no audit record is generated to indicate that audit and electronic
signature functions are disabled.

To enable auditing;:

1. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, select
Tools » Security » Settings.

2. From the Security Settings dialog box, select the Audit tab.
3. Select or deselect Enable Audit.

4. Click Apply Settings.

Modify the auditing

. To... Action
settings

Select objects to 1. In the Audit Settings group of the Audit tab, select the objects to
audit audit and the mode for each enabled item (Experiments,
Experiment Templates, or Study).

2. Set the Audit Mode for each item you enable for auditing:

e Optional - The event is audited, a reason prompt is displayed,
but the user can cancel and continue without entering a reason.

¢ Required - The event is audited, a reason prompt is displayed,
and the user must specify a reason.

¢ Silent - The event is audited, no reason prompt is displayed.
3. Click Apply Settings.

Create audit You can create, modify and delete the reasons that are available for
reason settings selection in the Audit Reason dialog box (displayed when a user
performs an audited action).

1. To require users to select a pre-defined reason in the Audit Reason
dialog box (displayed when a user performs an audited action),
enable Require users to select a reason to change from the
list. Users are not permitted to enter a reason.

2. As needed, click Create, or select a reason from the list, then click
Edit or Delete.
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Audit report generation

Viewing audit
histories from the
Security Settings
dialog box

You can use the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software to
generate reports of audit history from both the Security Settings dialog box and from
open experiments, templates, or studies.

B Viewing audit histories from the Security Settings dialog box............... 138

B Viewing audit histories from an experiment, template, or study............. 141

1. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, select
Tools » Security » Settings.

2. From the Security Settings dialog box, select the Audit tab, then click View
Reports.

Note: To access the Audit Reports screen, the user role for an account must have
the “Configure the security and audit feature” permission. Users without the
permission can view object audit histories for individual entries in the libraries by
selecting entries, then clicking View Audit History.

From the Audit Reports dialog box, you can perform the actions in the following table:

To... Action

Display audit histories | 1. Select a tab to display:

¢ System Configuration History - Security, audit, and
electronic signature configuration records, including audit
history for each user account.

e Action Record - System-specified audit events.
2. (Optional) Select Filter by, then filter the table:
e Sort the table.

 Specify filters (date range, user name, action, object or
record type, object or record name, reason), then click
Refresh.

Note: The Reason field in System Configuration History is
not used.

e Select one or more records, then click View Report.

Review the action log | The Action Record log lists system-specified audit events.

All items in the action log are audited silently, except for the items
noted as configurable. Configurable items may include comments
in the action log.

¢ Audit Settings (Update)

¢ Auditing Event (Archive, Restore, Purge)

* Configuration (Import, Export)

¢ Data Audit (Archive, Restore, Purge)

 Login (Success, Failure)

¢ Logout (Success])

e Run (Start, Stop, Completed, Failed, Aborted, Error)
¢ User Account (Create, Update)

138
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To...

Action

View and print audit
reports

Archive, purge, and
restore audit records

1. Select the System Configuration History tab.
2. Display the records of interest.

3. Filter the list to decrease the time required to generate reports.

IMPORTANT! You cannot cancel a report after you click a view
button.

4. Click View Report.

Note: From the audit report, the “Create” action value is listed
as “Added”, “Delete” action value is displayed as “Removed”,
and “Update” action value is displayed as “Updated”.

5. From the Report screen, click tool bar options to manipulate the
report as needed. Place the mouse pointer over an item for a
description of the item.

* To print the report, click = (Print].
 To save the report electronically (PDF), click |_|1| (Save).
6. Close the report.

The audit archive function makes a copy of audit records. Purge
makes a copy of audit records, and then deletes them. You can use
the Restore function to restore purged audit records.

Archive and purge

To selectively archive or purge (delete) system configuration or
action audit records:

1. Select the System Configuration History tab.
2. Select records in the appropriate screen.

3. Click Archive or Purge.
4

. If you select Archive, specify a location and name for the archive
file (.asz).

Restore

To restore system configuration or action audit records,
click Restore, then select the .asz file to restore.

Export audit records

You can export audit records to a .txt file for additional manipulation
and reporting outside the QuantStudio™ 6 and 7 Flex Real-Time
PCR System Software.

1. Display the records of interest as described above.
2. Click Export.

3. Specify a name and location for the export .txt file, then
click Save.

Note: If you export audit records for samples that have been
deleted or moved, an error message is displayed. Return
sample data files to their original location, then export again.

Review the system
configuration history

The System Configuration History lists security, audit, and
electronic signature configuration records.
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Review the system configuration history

The following table summarizes the actions that can be audited using the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software. The System
Configuration History lists security, audit, and electronic signature configuration
records.

Note: If you have installed additional modules to the QuantStudio" 6 and 7 Flex Real-
Time PCR System Software, then the list can contain additional auditable records.

Record type Action Corresponds to...
Security Settings Update | Disable, enable, or modify security policies and session time-out settings
Account Settings Update | Modify password settings, security policies [password expiration and account
suspension), or user name settings
User Group Manager Update | Create, delete, or modify reason for change
User Role Create = Create user role
Delete | Delete user role
Update | Modify user role
User Account Create | Create new user account
Update " Edit or suspend a user account
Role Assignment Delete | Assign a different user role to an existing user account
Update | Create a user account, or assign a different user role to an existing account
Audit Settings Update | Enable or disable auditing
Audit Type Update ' Modify audit settings
Function Management Settings | Update | Update function management
Function Access Manager Update | Update function access management
Function Create | Create function
Delete = Delete function
Update | Update function
Role Permissions Create | Create a user rolet
Delete | Delete a user role
Update ' Modify user role permissions
Audit Reason for Change Delete | Create reason for change
Update | Delete or modify reason for change
Event Manager Update | Update the event manager
E-signature Manager Update " Enable or disable e-signature
E-signature Type Create | Create an e-signature meaning
Delete | Delete an e-signature meaning
Update | Edit an e-signature meaning or an e-signature action
E-signature Function Update " Edit an action requiring e-signature
File Name Update | Update the file name
File Version Update | Update the file version
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T Creates one role assignment record for each permission in a role.

Viewing audit 1. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, open an
histories from an experiment (.eds), template (.edt), or study (.edm) file.
experiment, 2. From the open file, click ¥ ) Audit, then click Audit Records.

template, or study
3. (Studies only) Select the audit records of interest:

¢ Study to view the audit records for the study.

* The name of an experiment to view the audit records for the experiment.

From the Audit Records screen of the open file, you can perform the actions in the

following table:
To... Action
Display the audit (Optional] Filter the table.
history 1. Check the Filter by check box.
2. Enter criteria for the records of interest, such as a date range,
a user name, or a type of action.
3. Click Refresh.
To view details for a specific record:
1. Click the row in the list on the left to view the details of the
record in the table on the upper right.
2. Click any row to view details for individual records in the table
on the bottom right.
Export audit records 1. From the table on the left, select the records to be exported:
e Click in the table, then press Ctrl-A to select all the records
in the table.
e Click and drag or press Shift to select continuous rows.
® Press Ctrl to select discontinuous rows.
2. Export the records:
¢ Click Export Summary to export only the records in the left
table.
e Click Export Details to export the records in the left table
and the associated details.
3. Select a location for the export file, enter a name for the file,
then click Save.
4. Click OK in the confirmation message.
Print audit records 1. Click View Report to open the Print Preview dialog box.
2. Preview, save or print the report:
e Click |_|1| (Save] to save the report as a .pdf or .html file.
Enter the file name, select a location, select the file type, then
click Save.
¢ Click =k (Print] to send the report to the printer. From the
Print dialog box, select the printer and print options, then
click OK.
3. Click [Z3 to close the Print Preview dialog box.
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Manage electronic signature

Access the e- Use the Security screen to disable and enable electronic signature.

signature settings Note: Electronic signature is disabled by default.
screen and enable
or disable e-sig To enable or disable electronic signature:

1. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software, select
Tools » Security » Settings.

2. From the Security Settings dialog box, select the e-Signature tab.

3. Select or deselect Enable e-Signature.

IMPORTANT! Enabling the electronic signature feature can substantially increase
the size of experiment, template, and study files.

IMPORTANT! If you disable security, you inactivate audit and electronic signature
functions. No audit record is generated for the disabling of audit and electronic
signature functions when you disable security.

4. Click Apply Settings.

Configure the The e-signature meanings are the text that a user can select to describe a reason for an
meanings of the electronic signature. The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software
electronic is installed with the following default meanings.
signatures Default data types
E-Signature definition Plate Thermocylcer = Analysis @ Analysis
setup protocol protocol | results
Reviewed and Approved Plate Set Up Yes Yes No No
Reviewed and Approved Results No No Yes Yes
Reviewed and Approved Template No No Yes Yes

Use the Security Settings dialog box to add or remove electronic signature meanings
and to determine the data types to which they apply.

To... Action

Add a meaning 1. From the e-Signature tab of the Security Settings dialog box, click
Add in the e-Signature Meanings settings.

2. From the Create Meaning dialog box, enter a description of the e-
Signature meaning, then click OK.

3. Select what data is signed for the selected meaning.

4. Click Apply Settings.

Delete a meaning 1. Select the meaning from the e-Signature Meanings list, then
click Remove.

2. Click Apply Settings.
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Manage electronic signature

To determine the user roles that can perform an electronic signature:

1. From the e-Signature tab of the Security Settings dialog box, select the check box
next to the appropriate user roles in the User Role signature rights table.

2. Click Apply Settings.

IMPORTANT! Do not change electronic signature settings during calibration.

1. In the Signature Required column, select the check box next to each action for
which you want to require electronic signatures (see below). This selection causes
the software to present an e-sig prompt if a user performs the action on a data file
that does not have the required signatures. The data must be signed before the
user can perform the action.

Action The software requires e-signatures when a user...

Print Report | Prints a report from an experiment or study.

Start Run Initiates a run from the QuantStudio™ 6 and 7 Flex Real-Time PCR
System Software.

2. For each meaning of each selected action, enter the number of e-signatures from
each user role that are required before the software can execute the associated
action. For example, in the following figure, at least two users from the
Administrator user role must sign an experiment using the “Reviewed and
Approved Plate Set Up” meaning before a user can start the associated run.

Actions requiring signatures

Signature Required | Action

I;;iniiepﬂft I Meaning Administrator | Technician | Scientist

v

art B Revi d and Approved Plate Set Up 2 u] u]
Reviewed and Approved Results u] u] u]
Reviewed and Approved Template u] u] u]

3. Click Apply Settings.

If the system is configured to check for a signature before starting a run or printing a
report and the data are not signed, the QuantStudio'" 6 and 7 Flex Real-Time PCR
System Software displays a message when the user clicks Start Run or Print Report.

Example

The e-signature system is configured to require signatures from two users from the
user account named Administrator before a user can start a run. The experiment has
not been signed.

A user attempts to begin the run. The following message is displayed:
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Generate e-signature reports

Missing Required Signatures

' The requested operation cannot be performed because some required signatures are missing.
. The following e-Signatures must be collected before this operation can be performed:

Reviewed and Approved Plate Set Up by 2 Administratoris)

Before the run can start, two administrators must sign. If a user with an incorrect user
role signs, the message is displayed again.

Generate e-signature reports

You can use the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software to
generate reports of e-signature history from open experiment (.eds) or template (.edt)
files.

Task Description

Display the e- | 1. From the QuantStudio™ é and 7 Flex Real-Time PCR System Software,
sig records open an experiment or template file.

2. From the open experiment, click @Audit, then click E-Signatures.

3. (Optional) Click any row to view details for individual signatures.

Save or print 1. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software,
e-sig records open an experiment or template file.

2. From the open experiment, click @Audit, then click E-Signatures.
3. From the table, select the record to be saved or printed.

4. Save or print the record:

e Click |_|1| (Save), select a location for the export file, enter a name
for the file, then click Save.

or
e Click =1 (Print).
5. Click OK in the confirmation message.

Save or print 1. From the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software,

the table of e- open an experiment or template file.
signature 2. From the open file, click @Audit, then click Print E-Signatures.
events !

3. Save or print the record:

e Click |_|1| (Save), select a location for the export file, enter a name
for the file, then click Save.

or
s Click (= (Print).

4. Click OK in the confirmation message.

144 QuantStudio™ 6 and 7 Flex Real-Time PCR Systems Maintenance and Administration Guide



Appendix E Security, Audit, and Electronic Signature

Export and import user, security, audit, and e-signature settings

Export and import user, security, audit, and e-signature settings

Note: The export/import feature can be used to replicate identical security, audit, and
e-signature settings across multiple computers. The feature allows you to create a
standard security, audit, and e-signature settings “image” for the QuantStudio™" 6 and
7 Flex Real-Time PCR System Software that can then be imported by other copies of
the software to bypass manual setup.

Task Description

Export 1. In any screen of the Security Settings dialog box, click Export.
2. Select the items to export: All or Custom.
Custom contains select settings:

» Users & Roles - All user accounts with “Active” status and all user
roles and associated permissions (in case a user account specifies
a user role that does not exist on the system into which you import
the profiles).

e System & Roles - All system settings and all user roles and
associated permissions.
3. Click Export or OK.

4. When prompted, specify the name and location for the exported file
(.dat], then click Save. A message is displayed when the export
completes.

Import 1. In any screen in the Security Settings dialog box, click Import in the
Experiment Menu.

2. Select the .dat file to import, then click Open. A message is displayed
asking if you want to overwrite the current system configuration.
Click Yes.

If any imported user accounts already exist on the system, you are
prompted to overwrite or skip each account.
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User overview

User account
permissions

Account
suspension

Session time-out

146

The Security, Audit, and Electronic Signature (SAE) module is a component of the
QuantStudio™ 6 and 7 Flex Real-Time PCR System Software that provides the
following functionality:
* System security — Controls user access to the software.
* Auditing — Tracks changes made to library items, actions performed by users, and
changes to the Security, Audit, and Electronic Signature settings.

¢ Electronic signature — Requires users to provide a user name and password when
performing certain functions.

Depending on the way that your administrator configures these features, you may see
the following dialog boxes and prompts when you use the software.

If your user account does not have permission to perform any function in the software,
menu commands are shaded.

If the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software is configured to
suspend a user account for failed logins, and if you repeatedly enter an incorrect user
name and/or password, your user account is suspended, and the Log In dialog box
indicates that your account is inactive.

There are two ways to activate a suspended account:
* You can wait until the suspension period ends.

* An administrator can change the account status from Suspended to Active.

Note: While a user is suspended, another user can click Reset, then log in and replace
the suspended user.

If the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software is configured to
time-out and there is no user activity for the specified time, the Log In dialog box
indicates that your user session has timed out. You must enter your user name and
password to access the software.

The administrator or another user with permission to log in to timed-out sessions can
click Reset, then log in.
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User overview

User security tasks —

Description

Log in

Change your
password when
it expires

Your access to functions in the software is based on the permissions
associated with your user account. Functions for which you do not have
permissions are shaded.

Note: If the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software
is configured for password expiration, you are periodically prompted to
change your password.

Note: If the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software
is configured to monitor failed log in attempts, you will be locked out of
the software if you repeatedly enter an incorrect user name and/or
password.

When your password is about to expire, a message is displayed when you
log in.

To change your password, select Tools » Change Password. Enter your
current password, then enter the new password two times, then click OK.

Enter a reason
for change

If the QuantStudio™ é and 7 Flex Real-Time PCR System Software is
configured for auditing, you may be prompted to specify a reason when
you make certain changes in the software.

Depending on your QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software configuration, you can either select a reason from the list or
enter a reason for change.

Perform an
electronic
signature

If your system is configured for electronic signature, you may be required
to have the experiment signed by other users before you can print a
report or start a run. If an item is set to require multiple signatures, all
approvers must sign the associated data before the action can be
completed.

If electronic signature is enabled for experiments, any of the following
may apply:

e The Tools » Security » Sign Data menu option is enabled.

¢ You are prompted to sign.
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Create a background plate or array card

Create a background plate or array card

Required materials

Create a
background plate

150

Whenever possible, use a Background Plate or the TagMan® Array Background Buffer
that is included with the spectral calibration kit. The plates/array cards supplied in the
kit contain a buffer that accurately simulates the reagents used for PCR, and, therefore,
produces high-quality calibration data. If a background plate or array card from a
spectral calibration kit is not available, you can create one as described below.

96/384-Well Plate Sample Block

MicroAmp® Optical 96/384-Well Reaction Plate
Safety glasses

Optical Adhesive Cover or Optical Flat Caps
Pipettor, 200-uL (with pipette tips)
Powder-free gloves

Deionized water

Array Card Sample Block (QuantStudio™ 7 Flex System only)

Array Cards

Applied Biosystems® Array Card Staker/Sealer

Centrifuge with array card buckets and array card carrier clips
Permanent marker or pen

Pipettor, 200-uL (with pipette tips)

Powder-free gloves

Safety glasses

Deionized water

IMPORTANT! Wear powder-free gloves while creating the background plate.

. Remove a MicroAmp®96/384-Well Optical Reaction Plate from its box and place it

on a clean, dry surface.
Aliquot 20 puL deionized water to each well of the reaction plate.
Seal the plate using an optical adhesive cover or optical flat caps.

Use the plate for background calibration as you would a background plate from
the spectral calibration kit.
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Create a background plate or array card

. Remove an array card from its box and place it on a clean, dry surface.

2. Using a permanent marker, write “Background” on the side of the empty card.
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. Pipet 100 uL of deionized water into each of the eight reservoirs in the card:

a. Place the array card on a lab bench, with the foil side down.
b. Load 100 pL of the solution into a pipette.

c. Hold the pipette in an angled position (~45°) and place the tip into the fill
port.

There is a fill port on the left arm of each fill
reservoir — the larger of the two holes.

Fill Vent

port port
1 2 4
(] O] (- (e} (] (e} (] )

d. Dispense the fluid so that it sweeps in and around
the fill reservoir toward the vent port.

e\
ey
J,‘§§r

When pipetting the reagents into the array card,
pipet the entire 100-uL volume into the fill
reservoir, but do not go past the first stop of
pipettor plunger or you may blow the solution out
of the port.
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IMPORTANT! Do not allow the tip to contact and possibly damage the coated
foil beneath the fill port.

. Centrifuge and seal the array card as explained in “Filling the calibration array

cards” on page 36.
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Create a custom dye plate for calibration

Before you use
custom dyes

Required materials

Determine
optimum dye
concentration

152

The QuantStudio™ 6 or 7 Flex System can be used to run assays designed with custom

dyes (dyes not manufactured by Life Technologies). Custom dyes must excite between
455 and 672 nm and read between 505 and 723 nm.

Before using custom dyes with the QuantStudio™ 6 or 7 Flex System, you must:
* Determine optimum dye concentration.
¢ Create a custom dye plate.
¢ Add the custom dye to the software.

* Perform a dye calibration.

¢ Centrifuge with plate adapter

¢ Custom dye(s)

* Safety glasses

* Powder-free gloves

* MicroAmp® Optical 96/384-Well Reaction Plate
* Optical Adhesive Cover

* Pipettors and pipette tips (200-puL and 1000-pL)
e Tubes (2-mL and 10-mL)

e Deionized water

Note: Wear powder-free gloves while creating the dye plate.

1. Prepare and load the custom dye plate:

a. In the center of a 96/384-well plate, prepare a dilution series of the custom
dye (for example, 25, 50, 100, 200, 400, 800, 1600, and 3200 nM) using 20 pL
volumes for a 96/384-well plate.

b. Seal the reaction plate using an optical adhesive cover.

c. Load the prepared reaction plate.

2. Start the calibration wizard:

a. Inthe Home screen of the QuantStudio'" 6 and 7 Flex Real-Time PCR System
Software, click Instrument Console.

b. In the Instrument Console, select your QuantStudio™ 6 or 7 Flex System,
then click Add to My Instruments.

Select the QuantStudio™ 6 or 7 Flex System, then click Manage Instrument.
In the Instrument Manager, click Maintenance, then click ROIL.
In the ROI Calibration screen, click Start Calibration.

In the ROI dialog box, click Next until prompted to load the QuantStudio™ 6
or 7 Flex System. When the side door opens, load the sealed plate. Ensure
that the plate/array card is properly aligned in the holder.

- o a o0
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Create a custom dye plate for calibration

g. In the ROI dialog box, select Check the box when the ROI calibration plate
has been loaded, click Next twice, then click START RUN to start the
calibration.

3. When the run is complete, inspect the ROI images:
a. Select the first filter from the Filter drop-down list.

b. Record the coordinate of the well that contains the lowest concentration of
dye and that is encircled by a ring. This well contains the optimal
concentration of the custom dye at the given filter.

c. Repeat steps a and b for the remaining filters.

d. After you determine the optimum concentration for each filter, determine the
optimum concentration for the custom dye. Compare the results from all
filters, then select the concentration that yields the highest possible signal in
all filters.

4. Discard the plate.

WARNING! PHYSICAL INJURY HAZARD. During instrument
operation, the plate can reach 100°C. Allow the plate to reach room
temperature before removing.

5. Inthe ROI dialog box, click Finish to complete the calibration, then click No when
prompted to save the results.

Create a custom IMPORTANT! Wear powder-free gloves while creating the dye plate.
dye plate

1. Prepare 2 mL of the custom dye at the concentration determined in “Determine
optimum dye concentration” on page 152.

2. Pipet 20 pL of the diluted custom dye to all wells of an optical reaction plate.
3. Seal the wells of the reaction plate using an optical adhesive cover.

4. Centrifuge the plate for 2 minutes at < 1500 rpm.

Note: The custom dye calibration plate must be well mixed and centrifuged.

5. Verify that the liquid in each well of the plate is at the bottom of the well. If not,
centrifuge the plate again at a higher rpm and for a longer period of time.

Correct Incorrect
Liquid is at ¢ Not centrifuged with enough force, or
bottom of well. '« Not centrifuged for enough time
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Add the custom dye 1. Start the dye calibration:

to the software a. Inthe Home screen of the QuantStudio'" 6 and 7 Flex Real-Time PCR System
Software, click Instrument Console.

b. In the Instrument Console, select your QuantStudio™ 6 or 7 Flex System
from the list of instruments on the network, then click Add to My
Instruments.

c. Select the QuantStudio™ 6 or 7 Flex System, then click Manage Instrument.

d. In the Instrument Manager, click Maintenance, then click Dye.

e. In the Background Calibration screen, click Start Calibration.
2. In the Dye window, select a custom dye from the list or create the custom dye:
a. Click New Dye.
b. In the Dye Library dialog box, click New.
c. Complete the New Dye dialog box, then click OK.

Field/option Action

Name Enter a name for the custom dye.
Wavelength Enter the wavelength at which the dye fluoresces.
Type Select:

¢ Reporter if the dye works in conjunction with a quencher dye
to report an increase of PCR product.

¢ Quencher if the dye suppresses the fluorescence of a
reporter dye until amplification of PCR product.

e Both if the dye reports an increase of PCR product without
the aid of a quencher dye.

d. Click Close.

3. In the Dye window, enter a temperature setting for the calibration. Set the
temperature to match the temperature at which you intend to collect data. For
example, the temperature for all Life Technologies system dyes is 60°C because
data collection for TagMan® reagents occurs during the 60°C extension step of the
PCR.

4. Load the appropriate dye plate into the plate adapter, select Please check the box
when the dye calibration plate has been loaded, click Next twice, then click
START RUN to start the calibration.

5. When the run is complete and the QuantStudio™" 6 or 7 Flex System ejects the
plate, remove and discard the plate or array card.

WARNING! PHYSICAL INJURY HAZARD. During instrument
operation, the plate can reach 100°C. Allow the plate to reach room
temperature before removing.

6. In the Dye dialog box of the QuantStudio'" 6 and 7 Flex Real-Time PCR System
Software, click Next.

7. Verify the grouping of the dye spectra:
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a. In the plate layout, select the wells of the plate.
b. Inspect the raw data. For each spectrum, verify that the peak is:
* Within the detectable range for the QuantStudio"" 6 and 7 Flex Systems.
¢ Free of irregular spectral peaks.
* Present at the correct filter for the dye.
Note: Among wells containing the same dye, variations in spectral position and
peak position are caused by minor differences in the optical properties and
excitation energy between the individual wells.
8. Verify the status of the calibration. If the calibration:
Passed — If all spectra are acceptable, finish the calibration:
a. Click Next.
b. Enter any comments you have in the Comments field, click Finish, then click

Yes when prompted to save the calibration results.

Failed — Create another custom dye plate using the next dye concentration greater
than the concentration determined in “Determine optimum dye concentration”
on page 152, then perform the calibration again.
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How to order from
the Life
Technologies
website

How to order from
the QuantStudio™ 6
and 7 Flex Real-
Time PCR System
Software
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You can order materials and accessories directly from the Life Technologies store over
the internet.

Note: Product availability and pricing may vary according to your region or country.
Online ordering through the Life Technologies Store is not available in all countries.
Contact your local Life Technologies representative for help.

To order through the website or the QuantStudio™" 6 and 7 Flex Real-Time PCR System
Software:
¢ Confirm that your computer has an Internet connection.

* We recommend the following browsers and Adobe® Acrobat® Reader versions to
use the Life Technologies website:

H ® ®
_ Microsoft Apple® Mozilla® Adobe o
Operating system Internet -® . ® Acrobat
® Safari Firefox
Explorer Reader
Microsoft® Windows® | vé.x or later None' v2.x or later | v4.0 or later
Macintosh® None™ ' v2.0.4 or later

T Browser not available for this platform.

Note: Confirm that cookies and Javascript are turned on for the website to function
correctly.

To order... Procedure
Assays and 1. Go to www.lifetechnologies.com
reagents 2. Under “| Want to Buy,” select the product of interest.

Instrument parts | 1. Go to www.lifetechnologies.com/quantstudioéflex or
and accessories www.lifetechnologies.com/quantstudio7flex

Calibration kits 2. Click Parts and accessories.
3. Select the desired components, the complete the order as instructed.

See “Kits, consumables, and accessories” on page 160 for a complete
list of compatible instrument parts, accessories, and kits.

1. To find your assay on the Life Technologies Store, complete the Find Assay pane
in the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software:

a. Enter a gene name in the Enter Gene Name field, then click Find Assay.

b. In the Find Assay Results dialog box, select your assay.

c. Click Apply Assay Selection. The selected assay gets added to your
shopping list.

2. Check that the Experiment Shopping List contains the desired materials, other
than the assay selected in the previous step, and that the quantities are correct,
then click Order Materials in List.
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3. Inthe Order Materials - Login dialog box, enter your user name and password for
the Life Technologies Store, then click Log In and Submit.

Order Materials - Log In x|

Log into the Applied Biosysterns Store to place the selected itemns in your shopping basket, If vou do
not have a user name and password, click "Register Mow" to create a new account,

OR (o
Store Log In Register
To log into the Applied Biosystemns Stare, enter your user name Ifyou do not )
and passward then click"Log In and Submit', hawve an Applied
Biosystems
User Mame: I account, click
the link below to
create a new
Password: |
accaunt.

Log In and Submit W

Reqister Mow

[~ Remember my user name and password for future orders

Note: If you do not have an account with the Life Technologies Store, click
Register Now to create an account.

When you are connected to the Life Technologies Store, follow the prompts to
complete your order.
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Kits, consumables, and accessories

The following kits, consumables, and reagents are to be used with the QuantStudio™ 6

and 7 Flex Systems.
B Fast96-well consumables. .. ... ... ... i e 160
B 96-well consumables .. ...... ... i 161
B 384-well consumables . . ... 162
B Array card consumables. ......... ... 163
B QuantStudio™ 6 and 7 Flex Systems accessories . ................oouuuuunn. 164

Note: For reagent or consumable shelf-life expiration date, see the package label.

Note: The QuantStudio™" 6 Flex System does not support the Array Card block.

Fast 96-well

consumables Consumable Part no. Storage | Shelf life at storage

(°C) temperature

Fast 96-Well Spectral Calibration Plate
with FAM™ Dye

Fast 96-Well Spectral Calibration Plate
with VIC® Dye

Fast 96-Well Spectral Calibration Plate
with ROX™ Dye

Fast 96-Well Spectral Calibration Plate
with TAMRA™ Dye

Fast 96-Well Region of Interest (ROI) and
Background Plates Use the consumable

e Fast 96-Well Region of Interest (ROI) 4432638 <20 by the expiration date
Calibration Plate on the packaging

e Fast 96-Well Background Plate

Fast 96-Well Normalization Plates with
FAM™/ROX™ and VIC®/ROX™ Dyes

e Fast 96-Well Normalization Plate with
FAM™/ROX™ Dye

e Fast 96-Well Normalization Plate with
VIC®/ROX™ Dye

RNase P Fast 96-Well Instrument
Verification Plate

Fast 96-Well Background Plate 4481308

4432600

4432607

4432614

4432632

4443774

4432656
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96-well
6-we bl Consumable Part no Storage | Shelf life at storage
consumabtes : (°C) temperature
96-Well Spectral Calibration Plate with
FAM™ Dye 4432538
96-Well Spectral Calibration Plate with
VIC® Dye 4432545
96-Well Spectral Calibration Plate with
ROX™ Dye 4432551
96-Well Spectral Calibration Plate with
TAMRA™ Dye 4442918
96-Well Region of Interest (ROI) and
Background Plates Use the consumable
e 96-Well Region of Interest (ROI) 4432626 <20 | by the expiration date
Calibration Plate on the packaging.
e 96-Well Background Plate
96-Well Normalization Plates with FAM™/
ROX™ and VIC®/ROX™ Dyes
e 96-Well Normalization Plate with
FAM™/ROX™ Dye 4443661
* 96-Well Normalization Plate with VIC®/
ROX™ Dye
RNase P 96-Well Instrument Verification 4432593
Plate
96-Well Background Plate 4481309
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384-well

consumables Consumable Part no. Storage | Shelf life at storage

(°C) temperature

384-Well Spectral Calibration Plate with
FAM™ Dye

384-Well Spectral Calibration Plate with
VIC® Dye

384-Well Spectral Calibration Plate with
ROX™ Dye

384-Well Spectral Calibration Plate with
TAMRA™ Dye

384-Well Region of Interest (ROI) and
Background Plates <20

« 384-Well Region of Interest [ROI) 4432482 Use the consumable
. . by the expiration date
Calibration Plate

on the packaging.
e 384-Well Background Plate

384-Well Normalization Plates with
FAM™/ROX™ and VIC®/ROX™ Dyes

o 384-Well Normalization Plate with
FAM™/ROX™ Dye

e 384-Well Normalization Plate with
VIC®/ROX™ Dye

RNase P 384-Well Instrument Verification
Plate

384-Well Background Plate 4481310

4432445

4432452

4432458

4443619

4432620

4432500
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Array card

consumables Consumable Part no. Storage | Shelf life at storage

(°C) temperature

Array Card Spectral Calibration Dye Kit

e Array Calibration with FAM™ Dye

e Array Calibration with VIC® Dye

e Array Calibration with ROX™ Dye

¢ Array Calibration with ROI Dye

¢ Array Background Buffer

e Array Calibration with FAM™/ROX™ Dye
e Array Calibration with VIC®/ROX™ Dye

Kit, RNase P Array Card Instrument
Verification Reagents <20

4432644

Use the consumable
by the expiration date
e Port 1 NTC on the packaging.

e Port 2 Unknown A

e Port 3 Unknown B

e Port 4 Standard 200 Copies
e Port 5 Standard 400 Copies
¢ Port 6 Standard 800 Copies
e Port 7 Standard 1600 Copies
¢ Port 8 Standard 3200 Copies

Array Card Background Buffer Kit
¢ Background Buffer, 6 tubes 4481307
¢ Array Card Kit (empty), 6-pack

4432650

Note: The Array Card block consumables are applicable only to the QuantStudio" 7
Flex System.
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QuantStudio™ 6

and 7 Flex Systems Accessory Part no.

accessories 384-Well Plate/Array Card Heated Cover 4454163
384-Well Plate Sample Block 4454165
96-Well Plate Heated Cover 4459841
96-Well Plate Sample Block 4459839
Array Card Bucket/Clip Set 4452205
Array Card Sample Block 4454164
Fast 96-Well Plate Heated Cover 4459842
Fast 96-Well Plate Sample Block 4459840
Halogen lamp (12V, 75 W) 4480914
Handheld Barcode Scanner 4453271
Life Technologies Array Card Staker/Sealer 4456102

- TM

g::;tﬁt::gystgms Consumable Part no.

empty plates and 96-Well Fast Plate (empty), 10-pack 4346907

array cards 96-Well Fast Plate with Barcode (empty), 10-pack 4346906
96-Well Plate (empty), 10-pack N8010560
96-Well Plate with Barcode (emptyl, 10-pack 4306737
Adhesive Seal Applicator Kit, 5-pack 4481196
Array Card Kit ([empty), 1-pack? 4445702
Array Card Kit [empty), 4-pack? 4445701
Optical Adhesive Covers, 25-pack 4481193

+ QuantStudio™ 7 Flex System only.
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General-use materials and consumables

The following general-use materials and consumables are required to calibrate,
maintain, and operate the QuantStudio™ 6 and 7 Flex Systems. Unless indicated
otherwise, all materials shown below are available from major laboratory suppliers

(MLS).
Material/consumable Source
Bleach, 10% solution MLS
Centrifuge with 96-well plate buckets MLS
Cotton or nylon swabs and lint-free cloths MLS
Ethanol, 95% solution MLS
Optical clear adhesive film for PCR MLS
Pipettors, 100-pL and 200-pL (with pipette tips) MLS
Powder-free gloves MLS
Safety glasses MLS
Screwdriver, flathead MLS
Tissue, lint-free MLS
Deionized water MLS
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QuantStudio™ 6 and 7 Flex Systems specifications

The figure below summarizes the specifications and requirements for the
QuantStudio™ 6 and 7 Flex Systems. For more information, refer to the QuantStudio™ 6

and 7 Flex Systems Site Preparation Guide.

Component Height Depth Width Weight
Instrumentt | 75.0cm (29.5in.) | 70.0cm (27.6in.)  53.0cm (20.9in.) | 70 kg (154.3 lbs)
Computer 56.5cm (22.3in.) | 54.7cm (22.4in) | 21.6cm (8.5in)) 10 kg (22.0 bs)
Monitor 38.0cm (150in) | 13.7cm (5.4in) | 374cm (147in) 3.0 kg (6.7 lbs)
Keyboard 275 cm (1.11in) | 445cm(17.8in.)  13.75cm (6.5in.) | 0.75 kg (1.65 lbs)

233.0cm (91 in.)

T Weight varies depending on the sample block installed.

--53.0 cm (20.9 in.)—

-

(urg'eg) wo z'gy

P('U! 9'/g) wo 0'014

The QuantStudio 6 and 7 Flex Systems require the following additional clearances:

Required

clearances
Component Top Front Sides Back
Instrument 30.5cm (12.0in.) | 122cm (48.0in.) | 51.0cm (20.0in) = 15.2cm (6.0in.)
Computer — 30.5cm (12.0in.) — 15.2cm (6.0in.)
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QuantStudio™ 6 and 7 Flex Systems specifications

WARNING! For safety, the power outlet used for powering the instrument must
be accessible at all times. See “Required clearances” on page 168 for information
about the space needed between the wall and the instrument. In case of
emergency, you must be able to immediately disconnect the main power supply
to all the equipment. Allow adequate space between the wall and the equipment
so that the power cords can be disconnected in case of emergency.

Note: Place the QuantStudio™ 6 or 7 Flex System and computer power receptacle on
an electrical circuit that is not shared with electrically noisy devices or devices that can
cause power surges, such as refrigeration units.

The following table provides electrical specifications for the instrument and associated
devices. For all indicated input voltages, a 15 A circuit is required.

Device Rated current Rated power Rated voltage | Rated frequency
Instrument 125A 950 VA
100-240
Computer 2.1A 125 VA £ 10% VAC 50/60 Hz
Monitor 1.5A 65 VA

Note: The instrument, monitor, and computer self-adjust for 100-240 V input voltages

of 50/60 Hz.
Condition Description

Altitude Located between sea level and 6000 ft (~1800 m) above sea level

Electromagnetic | Do not use this device in close proximity to sources of strong

interference electromagnetic radiation (for example, unshielded intentional RF
sources). Strong electromagnetic radiation may interfere with the proper
operation of the device.

Humidity 15-80% (noncondensing])

Installation site

For indoor use only

Pollution The instrument has a Pollution Degree rating of Il. The instrument may
only be installed in an environment that has nonconductive pollutants
such as dust particles or wood chips. Typical environments with a
Pollution Degree Il rating are laboratories and sales and commercial
areas.
The noise output of the instrument is <60 dB at idle.

Temperature 15-30°C (60-85°F)

Thermal output

' During operation the net thermal output, based on the actual current

draw of the QuantStudio™ 6 and 7 Flex Instrument and computer, is
expected to be approximately 2731 Btu/h [800 W].

Vibration

Ensure that the instrument is not adjacent to strong vibration sources,
such as a centrifuge, pump, or compressor. Excessive vibration will affect
instrument performance.

Other conditions

Ensure the room is away from any vents that could expel particulate
material on the instrument components.

Avoid placing the instrument and computer adjacent to heaters, cooling
ducts, or in direct sunlight.
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Network The computer is factory-configured for the TCP/IP protocol. The product includes a
requirements fast Ethernet adapter (10/100 Mbps) with an RJ45-type connector and one 3-m (9.8-ft)
crossover Ethernet cable that connects the computer and the instrument.

If the instrument will be connected to a LAN, an active, tested LAN connection must
be in place before the scheduled installation date. Due to differences in network
connections, the Life Technologies service representative cannot configure the
instrument to access a specific network.

You must supply a standard Category 5 Ethernet cable of the required length to
connect the computer to your LAN.
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QuantStudio™ 6 and 7 Flex Systems layout and connections

The QuantStudio™ 6 and 7 Flex Systems consist of the components in the following

figure.

®

&

Component

Description

[0

QuantStudio™ 6 or 7
Flex System

Performs fluorescence detection and data collection of
experiment and calibration plates or array cards.

L
Computer
]
@ Monitor
Keyboard
[ﬁ Mouse

N
//|\\

Barcode scanner

Run the QuantStudio™ 6 and 7 Flex Real-Time PCR System
Software that is used to:

e Calibrate the QuantStudio™ 6 and 7 Flex Systems.
e Set up experiments.

* (Optional) Run experiments.

¢ Analyze experiments.

Scans the barcodes of plates and array cards.

Connection

Description

Power cables

Supply power to the computer and the QuantStudio™ 6 and
7 Flex Systems.t

LAN connection or
Ethernet cablet

" DVI cable

Connects the QuantStudio™ 6 and 7 Flex Systems (Ethernet
port) to the Ethernet port on the network interface card in
the computer. The components can be connected over a

local area network or a via a direct physical connection.

Connects the monitor to the computer (DVI port).

Barcode scanner cable

Connects the optional barcode scanner to the computer
(USB port).

E

Keyboard cable

Connects the keyboard to the computer (USB port).

F

Mouse cable

Connects the mouse to the computer (USB port).

t Supplies 115/230 V depending on the geographic location of the installation.
1 Supplied with the QuantStudio™ é and 7 Flex Systems.
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WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

* Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

* Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Symbols on this instrument

Symbols may be found on the instrument to warn against potential hazards or convey
important safety information. In this document, the symbol is used along with user
attention words described in the “About This Guide” section to highlight important
safety information. The following table gives the meaning of these symbols.

English

Francais

Caution, risk of danger

Consult the manual for further safety
information.

Caution, hot surface

Attention, risque de danger

Consulter le manuel pour d'autres
renseignements de sécurité.

' Attention, surface chaude

Caution, risk of electrical shock

Attention, risque de choc électrique

Laser radiation

Rayonnement laser

Moving parts

Potential biohazard

Parties mobiles

' Danger biologique potentiel

Ultraviolet light

Rayonnement ultraviolet

Potential slipping hazard

Danger de glisser potentiel

On ' On (marche)

off Off (arrét)

On/Off On/Off (marche/arrét)
Standby En attente

Earth (ground) terminal

Protective conductor terminal (main
ground)

Borne de [mise a la) terre

Borne de conducteur de protection

(mise a la terre principale)

1 ®@+CGO0—PRprpEkrpEp >

Terminal that can receive or supply
alternating current or voltage

Borne pouvant recevoir ou envoyer
une tension ou un courant de type
alternatif
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Symbol English Francais
Pt Terminal that can receive or supply Borne pouvant recevoir ou envoyer
alternating or direct current or une tension ou un courant continu ou
voltage alternatif
= Do not dispose of this product in Ne pas éliminer ce produit avec les
\ = ’ unsorted municipal waste déchets usuels non soumis au tri
—Q CAUTION! To minimize negative sélecti
environmental impact from disposal | CAUTION! Pour minimiser les
I of electronic waste, do not dispose of | conséquences négatives sur
electronic waste in unsorted Uenvironnement a la suite de
municipal waste. Follow local l'élimination de déchets
municipal waste ordinances for électroniques, ne pas éliminer ce
proper disposal provision and contact | déchet électronique avec les déchets
customer service for information usuels non soumis au tri sélectif. Se
about responsible disposal options. conformer aux ordonnances locales
sur les déchets municipaux pour les
dispositions d'élimination et
communiquer avec le service a la
clientéle pour des renseignements
sur les options d'élimination
responsable.
Conformity Description
mark

C€

Indicates conformity with European Union Directives (see “Safety and
electromagnetic compatibility (EMC) standards” on page 181).

c(UL)us

Indicates conformity with safety requirements for Canada and U.S.A.

Y

Indicates conformity with Australian standards for electromagnetic

compatibility.
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Conforming The following table describes symbols that may be displayed on the Life Technologies
symbols QuantStudio™" 6 and 7 Flex Systems, consumables, or reagents.
Symbol Description
BATCH CODE
LOT _ _ _ , o
This symbol is accompanied by the manufacturer’s batch code. It indicates the
lot number.

CATALOGUE NUMBER

The manufacturer’s catalogue number will appear after or below this symbol.

REF

T e CONSULT INSTRUCTIONS FOR USE
l This symbol indicates that you should consult the product insert for further
T information. If a product insert does not exist, or if the product insert does not
contain the symbol or the required information, consult the user manual.
CONTAINS
CONT

DO NOT REUSE

For one time use only.

LOWER LIMIT OF TEMPERATURE

The lower limit of temperature is indicated adjacent to the symbol.

MANUFACTURER

The name and the address of the manufacturer will appear next to this
symbol.

SERIAL NUMBER
The serial number will appear after or below this symbol.
TEMPERATURE LIMITATION

The upper and lower limits of temperature are indicated adjacent to the upper
and lower horizontal lines.

UPPER LIMIT OF TEMPERATURE

The upper limit of temperature is indicated adjacent to the symbol.

USE BY

This symbol is accompanied by a date to indicate that the device should not
be used after the end of the date shown.

O~ —E—®&
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Locations of safety labels on instrument

The QuantStudio™ 6 and 7 Flex Systems contain warnings at the following locations:

NI
AN

I Q

S
.
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Safety alerts on this instrument

Additional text may be used with one of the symbols described above when more
specific information is needed to avoid exposure to a hazard. See the following table
for safety alerts found on the instrument.

English

French translation

/AN

CAUTION! Hazardous chemicals.
Read the Safety Data Sheets (SDSs)
before handling.

ATTENTION! Produits chimiques
dangereux. Lire les fiches signalétiques (FS)
avant de manipuler les produits.

/AN

CAUTION! Hazardous waste. Refer
to SDS(s) and local regulations for
handling and disposal.

ATTENTION! Déchets dangereux. Lire les
fiches signalétiques (FS) et la réglementation
locale associées a la manipulation et a
Uélimination des déchets.

N

CAUTION! Class 2(I) visible and/or
invisible laser radiation present when
open Do not stare directly into the
beam or view directly with optical
instruments.

ATTENTION! Rayonnement laser visible ou
invisible de classe 2 (Il) présent en position
ouverte. Ne pas regarder directement dans
le faisceau ou avec des instruments
optiques.

Instrument safety

General C CAUTION! Do not remove instrument protective covers. If you remove the
protective instrument panels or disable interlock devices, you may be exposed
to serious hazards including, but not limited to, severe electrical shock, laser

exposure, crushing, or chemical exposure.

Physical injury A CAUTION! Moving and Lifting Injury. The instrument is to be moved and
positioned only by the personnel or vendor specified in the applicable site
preparation guide.

Improper lifting can cause painful and permanent back injury.
Things to consider before lifting or moving the instrument or accessories:
* Depending on the weight, moving or lifting may require two or more
persons.
¢ If you decide to lift or move the instrument after it has been installed, do not
attempt to do so without the assistance of others, the use of appropriate
moving equipment, and proper lifting techniques.
* Ensure you have a secure, comfortable grip on the instrument or accessory.
* Ensure that the path from where the object is to where it is being moved is
clear of obstructions.
* Do not lift an object and twist your torso at the same time. Keep your spine
in a good neutral position while lifting with your legs.
* Participants should coordinate lift and move intentions with each other
before lifting and carrying.
* For smaller packages, rather than lifting the object from the packing box,
carefully tilt the box on its side and hold it stationary while someone else
slides the contents out of the box.
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‘% CAUTION! Moving Parts. Moving parts can crush, pinch, and cut. Keep hands
clear of moving parts while operating the instrument. Disconnect power before

servicing.
Electrical C WARNING! Fuse Installation. Before installing the instrument, verify that the
fuses are properly installed and the fuse voltage matches the supply voltage.

Replace fuses only with the type and rating specified for the unit. Improper
fuses can damage the instrument wiring system and cause a fire.

C WARNING! Ensure appropriate electrical supply. For safe operation of the
instrument:

* Plug the instrument into a properly grounded receptacle with adequate
current capacity.

* Ensure the electrical supply is of suitable voltage.

* Never operate the instrument with the ground disconnected. Grounding
continuity is required for safe operation of the instrument.

C WARNING! Power Supply Line Cords. Use properly configured and approved
line cords for the power supply in your facility.

C WARNING! Disconnecting Power. To fully disconnect power either detach or
unplug the power cord, positioning the instrument such that the power cord is
accessible.

Cleaning and C CAUTION! Cleaning and decontamination.

decontamination ¢ If hazardous materials are spilled onto the instrument, the instrument
should be appropriately decontaminated.

* Using cleaning or decontamination methods other than those recommended
by the manufacturer may compromise the safety or quality of the
instrument.

¢ Care should be taken to not use decontamination or cleaning agents which
would cause a hazard as a result of a reaction with parts of the equipment or
with material contained in it.

* For the protection of others, ensure the instrument is properly
decontaminated prior to having the instrument serviced at your facility or
before sending the instrument for repair, maintenance, trade-in, disposal, or
termination of a loan. Decontamination forms may be requested from
customer service.

Instrument, To minimize negative environmental impact from disposal of electronic waste, do no
component, and dispose of electronic waste in unsorted municipal waste. Follow local municipal waste
ordinances for proper disposal provision and contact customer service for information

accessory disposal about responsible disposal options.
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Barcode scanner laser safety

Laser classification

Laser safety
requirements

The optional barcode scanners included with the QuantStudio™ 6 and 7 Flex Systems
are categorized as Class 2 (II) lasers.

Class 2 (II) lasers are low-power, visible-light lasers that can damage the eyes. Never
look directly into the laser beam. The scanner is designed to prevent human access to
harmful levels of laser light during normal operation, user maintenance, or during
prescribed service operations.

WARNING! LASER HAZARD. Class 2 (II) lasers can cause damage to eyes.
Avoid looking into a Class 2 (II) laser beam or pointing a Class 2 (II) laser beam
into another person’s eyes.

Workstation safety

180

Correct ergonomic configuration of your workstation can reduce or prevent effects
such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring
your workstation to promote neutral or relaxed working positions.

CAUTION! MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD.
These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static
unhealthy positions, contact pressure, and other workstation environmental
factors.

To minimize musculoskeletal and repetitive motion risks:

¢ Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.
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Safety and electromagnetic compatibility (EMC) standards

The instrument design and manufacture complies with the standards and
requirements for safety and electromagnetic compatibility as noted in the following

table:

Safety

Reference

Description

EU Directive 2006/95/EC

European Union “Low Voltage Directive”

IEC 61010-1
EN 61010-1
UL 61010-1
CSA C22.2 No. 61010-1

Safety requirements for electrical equipment for measurement,
control, and laboratory use - Part 1:
General requirements

IEC 61010-2-010
EN 61010-2-010

Safety requirements for electrical equipment for measurement,
control and laboratory use - Part 2-010:

Particular requirements for laboratory equipment for the heating of
materials

IEC 61010-2-081
EN 61010-2-081

Safety requirements for electrical equipment for measurement,
control and laboratory use - Part 2-081:

Particular requirements for automatic and semi-automatic
laboratory equipment for analysis and other purposes

EMC

Reference

Description

Directive 2004/108/EC

European Union “EMC Directive”

EN 61326-1

Electrical Equipment for Measurement, Control and Laboratory Use
- EMC Requirements - Part 1: General Requirements

FCC Part 18 (47 CFR)
AS/NZS 2064

U.S. Standard “Industrial, Scientific, and Medical Equipment”

Limits and Methods of Measurement of Electromagnetic
Disturbance Characteristics of Industrial, Scientific, and Medical
(ISM) Radiofrequency Equipment

ICES-001, Issue 3

Industrial, Scientific and Medical (ISM] Radio Frequency Generators

Environmental

) Reference
design

Description

Directive 2002/96/EC

European Union “WEEE Directive” - Waste electrical and
electronic equipment

Directive 2002/95/EC

European Union “RoHS Directive” - Restriction of hazardous
substances in electrical and electronic equipment
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

* Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

* Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

* Minimize the inhalation of chemicals. Do not leave chemical containers
open. Use only with adequate ventilation (for example, fume hood).

¢ Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.

* Handle chemical wastes in a fume hood.

* Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

* After emptying a waste container, seal it with the cap provided.

* Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

* Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

* IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by
the instrument is potentially hazardous. Follow the guidelines noted in the
preceding General Chemical Handling warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste
bottles can crack and leak. Each 4-liter bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in
the upright position.
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Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following;:

In the U.S.:

* U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories found at:
www.cdc.gov/biosafety

* Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030), found at: www.access.gpo.gov/nara/cfr/waisidx_01/
29¢fr1910a_01.html

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

* Additional information about biohazard guidelines is available at:
www.cdc.gov

In the EU:

Check local guidelines and legislation on biohazard and biosafety precaution
and refer to the best practices published in the World Health Organization
(WHO) Laboratory Biosafety Manual, third edition, found at: www.who.int/
cst/resources/publications/biosafety/ WHO_CDS_CSR_LYO_2004_11/en/
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Documentation and Support

Obtaining information from the Help system

The QuantStudio™" 6 and 7 Flex Systems have a Help system that describes how to use
each feature of the user interface. Access the Help system by doing one of the
following:

e Click & in the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software
window.

* Select Help » QuantStudio’" 6 and 7 Flex Real-Time PCR System Software
Help.

e Press F1.

You can use the Help system to find topics of interest by:
¢ Reviewing the table of contents.
* Searching for a specific topic.

* Searching an alphabetized index.

Obtaining support

For the latest services and support information for all locations, go to:
www.lifetechnologies.com

At the Life Technologies website, you can:

* Access worldwide telephone and fax numbers to contact Life Technologies
Technical Support and Sales facilities.

* Search through frequently asked questions (FAQs).
* Submit a question directly to Technical Support.

* Order Life Technologies user documents, SDSs, certificates of analysis, and other
related documents.

¢ Download PDF documents.
¢ Obtain information about customer training.

¢ Download software updates and patches.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies” General Terms and Conditions of Sale found on Life

Technologies’” website at www.lifetechnologies.com/termsandconditions. If you have
any questions, please contact Life Technologies at www.lifetechnologies.com/support.
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aligned melt curve
plot

allele

amplicon

amplification

amplification
efficiency (EFF%)

Amplification Plot

amplification stage

assay

assay mix

Glossary

Plot of the re-scaled melt curve.

In a diploid organism, one of two DNA sequences found at the same locus (for
example, a particular gene), but located on homologous chromosomes. Two
corresponding alleles may have the identical sequence, or they may differ somewhat,
often at one or more single-base sites (SNPs).

A segment of DNA amplified during PCR.

Part of the instrument run in which PCR amplifies the target. Fluorescence data
collected during amplification are displayed in an Amplification Plot, and the data are
used to calculate results.

Note: Only quantitative real-time PCR experiments, not end-point experiments, take
amplification data into account.

Calculation of the efficiency of the PCR amplification in an experiment. EFF% is
calculated using the slope of the regression line in the standard curve. A slope close to
-3.32 indicates optimal, 100% PCR amplification efficiency.

Display of data collected during the cycling stage of PCR amplification. The
Amplification Plot can be viewed as:

* Baseline-corrected normalized reporter (AR,) vs. cycle

* Normalized reporter (R,) vs. cycle

¢ Threshold cycle (Ct) vs. well

Part of the instrument run in which PCR amplifies the target. The amplification stage,
called a cycling stage in the thermal profile, consists of denaturing, primer annealing,

and extension steps that are repeated. Fluorescence data collected during the extension
stage are displayed in an amplification plot, and the data are used to calculate results.
With chemistry, the last two steps of a PCR stage are typically combined.

See also cycling stage.

In a PCR reaction mix, two target-specific primers or two primers and a probe used to
amplify a target.

PCR reaction component in assays. The assay mix contains primers designed to
amplify a target and a probe designed to detect amplification of the target.
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automatic baseline

automatic threshold

background
calibration

baseline

baseline-corrected
normalized reporter
(AR,)

blocked IPC

CE mark

€

chemistry
control
Cr

Cy algorithm

cycle threshold

cycling stage
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An analysis setting in which the software calculates the baseline start and end cycles
for the amplification plot.

See also baseline.
An analysis setting in which the software calculates the baseline start and end cycles

and the threshold in the amplification plot. The software uses the baseline and
threshold to calculate the threshold cycle (Cr).

See also threshold cycle (CT).
Type of calibration in which the instrument performs reads of a background plate or
array card, averages the spectra recorded during the run, and extracts the resulting

spectral component to a calibration file. The software then uses the calibration file
during subsequent runs to remove the background fluorescence from the run data.

From the Amplification Plot, a cycle-to-cycle range that defines background
fluorescence.

The magnitude of normalized fluorescence signal generated by the reporter. In
experiments that contain data from real-time PCR, the magnitude of normalized
fluorescence signal generated by the reporter at each cycle during the PCR
amplification. From the AR, vs. Cycle Amplification Plot, AR, is calculated at each
cycle as:

AR}, (eycle) = Rn (cycle) Rn (baseliney Where Ry, = normalized reporter

See also normalized reporter (Rn).

In presence/absence experiments, a reaction that contains IPC blocking agent, which
blocks amplification of the internal positive control (IPC). In QuantStudio™ 6 and 7
Flex Real-Time PCR System Software, also the name of the task for the IPC target in
wells that contain IPC blocking agent. See also negative control-blocked IPC wells.

The CE Mark (an acronym for the French “Conformite Europeene”) of conformity
certifies that a product has met the essential requirements of the applicable European
Directive.

See reagents.
Sample of known genotype or melt-curve shape.
See threshold cycle (CT).

The QuantStudio™ 6 and 7 Flex Real-Time PCR System Software uses the Baseline
Threshold algorithm.

See threshold cycle (CT).

In the thermal profile, a stage that is repeated. A cycling stage is also called an
amplification stage.

See also amplification stage.
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data collection

delta R, (AR,)

derivative melt curve
plot

derivative reporter
(Ry)

dissociation curve

dye calibration

EFF%

error

filter

flag

forward primer

heterozygote

holding stage

Glossary

During the instrument run, a process in which an instrument detects fluorescence data
from each well of the plate or array card. The instrument transforms the signal to
electronic data and saves the data in the experiment file.

See baseline-corrected normalized reporter (DRn).

The default view of the melting curve. It plots the negative derivative data (-R,," ) vs.
temperature.

Note: An alternative view is the raw data view, which plots the normalized
fluorescence from reporter dye vs. temperature.

The rate of change in fluorescence as a function of temperature. R,,;” is used to plot a
melting curve. Significant decrease of the fluorescent signal generates a positive peak
on the derivative view of the melting curve.

See melt curve.

Type of calibration in which the software collects spectral data from a series of dye
standards and stores the spectral information for the dye standards in a pure spectra
calibration file. This file is used during experiment runs to characterize and distinguish
the individual contribution of each dye in the total fluorescence collected by the
instrument.

See amplification efficiency (EFF%).

The standard error of the slope of the regression line in the standard curve.

The error can be used to calculate a confidence interval (CI) for the slope. Because the
amplification efficiency (EFF%) is calculated from the slope, knowing the error allows
a CI for the amplification efficiency to be calculated.

Dye excitation and emission filter combination that is set for a experiment. The
QuantStudio™ 7 Flex System includes a decoupled, six by six-color filter set. The
QuantStudio™ 6 Flex System includes a coupled five-color filter set. The excitation and
emission filter combinations are preset by the experiment document (.eds) file for your
experiment.

A quality control (QC) indicator which, when applied by the software to a well during
analysis, indicates a possible issue with that reaction. For example, a flag may be
issued if no amplification is detected in a well. Flags indicating potential problems are
displayed in the Quality Control tab of the Plate Layout, Well Table, and QC Summary
screens.

Oligonucleotide that flanks the 5° end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

Samples having both allele 1 and allele 2.

In the thermal profile, the stage that holds the temperature constant for a defined
period of time.
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homozygote

Instrument Console

Instrument Manager

internal positive
control (IPC)

IPC
IPC+

melt curve

melt curve
characteristics

melt curve stage

melting temperature
(Try)

melting transition
region

negative control (NC)

negative control-
blocked IPC wells

negative control-IPC
wells
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Samples having only allele 1 or only allele 2.

A software feature that allows you to monitor the status of any instrument on the
network; view calibration, maintenance, and instrument properties for a selected
instrument; and open and close the instrument drawer.

A software feature that allows you to monitor the status of an instrument; monitor
Amplification Plots and temperature plots in real time; view the calibration status,
perform calibrations and manage files on the instrument, including downloading
completed experiments to your computer.

In presence/absence experiments, a short synthetic DNA template that is added to PCR
reactions. The IPC can be used to distinguish between true negative results (the target
is absent in the samples) and negative results caused by PCR inhibitors, incorrect assay
setup, or reagent or instrument failure.

See internal positive control (IPC).
See negative control-IPC wells.

A plot of data collected during the melt curve stage. Peaks in the melt curve can
indicate the melting temperature (T,,) of the target, or they can identify nonspecific
PCR amplification. In the software, you can view the melt curve as normalized
reporter (R,,) vs. temperature or as derivative reporter (-R,," ) vs. temperature.

The melt curve shape and the difference in melting temperature (T,,) values.

In the thermal profile, a stage with a temperature increment to generate a melt curve.

The temperature at which 50% of the DNA is double-stranded and 50% of the DNA is
dissociated into single-stranded DNA. In a melt curve experiment, the melt curve plot
displays the melting temperature.

In Melt Curve experiments, the region before and after the melting temperature (Tm).

The task for targets or SNP assays in wells that contain water or buffer instead of
sample. No amplification of the target should occur in negative control wells.
Previously called no template control (NTC).

In presence/absence experiments, wells that contain IPC blocking agent instead of
sample in the PCR reaction. No amplification should occur in negative control-blocked
IPC wells because the reaction contains no sample and amplification of the IPC is
blocked. Previously called no amplification control (NAC).

In presence/absence experiments, wells that contain IPC template and buffer or water
instead of sample. Only the IPC template should amplify in negative control-IPC wells
because the reaction contains no sample. Previously called IPC+.
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no template control
(NTC)

nonfluorescent
quencher-minor

groove binder (NFQ-
MGB)

normalization
calibration

normalized quantity

normalized quantity
mean

normalized quantity
SE

normalized reporter
(Ry)

outlier

passive reference

plate layout

point

positive control

Glossary

See negative control (NC).

Molecules that are attached to the 3’ end of probes. When the probe is intact, the
nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence
signal. Because the NFQ does not fluoresce, it produces lower background signals,
resulting in improved precision in quantification. The minor groove binder (MGB)
increases the melting temperature (T,,) of the probe without increasing its length,
allowing for the design of shorter probes.

Type of calibration in which the software collects data from the normalization
standards, then stores it in a normalization calibration file.

Either the Cy Avg. of the target gene minus the Cy Avg. of the endogenous control
(Comparative Ct experiments), or the Q Avg. of the target divided by the Q Avg. of the
endogenous control (Relative Standard Curve experiments).

The relative standard curve equivalent of the ACt mean value found in Comparative
Cr experiments (computed as the geometric mean).

The relative standard curve equivalent of the ACt SE value found in Comparative Ct
experiments (computed as the geometric standard error of the mean).

Fluorescence signal from the reporter dye normalized to the fluorescence signal of the
passive reference dye (usually ROX™ dye on Life Technologies instruments).

A measurement (such as a Cr) that deviates significantly from the measurement of the
other replicates for that same sample.

A dye that produces fluorescence signal independent of PCR amplification, and that is
added to each reaction at a constant concentration. Because the passive reference
signal should be consistent across all wells, it is used to normalize the reporter dye
signal to account for non-PCR related fluorescence fluctuations caused by minor well-
to-well differences in volume. Normalization to the passive reference signal generally
results in data with noticeably high precision among technical replicates.

An illustration of the grid of wells and assigned content in the plate or array card. The
number of rows and columns in the grid depends on the sample block that you use.

From the software, you can use the plate layout as a selection tool to assign well
contents, to view well assignments, and to view results. The plate layout can be
printed, included in a report, exported, and saved as a slide for a presentation.

One standard in a standard curve. The standard quantity for each point in a standard
curve is calculated based on the starting quantity and serial factor.

In genotyping and presence/absence experiments, a DNA sample with a known
genotype, homozygous or heterozygous.

In the software, the task for the SNP assay in wells that contain a sample with a known
genotype.
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pure dye

quantity

quencher
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Raw Data Plot
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reagents

real-time PCR

reference sample

region of interest
(ROI) calibration

regression
coefficients

regression line
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Fluorescent compound used to calibrate the instrument.

See system dye.

In quantification experiments, the amount of target in the samples. Absolute quantity
can refer to copy number, mass, molarity, or viral load. Relative quantity refers to the
fold-difference between normalized quantity of target in the sample and normalized
quantity of target in the reference sample.

A molecule attached to the 3’ end of probes to prevent the reporter from emitting
fluorescence signal while the probe is intact. With reagents, a nonfluorescent
quencher-minor groove binder (NFQ-MGB) can be used as the quencher.

Regression coefficient calculated from the regression line in the standard curve. An
important quality value, the R? value indicates the closeness of fit between the
standard curve regression line and the individual Cy data points from the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and the
data points.

A plot of raw fluorescent signal as detected through each emission filter, used to view
raw data for individual wells and at individual cycles.

A solution that contains all components to run the PCR reaction, except for the
template (sample, standard, or control). Also called a “PCR cocktail”.

The PCR reaction components used to amplify the target and to detect amplification.

Process of collecting fluorescence data during PCR. Data from the real-time PCR are
used to calculate results for quantification experiments or to troubleshoot results for
genotyping or presence/absence experiments.

In relative standard curve and Comparative Ct (AACt) experiments, the sample used
as the basis for relative quantification results. Also called the calibrator.

Type of calibration in which the software maps the positions of the wells on the sample
block of the instrument. The software uses the ROI calibration data to associate
increases in fluorescence during a run with specific wells of the plate or array card. A
calibration image for each individual filter must be generated to account for minor
differences in the optical path.

Values calculated from the regression line in standard curves, including the R? value,
slope, and y-intercept. You can use the regression coefficients to evaluate the quality of
results from the standards. See also standard curve.

In standard curve and relative standard curve experiments, the best-fit line from the
standard curve. Regression line formula:

Cr=m[log (Qty)] +b
where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also regression coefficients.

QuantStudio™ é and 7 Flex Real-Time PCR Systems Maintenance and Administration Guide



reject well

relative standard
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replicates

reporter

reverse primer

reverse
transcriptase

Rn

ROX™ dye

run method

sample

sample definition file
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Glossary

An action that the software performs during analysis to remove one or more wells
from further analysis if a specific flag is applied to the well.

A method to determine relative quantities. This method compensates for target and
endogenous control efficiency differences within each run. In all experiments,
unknown samples and dilution series of template (such as cDNA) are amplified.
Following a run, the instrument software interpolates relative quantities for each
unknown sample from the appropriate dilution curve, then normalizes the data for
each sample (or set of replicates) as follows: target QAvg. + endogenous control QAvg.

A user-defined biological grouping. A replicate group may be a set of identical
reactions in a experiment.

Total number of identical reactions containing identical components and identical
volumes.

A fluorescent dye used to detect amplification. With reagents, the reporter dye is
attached to the 5" end.

An oligonucleotide that flanks the 3° end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

An enzyme that converts RNA to cDNA.

See normalized reporter (Rn).

A dye supplied by Life Technologies, which is used as a passive reference in some
experiments.

Definition of the reaction volume and the thermal profile for the instrument run. The
run method specifies the temperature, time, ramp, and data collection points for all
steps and stages of the instrument run.

The biological tissue or specimen that you are testing for a target gene.

A tab-delimited file (.txt) or Microsoft® Excel® file (.xls or .xlsx) that contains the
sample name and custom sample properties for a single experiment.
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security, auditing
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serial factor
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A separately licensed software module that provides:

e System Security — Controls user access to the software. Provides a default
Administrator user account. You can define additional user accounts and
permissions.

* Auditing — Tracks changes made to library items, actions performed by users, and
changes to the Security and Audit settings. The software automatically audits
some actions silently. You can select other items for auditing and specify the audit
mode. Provides reports for audited library items, Security and Audit changes,
and actions.

* Electronic Signature (e-signature) — Controls whether users are permitted,
prompted, or required to provide a user name and password when accessing
certain software features. You can select which features are controlled and the
number of signatures required for access. When authorized persons use this
feature, they are creating a legally binding signature.

In the software, a numeric value that defines the sequence of quantities in the standard
curve. The serial factor and the starting quantity are used to calculate the standard
quantity for each point in the standard curve. For example, if the standard curve is
defined with a serial factor of 1:10 or 10X, the difference between any two adjacent
points in the curve is 10-fold.

Regression coefficient calculated from the regression line in the standard curve. The
slope indicates the PCR amplification efficiency for the assay. A slope of -3.32
indicates 100% amplification efficiency.

See also amplification efficiency (EFF%) and regression line.

In the thermal profile, a group of one or more steps. Examples: PCR stage, cycling
stage (also called amplification stage), and hold stage.

A sample that you dilute and amplify along with unknown samples. This dilution
series can contain known starting quantities of the target of interest (absolute standard
curve) or it can be of known dilution factor (relative standard curve). Following the
run, the software interpolates the Ct values of the unknowns to this curve, yielding
either specific quantities of the target (for absolute curves) or relative quantities (for
relative dilution curves).

See also standard curve.

In standard curve and relative standard curve experiments:

* The best-fit line in a plot of the C values from the standard reactions plotted
against standard quantities. See also regression line.

* A set of standards containing a range of known quantities. Results from the
standard curve reactions are used to generate the standard curve. The standard
curve is defined by the number of points in the dilution series, the number of
standard replicates, the starting quantity, and the serial factor.

Method for determining absolute target quantity in samples. With the standard curve
method, the software measures amplification of the target in samples and in a
standard dilution series. Data from the standard dilution series are used to generate
the standard curve. Using the standard curve, the software interpolates the absolute
quantity of target in the samples.
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Glossary

See also standard and standard curve.

In standard curve and relative standard curve experiments, a set of standards
containing a range of known quantities. The standard dilution series is prepared by
serially diluting standards. For example, the standard stock is used to prepare the first
dilution point, the first dilution point is used to prepare the second dilution point, and
so on. In the software, the volumes needed to prepare a standard dilution series are
calculated by the number of dilution points, the number of standard replicates, the
starting quantity, the serial factor, and the standard concentration in the stock. See also
standard curve.

In the PCR reaction, a known quantity. In standard curve experiments, the quantity of
target in the standard. From the software, the units for standard quantity can be for
mass, copy number, viral load, or other units for measuring the quantity of target.
Standard quantity can also refer to dilution factor.

When defining a standard curve in the software, the highest quantity.

A component of the thermal profile. For each step in the thermal profile, you can set
the ramp rate (ramp increment for melt curve steps), hold temperature, and hold time
(duration) are set as part of the .tdd file. Data collection can also be turned on or off for
the ramp or the hold parts of the step in each .tdd file. For cycling stages, a step is also
defined by the AutoDelta status.

Dye supplied by Life Technologies and calibrated on the QuantStudio™ 6 and 7 Flex
Systems. Before you use system dyes in your experiments, make sure the dye
calibration is current in the Instrument Console.

The nucleic acid sequence to amplify and detect.

From the software, a color assigned to a target to identify the target in the plate layout
and analysis plots.

From the software, the type of reaction performed in the well for the target or SNP
assay.

Wells containing identical reaction components, including sample; important for
evaluating precision.

From the software, a display of temperatures for the instrument cover and instrument
block during the instrument run.

The type of nucleic acid to add to the PCR reaction.
Refers to the entire process of performing a run, including setup, run, and analysis.

Part of the run method that specifies the temperature, time, ramp, and data collection
points for all steps and stages of the instrument run.
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experiment
document file (.eds)

threshold
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touchscreen
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unknown

variant

y-intercept
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The Life Technologies name for the electronic records that comprise all information
about a particular plate or array card, including metadata (name, barcode, comments),
plate setup (well contents, assay definitions), run method (thermal cycling protocol),
run results, analysis protocol, analysis results, audit records, and other consumable-
specific data. Experiment document files have the .eds suffix.

In Amplification Plots, the level of fluorescence above the baseline and within the
exponential growth region.

The PCR cycle number at which the fluorescence meets the threshold in the
Amplification Plot.

See melting temperature (Tm).
Instrument display that you touch to control the instrument.

Type of calibration in which the software measures sample block uniformity. The
calibration generates data that compensate for the physical effects of the
QuantStudio™ 6 and 7 Flex System:s filters on data collected during a experiment.

From the software, the task for the target in wells that contain the sample being tested.
In quantification experiments, the task for the target in wells that contain a sample
with unknown target quantities. In genotyping experiments, the task for the SNP assay
in wells that contain a sample with an unknown genotype. In presence/absence
experiments, the task for the target in wells that contain a sample in which the
presence of the target is not known.In melt curve experiments, the task for the target in
wells that contain a sample with an unknown melt curve profile.

A sample (or group of samples) with a unique melt curve (that is, the melt curve is
different from the melt curves of other samples or controls used in the experiment).
The software determines melt curve differences by the melting temperature (T,,) and
the shape of the melt curve.

From the standard curve, the value of y where the regression line crosses the y-axis.
The y-intercept indicates the expected threshold cycle (Ct) for a sample with quantity
equal to 1.
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A

accessories 160
account
setup 131
suspended, activate 133
suspension 131, 146
user 133
action log
contents 138
display 138, 141, 144
activation, license keys 104
administrator
auditing 137
password 130
security 130
user role 134
aligned melt curve plot 187
allele 187
altitude requirement 169
amplicon 187
amplification 187
amplification efficiency (EFF%) 187
Amplification Plot 187
amplification stage 187
AMPNC quality flag 66
annual (semi-annual) maintenance 28
APIPA support 114
archive
audit records 139
instrument settings 85
array card
background, creating 150
calibration 25
prepare for calibration 36
prepare for verification 36, 64
Array Card RNase P Kit 62
assay 187
audit, administrators 137

action log 138, 141, 144
archive records 139

audit actions 138

audit mode 137

audit reason settings 137
audited objects and actions 137
enable or disable 137

export records 139

export settings 145

import settings 145

object audit history 138, 141, 144
overview 130

purge records 139

restore records 139

Index

system configuration history 138, 139, 140, 141,

144

when security is disabled 137
audit, users

enter reason for change 147

overview 146
Autodiscovery, instrument 90
automatic baseline 188
automatic threshold 188

background calibration
about 44, 188
about the data 44
performing 46
plate preparation 45
troubleshooting 69
background fluorescence 44
backing up, instrument settings 85
BADROX quality flag 66
barcode readers 21
barcode scanner 20, 171
baseline 188

baseline-corrected normalized reporter (AR,,) 188

biohazard safety 183
BLFAIL quality flag 66
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Index

blocked IPC 188 create
custom background plate or array card 150
c custom dye plate 153

experiments from the instrument 81
calibration

array cards 25, 36

background 44 ;
consumables 25 Ct algorithm 188

custom dye 152 CTFAIL quality flag 66

data 40, 44, 52, 57 custom dyes
add to software 154

creation
array cards for calibration 36

dye 52 1108
instrument status, viewing 29 calibration 152
kits 160 create plate 153
normalization 57 cycle threshold 188
plates 25, 35 cycling stage 188
reminders 31, 33, 90, 121

ROI 40 D

schedule 28
uniformity 48
workflow 29

data
transfer to/from the instrument 83, 84, 121
data collection 189

calibration plate ) .
date/time, instrument 88

background 45

dye 53 decontamination safety 179

normalization 57 decontamination, sample block 78, 96

ROI 41, 48 deleting instrument data 84
CE mark 188 delta Rn 189
chemical safety 182 derivative melt curve plot 189
cleaning safety 179 derivative reporter 189
clearance requirements for instrument DHCP support 114

components 168 dimensions, instrument 168

compatibility, operating system 24 disable
compatibility, third-party software 24 security, instrument 92
computer security, software 131

electrical requirements 169 disabling, calibration reminders 31, 90, 121

layout 171 DNS support 114

remote monitoring 119, 120 dye calibration 189

requirements 24 about 52

specifications 168 about the data 52
conforming symbols 176 performing 54
connections 171 plate preparation 53
consumables troubleshooting 69

accessories 160 dyes, supported 17

general use 165

kits 160 E
Cont.a na t19n electrical

identifying 78 ,

requirements 169
sample block 96 safety 179

control 188

) electromagnetic compatibility (EMC) standards 181
control, instrument over a network 114
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electronic signature, administrators
actions that allow e-sig 143
enable or disable 142
functions that require e-sig 143
is signed field 147
when security is disabled 142
electronic signature, users
is signed field 147
signing 147
enable
security, instrument 92
security, software 131
enabling
calibration reminders 31, 90, 121
electronic signature 142
environmental requirement 169
ergonomics, safety 180
error 189
e-sig. See electronic signature
Ethernet port
about 114
defining instrument IP settings 90, 118
location 19
experiment
deleting from the instrument 84
transfer from the instrument 84, 121
experiment document file 196
experiments
create from touchscreen 81
run from touchscreen 82
transfer to/from the instrument 83
EXPFAIL quality flag 66
export
audit records 139
audit settings 145
e-sig settings 145
security settings 145
user account settings 145

F

feet 21
file

experiment document file 196
fill array cards

calibration 36

instrument verification 36, 64

filter 189
filters, supported 17
firmware, update 87
flag 189
forward primer 189
fuse cover 22
fuses
location 19
replacement 102
specification 102

G

general use materials and consumables 165
guidelines
calibration plate preparation 35
consumable preparation 25
networking 116
remote monitoring 120

H

halogen lamp. See lamp
heated cover
handling 108
installation 108
location 18
temperature setting 88
Help system, accessing 185
heterozygote 189
HIGHSD quality flag 66
holding stage 189
homozygote 190
humidity requirement 169

icon, instrument 88
import
audit settings 145
security settings 145
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dye calibration 152

electrical requirements 169

environmental requirements 169

Ethernet port 114

exhaust venting 169

filters 17

fuse, replacement 102

heated cover temperature 88

icon 88

installation specification 63

IPV4LL 114

layout and connections 171

log 92

maintenance 85

mDNS/DNS support 114

moving 127

name setting 88

network setting 90

networking 114, 118

power line regulator 23

power on/off 124

security 92

self test 86

settings 85

Smart Monitoring 90

specifications 168

standby 124

standby time-out 88

static IP support 114

statistics 91

status, viewing 29

storage 126

surge protector 23

system shortcuts 91

touchscreen 80

verification 36, 64
Instrument Console 190
Instrument Manager 190
instrument safety 178
internal positive control (IPC) 190
IP settings, Ethernet port 90
IPv4 link-local (IPV4LL) 114
is signed field 147

K

keys, software 104

L

lab director user role 134
lamp
location 18, 99
replacement 99
laser classification 180
laser safety
barcode scanner 180
requirements 180
layout
instrument 171
network 115
License Central 104
licenses, software 104
Life Technologies, support 185
lifespan, lamp 99
location requirement 169
log in, user account 147
log, instrument 92
logged-in user name
display 134
in user account 133

M

mail server settings 31
maintenance
instrument 85
instrument settings 85
planned maintenance 28
reminders 31, 90
schedule 28
software licenses 104
materials
accessories 160
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lamp replacement 99
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user role 134
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security, users
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login 147
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stage 194
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CE 188
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training, information on 185
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troubleshooting
calibrations and RNase P test 69
identifying contamination 78
instrument fuses 102
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about 48
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unknown 196
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backup instrument settings 85
location 18, 19
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